# Table of Contents

- Package Page ........................................................................................................... 11
- Visual Package Page ................................................................................................. 12
- Package Winnings Page ............................................................................................. 15
- Winning Numbers Page ............................................................................................. 18
- Visual Winning Numbers ......................................................................................... 19
- Statistics Page ........................................................................................................... 22
- Package Statistics Page ............................................................................................ 25
- Filter Statistics Page .................................................................................................. 28
- Winning Numbers History Page ................................................................................ 31
- Menu Package ........................................................................................................... 35
- Ticket Generator ........................................................................................................ 36
- Insert File ................................................................................................................... 40
- Insert Wheel ............................................................................................................... 40
- Insert Winning Numbers ............................................................................................ 41
- Save the Package into a File ....................................................................................... 43
- Swap Ticket Numbers ............................................................................................... 44
- Dummy Numbers ........................................................................................................ 45
- Print Playslips ............................................................................................................ 49
- What is "Filter" ........................................................................................................... 53
- Odd/Even Filter .......................................................................................................... 54
- Sum Filter .................................................................................................................... 55
- Successive Numbers Filter ......................................................................................... 56
- Match Winning Numbers Filter ................................................................................ 58
- Match Tickets in the Package Filter ........................................................................... 60
<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Tickets in a File Filter</td>
<td>62</td>
</tr>
<tr>
<td>Match Numbers Filter</td>
<td>63</td>
</tr>
<tr>
<td>Random Selection Filter</td>
<td>63</td>
</tr>
<tr>
<td>Systematic Selection Filter</td>
<td>64</td>
</tr>
<tr>
<td>Single Numbers Filter</td>
<td>64</td>
</tr>
<tr>
<td>Pairs Filter</td>
<td>64</td>
</tr>
<tr>
<td>Triplets Filter</td>
<td>65</td>
</tr>
<tr>
<td>Ticket Numbers Range Filter</td>
<td>66</td>
</tr>
<tr>
<td>Number Distance Filter</td>
<td>69</td>
</tr>
<tr>
<td>Standard Deviation Filter</td>
<td>70</td>
</tr>
<tr>
<td>Panel Filter</td>
<td>71</td>
</tr>
<tr>
<td>Powerball Filter</td>
<td>72</td>
</tr>
<tr>
<td>Number Groups Filter</td>
<td>73</td>
</tr>
<tr>
<td>First/Last Digit Filter</td>
<td>74</td>
</tr>
<tr>
<td>Low / High Filter</td>
<td>75</td>
</tr>
<tr>
<td>Ticket Index Movement Filter</td>
<td>76</td>
</tr>
<tr>
<td>Ticket Index Filter</td>
<td>76</td>
</tr>
<tr>
<td>Winning Numbers History Filter</td>
<td>76</td>
</tr>
<tr>
<td>Winning Numbers History Differences Segments Filter</td>
<td>80</td>
</tr>
<tr>
<td>Winning Numbers History Standard Deviation Filter</td>
<td>82</td>
</tr>
<tr>
<td>Numbers Position Filter</td>
<td>82</td>
</tr>
<tr>
<td>Number Range Position Filter</td>
<td>83</td>
</tr>
<tr>
<td>Number Movement Position Filter</td>
<td>84</td>
</tr>
<tr>
<td>Odd / Even Position Filter</td>
<td>86</td>
</tr>
<tr>
<td>Low / High Position Filter</td>
<td>86</td>
</tr>
</tbody>
</table>
Table of Contents

First / Last Digit Position Filter ................................................................. 87
Optimizer Filter ......................................................................................... 88
Minimizer Filter ........................................................................................ 91
Fast Minimizer Filter .............................................................................. 93
Custom Combinations Coverage Filter ................................................... 94
Best Tickets Filter .................................................................................... 95
Compound Filter ...................................................................................... 96
Filter Groups ............................................................................................. 97
Add Winning Numbers ............................................................................... 99
Edit Winning Numbers ............................................................................. 99
Export Winning Numbers .......................................................................... 101
Import Winning Numbers ......................................................................... 101
Import Winning Numbers Wizard ............................................................. 103
General Statistics .................................................................................... 105
Ticket Numbers Statistics ......................................................................... 105
Bonus Numbers ......................................................................................... 106
Sum Statistics ........................................................................................... 107
Odd / Even Statistics ................................................................................ 108
Low / High Statistics ................................................................................ 109
Odd/Even + Low/High Statistics ............................................................... 109
Sum Root + Odd/Even .............................................................................. 109
Sum Root + Low/High Statistics ............................................................... 110
Statistics - Pairs ....................................................................................... 110
Triplets Statistics ...................................................................................... 110
Number Matrix Statistics ........................................................................ 111
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random Win Test</td>
<td>159</td>
</tr>
<tr>
<td>Winning Numbers Win Test</td>
<td>160</td>
</tr>
<tr>
<td>Win Coverage</td>
<td>161</td>
</tr>
<tr>
<td>Win Coverage of Custom Combinations</td>
<td>164</td>
</tr>
<tr>
<td>Application Preferences</td>
<td>165</td>
</tr>
<tr>
<td>General Preferences</td>
<td>165</td>
</tr>
<tr>
<td>Files &amp; Folders Preferences</td>
<td>165</td>
</tr>
<tr>
<td>Plugin Preferences</td>
<td>166</td>
</tr>
<tr>
<td>Internet Connection Preferences</td>
<td>166</td>
</tr>
<tr>
<td>Winning Numbers History Preferences</td>
<td>166</td>
</tr>
<tr>
<td>How To</td>
<td>169</td>
</tr>
<tr>
<td>Example 1</td>
<td>169</td>
</tr>
<tr>
<td>Example 2</td>
<td>172</td>
</tr>
<tr>
<td>Example 3</td>
<td>174</td>
</tr>
<tr>
<td>Why do we study winning numbers history?</td>
<td>175</td>
</tr>
<tr>
<td>Hot Numbers</td>
<td>182</td>
</tr>
<tr>
<td>Best Tickets</td>
<td>186</td>
</tr>
<tr>
<td>Tips &amp; Tricks</td>
<td>188</td>
</tr>
<tr>
<td>How to import a wheel</td>
<td>189</td>
</tr>
<tr>
<td>How to add past winning numbers</td>
<td>190</td>
</tr>
<tr>
<td>How to create a new wheel</td>
<td>194</td>
</tr>
<tr>
<td>How to print to playslips</td>
<td>197</td>
</tr>
<tr>
<td>How to create a new lottery</td>
<td>198</td>
</tr>
<tr>
<td>How to use filters</td>
<td>199</td>
</tr>
<tr>
<td>How to use statistics</td>
<td>201</td>
</tr>
</tbody>
</table>
Expert Lotto Help

How to export data from the application ................................................... 203
How to check winnings ............................................................................. 205
How to use Winning Numbers History features ..................................... 205
Predictions .............................................................................................. 210
Expert Lotto Help

Expert Lotto application is designed for all numerical lotteries where a small set of winning numbers is drawn from a given pool of numbers. This flexibility allows using Expert Lotto for almost any lottery in the world. The application can also be used for lotteries drawing a bonus number(s). The bonus numbers can be drawn either from the same pool or from a different pool than the main winning numbers. The application is designed to meet the needs of most lotteries played worldwide. Some specific functionality or extensions are provided as plugins.

Expert Lotto provides an extensive set of functions to support your lottery strategy. You can decide which functions you wish to use; no procedures or strategies are forced on you.

The results of all functions are always reproducible. The application is not a black box providing different results each time the same function is used. With application's help you can process and optimize large sets of data including all number combinations. The only limits are your hardware specifications (CPU speed, free RAM, hard disk space).

The application is divided into three logical modules:

- **Winning Numbers Database**
  Most lotteries provide a list of all winning numbers drawn so far. This application part allows reviewing the winning numbers history thus helping you to form your opinion on the winning numbers statistics. You can also compare the numbers you wish to bet with the winning numbers history. You can download winning numbers databases from our web site or you can setup a new database from data published on lottery's official web site. You can add new entries into winning numbers database either manually or you can use modules for online winning numbers update where available.

- **Package**
  The Package is the basic application workspace where you store and manage your tickets. The application provides many functions for working with tickets in the package. You can load previously stored ticket files into the package or you can use Ticket Generator to create new tickets. The package contents can be processed using filters, which reduce the number of tickets in the package according to your settings. The package contents can be saved to a file, printed as plain text and you can even fill the playslips. An extensive set of functions is available to simplify package processing: various statistics, winning numbers database, win tests and many other additional functions.

- **Filters**
  Filters remove tickets from the package according to your parameters. This way you can create cost effective bets using filters based on your lottery strategy.

The following schema demonstrates application modules and their dependencies:
Expert Lotto provides very effective feedback because the results of all application functions are reproducible and can be stored to a file. Such feedback then verifies your lottery strategy and contributes to improvement of your bet/win balance.

To get started with the application read Main Window section first. In How to section you can find a list of examples, which help to familiarize yourself with main application functions and their recommended use.
Getting Started

In this chapter you will find brief instructions how to use Expert Lotto for some of the most common tasks.

Generating (wheeling) new numbers

You can generate new tickets using Ticket Generator from menu Package ➔ Generator or clicking ⚙️ in application's toolbar. When you wish to create a full set of tickets covering all possible number combinations, select Ticket numbers range (e.g. all combinations of numbers from 1 to 15) and select option Generate maximum possible number of tickets. Then click Ok button. To generate tickets with random numbers switch the Generate maximum possible number of tickets option off and select Generate tickets with random numbers instead. Enter the number of Tickets to generate and then click Ok button. The generated tickets are stored in the package. Package page displays them as a table; Visual Package page displays the generated tickets in a visual form, which allows evaluating the distribution of ticket numbers. More on the Ticket Generator here.

Editing existing numbers/tickets

You can edit existing tickets in the package using controls in Package page - add a new ticket, remove selected ticket, change numbers in selected ticket etc. Or you can use filters to reduce the number of tickets in the package. For example you can remove all tickets that do not have the ratio of odd and even number equal to 3:3, which is statistically the most common combination. These functions are available from menu Filters. There are other functions for processing of tickets in the package in menu Package. E.g. you can swap any ticket number(s) for your "hot numbers".

Working with files

Tickets in the package can be saved to a file that you can reuse later on e.g. to check your winnings or to print them on playslips. Click button 📄 in application's toolbar or choose Save to file in menu Package to bring up a standard window for file name browsing. To insert into the package a previously stored file, click button 📄 or choose File in menu Package. Again a standard window for file name browsing appears. You can also drag and drop any ticket file into application's main window to bring up the Insert File window, which will have the dropped file pre-selected. Dropping the file while holding down the CTRL key inserts the file directly into the package.

Playslip printing

You can print tickets in the package directly to lottery's official playslips using menu Print ➔ Playslip. When printing to playslips for the first time you should adjust the
print margin corrections depending on the type of your printer. 

**Note:** This feature is disabled when playing a lottery, which does not use paper playslips for bet submission (bets are submitted online or by telephone only), or when playing one of Expert Lotto demo lotteries that are not actually operated (*Expert Lotto 6/49, Expert Lotto Keno and Expert Lotto Powerball*).

### Check your winnings

To find your winnings you can use e.g. page Package Winnings. First update the winning numbers database (see below), in *Winning Numbers Selection* panel choose *Latest 1* and eventually also choose the draw you wish to test. Load the file you wish to check (for example your latest bet) then click *Test* button. The table will display a list of tickets in the package and their winnings.

Another way is menu *Win Test ➔ Package*. Enter the latest winning numbers into the edit fields and click button *Test*. The table will display the score of winning prizes.

### Updating the winning numbers database

To add the latest winning number manually choose menu *Winning Numbers ➔ Add*. Select the draw date you wish to update from the list, enter drawn numbers into edit fields and click button *Add*.

For some lotteries you can use plugins for automatic online winning numbers update. If the lottery operator publishes the complete history of winning numbers at their web site then Expert Lotto plugin can download the latest winning numbers data from internet and update application's winning numbers database automatically.

**Note:** These plugins do not have to be included in the standard installation package. In such a case you have to download the plugin separately from www.expertlotto.com and install it yourself (see below).

### Statistics for the winning numbers and for tickets in the package

Application page Statistics offers various tables and charts calculated from winning numbers database where you can find the most and the least frequently drawn numbers, the count occurrences of any pair of numbers etc. The same statistics can be calculated for tickets in the package.

### Installing new application versions, plugins and additional lotteries

To upgrade to a new application version you only have to download the latest installation package from www.expertlotto.com and install Expert Lotto again to the same directory that already contains the old Expert Lotto version.

Some additional functionality is available in plugins that are installed separately. You can download new plugins from www.expertlotto.com for free. To install a new plugin or a new version of an existing plugin you must copy the downloaded file (*.plugin extension) to the *plugins* folder in application's installation directory (e.g. *C:\Program Files\ExpertLotto\plugins*). After restarting the application you will show a message with names and version numbers of newly installed plugins.

The same applies to additional lotteries that you can also download for free from www.expertlotto.com. Copy the downloaded file (*.pack extension) to the *data* folder in
application's installation directory (e.g. C:\Program Files\ExpertLotto\data). After restarting the application you will get a message with a list of the new lotteries.

**Advanced application features**

Some of the advanced application features is for example dummy numbers function, which allows working with tickets consisting of only three, four or five numbers instead of the regular six. You can then fill the remaining ticket number positions with your hot numbers.

You can also use Panel Coloring function that presents the frequency of number occurrences from selected winning numbers database range as a scale of different colors.

Another example is page Winning Numbers History. Using its functions you can find a small set of tickets, which is guaranteed to include the jackpot winning ticket. You only have to correctly estimate the trend of several chart lines presented in the page (i.e. the chart line will fall/ rise in the next draw).

**Creating your own lottery**

If your favorite lottery is not in our list at www.epxertlotto.com, you can create it yourself using *Lottery Wizard* (menu Lottery ➔ Manager ➔ New Lottery). You only have to answer a few wizard's simple questions (e.g. how many numbers are drawn, what is the range of drawn numbers etc) and the lottery is ready to play in a few moments, including playslip printing.
Glossary

- **Package** - denotes the part of application where you store the tickets you are currently working with. The Package is shown in Package and Visual Package pages. You can add tickets to the package manually in the Package page or using the Ticket Generator or you can load into the package a saved ticket file.

- **Ticket** - usually an ordered set of number for a single bet in your lottery. Some lotteries allow to place a bet with fixed count of numbers only. Some lotteries allow to place a bet with variable count of numbers (e.g. in Keno-type lotteries you can choose 1 to 10 numbers for a single bet).

- **Ticket file** - you can save tickets in the package to a file, which you can reuse later on, e.g. to check your winnings, print on playslips, find match with other tickets in the package etc.

- **Filter** - is a simple yes/no condition you can apply to tickets. A ticket can either pass or fail this condition depending on your settings of the filter. An example of a filter is a requirement for the ratio of odd and even numbers in a ticket, for instance the ticket must have the same count of odd numbers as the count of even numbers. You can reduce the number of tickets in the package by using filters thus decreasing the cost of bet and improving your chances to win.

- **Panel** - is a grid of drawn numbers as they appear on lottery's official playslip. The application uses panel to display and enter ticket numbers.

- **Playslip** - (or bet slip) is used to mark the numbers you wish to bet. It's usually done by crossing or markings number in grids on the playslip. You can also use the Playslip Printing feature and let Expert Lotto to fill the playslips for you. Playslips are available at lottery's outlet or retailer.

- **Winning numbers** - with Expert Lotto you can track all previously drawn winning numbers. The statistics and analysis of historical winning numbers is an important tool for your number selection. You can update the winning numbers database either manually or you can use application modules for online winning numbers update.

- **Draw date** - each set of drawn winning numbers (winning numbers ticket) is identified by the calendar date which the numbers were drawn on. The date consists either of the week of the year and the year or a regular calendar date (day/month/year).

- **Draw day** - if the lottery draws winning numbers several times a week then the draw date also includes the name of the day (e.g. Wednesday or Saturday).

- **Draw name** - some lotteries draw two or more sets of winning numbers in a single draw day. The draw date then includes the name of the draw (e.g. 1st Draw and 2nd Draw or Lotto and Lotto Plus).

- **Demo lotteries** - *Expert Lotto 6/49, Expert Lotto Keno* and *Expert Lotto PowerBall* are demo lotteries only, you cannot bet on these lotteries anywhere in the world. They only demonstrate Expert Lotto features and we also used them as examples in the application help pages.
Main Application Window

Menu bellow the window title bar provides access to the following functions:

- Lottery
- Package
- Filters
- Winning Numbers
- Win Test
- Print
- Help

Menu descriptions and their functions are available in separate sections of this help.

The toolbar bellow the main menu contains some of the most frequently used application functions. Hover your mouse cursor over any toolbar button to see its short description.

The largest part of the application window contains application pages offering most of application tables and lists:

- Package
- Visual Package
- Package Winnings
- Winning Numbers
- Visual Winning Numbers
- Statistics
- Package Statistics
- Filter Statistics
- WN History

You can switch between the pages by clicking your mouse on the page title at bottom part of the window. Switching to a different page preserves your data in the previous page.

This way you can for example use Generator to create a set of tickets in the package page and then you can review the number distribution in Visual Package page and eventually remove some tickets. At the same time you can compare this package with winning numbers from any draw date range in Package Winnings page and tag unwanted tickets. You may also wish to review tickets drawn in the past in Winning Numbers page and use panel coloring feature to determine the frequency of number occurrences for selected draw date range. Each page’s functions and their relationships are explained in examples in other help sections.

The bottom part of the application window contains status bar, which shows the name of the file last inserted into the package. When you generate new set of tickets into the package the name of the previous file is shown in italics with an asterisk appended. This image remains unchanged even if you apply command Back in menu for package processing. The next field to the right shows the current number of tickets in the package preceded by the current cursor position.
The icon at the end of the status bar shows the latest winning numbers in its tooltip.
Application Pages

Package Page

The Package page shows tickets in the package as a table. This is the default application page.

The upper left part of this page contains edit fields for ticket numbers entry. Entering a valid two-digit number into any edit field automatically moves input focus into the next field. Therefore it is more suitable to enter all numbers as two digits (e.g."01", "02" ...etc.). An invalid number (e.g. an out of range or duplicate number) is indicated by edit field's red background. You can also enter the ticket numbers by selecting a ticket from the list of favorite tickets by clicking button.

The table under the edit fields shows tickets in the package. Each row of this table corresponds to one ticket and each column in this table corresponds to one ticket number. The first table column is used for ticket tagging.

You can add tickets into the package by using the Ticket Generator, inserting winning numbers tickets or by loading previously stored content of the package.

The numbers of a ticket selected in the table are automatically displayed in edit fields and also on the panel (right). In the bottom right corner you can see ticket's ordinal number and the total count of tickets in the package. If the package contains newly
generated tickets the name of the last loaded existing file is in *italics* followed by asterisk.

The Panel offers an alternative way for entering ticket numbers by using your mouse. You can select any numbers on the panel by clicking the number boxes. When the count of checkmarks in the panel (including dummy numbers) is equal to the count of numbers in a ticket, these numbers are transferred to the ticket edit fields. The panel can also be colored using the colors from the WN History and Statistics pages. This way you can obtain another interesting tool for decision-making process concerning your bet.

Using the **Show coloring** button you can change background color for all number cells in the table. The color under each number corresponds to colors obtained by the panel coloring function. This way you are provided with the information on the frequency of occurrence of each drawn number.

The package contents can be modified using the following buttons:

- **Add** - the ticket from edit fields is added to the end of the package. When you try to add a ticket already present in the package the application shows an error message. This button is disabled if the edit fields contain invalid number(s).
- **Set** - will replace currently highlighted ticket in the table with ticket from edit fields. This button is disabled if the edit fields contain invalid number(s).
- **Search** - will search the package for the ticket entered into edit fields. If the package contains the requested ticket the corresponding table row is highlighted. Otherwise the application shows a message "*ticket not found*". This button is disabled if the edit fields contain invalid number(s).
- **Remove** - all the tickets from labeled rows of the table are removed.

Button **Statistics** will open information table with statistical values for ticket highlighted in the package table. The rows in this table correspond to columns of table from Package Statistics page. Asterisk in table header indicates that the highlighted ticket contains dummy numbers so some statistical data are incredible (for example *Sum*). You can hide/show some table rows by clicking **Customize** button. These changes are reflected in Package Statistics page and vice versa. You can leave the statistics window open while switching between main application tabs, which can be handy for other program functions.

Button **Print** button prints the current contents of the table on your printer.

If you perform any action in the Package page, e.g. add or remove some tickets, this action is visible also in Visual Package and Package Statistics pages. However such actions do not affect the Statistics page even if the *Calculate stats for tickets in the package* option is on. You must use button **Calculate stats** to refresh the Statistics page.
This page displays the package contents in a visual form and allows removing from the package or leaving in the package tickets that match a given set of selected numbers.

The table displays tickets in the package as a matrix. Each matrix row corresponds to one ticket in the package; each column corresponds to one drawn number. Numbers in position 10, 20, 30 etc. are highlighted using red color for better orientation. Matrix cells containing ticket numbers are filled with black color. Hovering the mouse cursor above any matrix point shows a tooltip with the number that the matrix point represents.

You can highlight any table column(s) by clicking the mouse in table’s header. This highlighting is displayed as yellow background in table columns. You can also highlight any column by clicking the appropriate number box in ticket panel on the right. To remove the highlight click column header or panel's number box again.

**Note:** You can change the layout of numbers in the matrix so that the odd numbers are displayed in the first half of the matrix and the even numbers are displayed in the second half.

Click the drop down button in the upper left corner of the table to display a menu where you can chose either *Regular* or *Odd - Even* number layout. This feature supports visual perception of odd/even numbers in tickets. Background of the half displaying odd numbers is highlighted in gray.

The last column of this table gives the count of ticket numbers, which belong to the highlighted columns. When the ticket does not contain any highlighted number the last column remains blank.

The last field in the column header shows the count of highlighted columns. When no column is highlighted this field is blank. Double-clicking this field cancels highlight for all columns.
To highlight columns you can also use numbers of any ticket in the package. Double-clicking the ticket while holding down the CTRL key cancels existing highlighting and the columns corresponding to ticket numbers are highlighted. Double-clicking any ticket while holding down the SHIFT key preserves existing highlighting and additional columns corresponding to ticket numbers are highlighted.

Button *Remove Match in* removes from the package tickets matching the highlight in a given count of numbers as indicated by the checkboxes next to this button. Function *Remove Match in* function accepts any combination of these checkboxes. When finished the application provides a message informing how many tickets were removed from the package and how many tickets remain in the package. This button is enabled only when at least one of the checkboxes is ticked.

The tickets in the table can be tagged by clicking the first column in the table.

Button *Print* prints the package contents in the visual form including the table header.

When tickets with dummy numbers are inserted into the package, the table shows only regular lottery numbers, dummy numbers are shown only in the panel on the right of the table.

When playing a powerball lottery (e.g. Expert Lotto Powerball) where you bet a bonus number(s) drawn from a separate pool, the table shows the bonus numbers as green boxes. If the bonus number matches a main ticket number then the green box has a black border.

**Example:**

- Use Ticket Generator to insert into the package 10000 tickets with maximum allowed match in four numbers.
- Switch to *Visual Package* page and highlight your favorite numbers (e.g. 18 different numbers as in the picture below).
In the picture above we highlighted 18 favorite numbers in the panel for a package containing 10000 tickets.

Using the *Remove Match in* function we removed from the package all tickets that match our selection in less than 6 numbers. Results are in the picture above. Seven tickets remain in the package, which according to our requirement should not match each other in more than 4 numbers.

If the chosen 18 numbers will contain all 6 drawn winning numbers then we managed to reduce the cost of our bet significantly. The given example is very simple just to demonstrate the function usage. However in practice you probably will apply more sophisticated approach to this function.

**Note:** Visual Package page functions are often used for fast selection of match in 4, 5 or 6 numbers with given selection when working with large numbers of tickets.

**Note:** The ticket panel offers also bonus number boxes when playing a powerball lottery.

**Package Winnings Page**
This page functions allow testing of the package contents to identify possible winnings of this package in the lottery history.

The upper left part of this window contains options for winning numbers selection.

Button Test initiates the testing of all package tickets for possible winning matches for the selected winning numbers draw range. This button is disabled when the package is empty.

The right hand part of this window contains the table of tickets in package with complementary information on the count and type of ticket winnings in your selected range of winning numbers draws (All Draws are selected above so the results show the winnings of each ticket for the whole history of the Expert Lotto 6/49 demo lottery).

The column header labels correspond to winning prize levels. Values in each column show the count of winnings for the appropriate prize. The table size is limited to 100 rows (tickets). If the package contains more than 100 tickets you can display the next 100 tickets by clicking Next 100 button. Clicking Prev 100 button will bring you back to previously displayed 100 tickets. The ticket number cells can be colored using the Show coloring button. Button Print will print the current content of the table, button Export will save the current content of the table to a text file.
Each ticket in the table can be tagged by clicking the checkbox in the first column.

The lower right corner of application window shows the total number of tickets in the package and the ordinal number of currently selected ticket.

<table>
<thead>
<tr>
<th>Ticket</th>
<th>☑ 1st</th>
<th>☑ 2nd</th>
<th>☑ 3rd</th>
<th>☑ 4th</th>
<th>☑ 5th</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 11 14 29 41 42</td>
<td>0 0 1 0 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16 18 30 31 34 39</td>
<td>0 0 1 0 25</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 16 33 35 39 46</td>
<td>0 0 1 2 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 4 10 29 32 35</td>
<td>0 0 1 1 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 5 6 15 26 31</td>
<td>0 0 1 1 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To display tickets winning higher prizes only uncheck appropriate checkboxes in column headers. The table will then contain only tickets that win the lowest checked prize at least (3rd prize in the example above; only the 1st, 2nd and 3rd prizes are required to be displayed). The table shows also lower prize winnings of these displayed tickets.

Checking option *Show winning tickets only* will cause that only tickets winning at least one prize in the selected draw date range are displayed.

When you press *Win Summary* button the program calculates all winnings and window containing table with list of all prizes will appear on the screen.

**Note:** Different background color is used to highlight the columns of winning tickets.

**Usage**

This function can be used to check the winnings of your package tickets. First bring your winning numbers database up to date after the latest winning numbers were drawn. Then load into the package the file with your last bet. In the Package Winnings page choose the appropriate draw (for example the 1st and 2nd Wed), select the Latest “1” and press the *Test* button. When option *Show winning tickets only* is on, only the winning tickets are displayed in the table (make sure that all column headers are checked before testing). When the table is empty your package unfortunately did not win anything. We wish you that this does not happen too often. To display all tickets you must unselect *Show winning tickets only* option. Then the package content is tested again for the chosen winning numbers selection and all tickets are displayed in the table including those that did not win anything.

**Usage before betting**

The function can be used for decision-making process concerning your future bet. E.g. you may decide to exclude all tickets from the package that won at least one of the 1st, 2nd and/or 3rd prizes throughout the whole lottery history. Another option is to prefer only tickets that reached at least one 5th prize during the last 30 weeks (120 draws) and to exclude tickets winning 4 or more such prizes during the same period. Please, refer to Example 3 for more details.
**Note:** If you wish to see details on any ticket switch to Package page click the Statistics button and return back to this page. Then click on any required ticket to see its details in the open window with statistical details.

## Winning Numbers Page

This function displays the database of winning numbers as a table. After selecting the range of winning numbers press button Select to display the winning numbers in the table. The first table column shows the draw date. When option Reverse order is set then the oldest database records are displayed first and the table rows are sorted by the draw date. Otherwise the table starts with the latest winning numbers records. Use controls in WN Selection panel to reduce the number of records displayed in the table.

To highlight a continuous range of tickets in the table click the first ticket in the range and then hold down the SHIFT key and click the last ticket in the range. To highlight non-adjacent tickets click the tickets while holding down the CTRL key.

When the panel coloring function is active then the background of number boxes in the panel will change according to the number occurrence in highlighted tickets. This function is especially useful when color perception is preferred. You can use this function for example to find so-called "hot numbers" (i.e. numbers drawn more frequently in a certain period) or to find out which numbers were not drawn in the
selected range of draws. The panel coloring is offered as an assisting tool for you decision process in other application screens that use the panel. The count of tickets forming the panel colors is displayed under the Coloring button. The panel also shows the numbers of the last highlighted ticket.

*Hide Selected* - this button removes from the table highlighted rows. The data are removed from the table display only, the winning numbers database is intact and clicking button Select again refreshes the table with all winning numbers draws from the selected range. You can use this button to *Export* only a portion of the data displayed in the table.

*Export* - stores the current table contents to a text file in CSV format that can be imported into any spreadsheet processor.

*Print* - prints the complete table’s content (i.e. all tickets selected by the *WN Selection* panel options).

**Caution**: The data on the status line of the main window relate to the package contents, not to controls in this page. Therefore *Count* status line field remains unchanged (0 when the package is empty).

**Visual Winning Numbers**

Visual Winning Numbers Page presents the winning numbers in a visual form, same way as Visual Package page.
The table displays the winning numbers tickets as a matrix. Each matrix row corresponds to one ticket of drawn numbers; each column corresponds to one drawn number. The first column displays the draw date. Numbers in position 10, 20, 30 etc. are highlighted using red color for better orientation. Matrix cells containing ticket numbers are filled with black color. Hovering the mouse cursor above any matrix point shows a tooltip with the number that the matrix point represents. The last column shows in how many numbers each individual row matches selection in the table header.

Note: Clicking button in the upper left corner of the table opens a pop-up menu with the following functions:

- **Number Layout** which can be: Regular, Odd/Even, Low/High. These switches serve as a support for visual perception of count of Odd/Even or Low/High
numbers in tickets. The half of the table displaying odd (low) numbers has gray background.

- **Auto-highlight latest winning numbers** - will automatically highlight numbers from the latest existing draw
- **Synchronize Number Highlight** - transfers highlighted numbers to Visual Package page.
- **Highlight Latest Draws** - clicking this button opens a new window for selection of draws from winning numbers database. The numbers from the selected draws are then highlighted in the table.

To highlight columns you can also use numbers of any ticket in the table. Double-clicking the ticket while holding down the CTRL key cancels existing highlight and the columns corresponding to ticket numbers are highlighted. Double-clicking any ticket while holding down the SHIFT key preserves existing highlight and additional columns corresponding to ticket numbers are highlighted as well.

Hovering mouse cursor on any point in matrix displays number corresponding to this point.

Button *Print* button prints current table contents including table’s header.

*Match Summary* button brings up a table showing how many tickets in the table match in 6, 5, 4, 6 ... 0 numbers with numbers highlighted in the bar.

*Show Ticket Panel* switch allows displaying ticket panel in the right-hand part of screen. This panel shows *ticket coloring* from e.g. *Winning Numbers* page.

Button *Remove Match in* allows removing from the package tickets matching the highlight in a given count of numbers as indicated by the checkboxes next to this button. This button is enabled only when at least one of the checkboxes is checked. **Note:** This function does not delete tickets from the winning numbers database; it only removes the tickets from the table. You can display all tickets (including the removed ones) by choosing the *Select* button again.

**Example:** Select from 13 to 15 numbers in table’s header. Click checkboxes 0, 1, 2, 3 and 4 and then click button *Remove Match in*. Then the table contains only tickets matching the selected numbers in 5 or 6 numbers. However this does not delete the tickets from the winning numbers database, the tickets are removed from the table only.

**Note:** When playing a lottery that draws a bonus number(s) (e.g. Expert Lotto 6/49 or Expert Lotto Power ball) the bonus numbers are displayed as green boxes. If the bonus number matches a main ticket number then the green box has a black border.

**Usage**

The visual representation enables easy and quick review of winning numbers. You can also use it to estimate the number distribution in each row, to look for pairs or triplets of successive numbers, to find repeating numbers and to find tickets matching the selection of numbers in table’s header.
Statistics Page

The Statistics page contains a set of functions focused on assessment of occurrence of numbers, pairs, triplets and quads of successive numbers, pairs of any numbers, ticket numbers sums etc. Most of these statistics are available in a table form and a chart form as well.

Statistics can be calculated separately for tickets in package, for winning numbers tickets and for combination of both. The range of winning numbers draws can be reduced by the WN Selection panel. Button Calculate Stats starts the calculation of all the statistics for the given selection. You must recalculate the statistics again using the Calculate Stats button whenever you change the selection of winning numbers and/or the package contents.

The list of available statistics and chart is in the upper left part of this window. The pop-down menu Show Stats for offers the following tables and charts:

- **General** - provides general information on the number of processed tickets.
- **Ticket Numbers** - contains table and chart with frequency of occurrence of numbers in processed tickets.
- **Bonus Numbers** - presents table and chart with bonus number frequency.
- **Sum** - contains table and chart of ticket number sums, table and chart for sum roots and Odd/Even sums table.
- **Odd/Even** - table and chart of Odd / Even numbers ratio
- **Low/High** - table and chart of Low / High numbers ratio
- **Odd/Even + Low/High** - table and chart with statistics for combination of Odd/Even and Low/High ratios
- **Sum Root + Odd/Even** - table and chart with statistics for combination of Odd/Even ratio and sum root values
- **Sum Root + Low/High** - table and chart with statistics for combination of Low/High ratio and sum root values
- **Pairs** - frequency of occurrences of any pair of numbers within processed tickets
- **Triplets** - frequency of occurrences of any triplet of numbers within processed tickets
- **Number Matrix** - presents the frequency of occurrences of all two-number combinations for the selected data. The results can be sorted by any row and by any column. Thus it is possible to identify how many times a given number was drawn together with any other number in the selected data. Using second table in this statistics you can also find out how many draws elapsed since the last occurrence (latest draws) of any given number pair.
- **Inverted matrix** - similar to the Number Matrix table. Column headings show the frequency values; table cells then present the particular pair of numbers. The Latest Draws option allows to display the table of pairs divided into columns, where each column shows how many draws elapsed from the last occurrence of the appropriate pairs (value “0” means the very last draw).
- **Successive Numbers** - provides information on the frequency of occurrences of pairs, triplets and quads of successive numbers for the selected data.
- **Dummy Numbers** - shows the number of tickets with and without dummy numbers.
- **Number Groups** - contains table and chart for count of numbers in each preset number group. In addition it contains table and chart for count of groups in processed tickets.
- **Ticket Positions** - provides data about frequency of occurrences of numbers in individual ticket positions.
- **Number Distance** - provides data about spacing between any two adjacent positions of numbers within tickets (Spacing means absolute difference between numerical values of numbers in two adjacent positions).
- **First / Last Digit** - provides tables and charts with frequency of occurrence of first and last digits at each ticket position.
- **Number Movement** - statistics for increase/decrease of ticket numbers at each ticket position when compared with the latest winning numbers draw.
- **Trailing numbers** - takes the latest draw as a precursor and then collects statistics of numbers drawn immediately after such precursors in the lottery history. The data are shown for the whole ticket and also per each ticket position.
- **Repeating Numbers** - shows how many times was each number repeated in the selected range of winning numbers draws.
- **Filters** - tracks how many draws elapsed from the latest occurrence, minimum and maximum skip and other statistical parameters (see below) for any filter.
- **WN History Segments** - shows occurrences and other statistical parameters (see below) for all combinations of segments from WN History.
- **Winning Numbers** - very useful tools providing tables and charts with an overview of values for majority of filters.
- **Options** - this option allows rearranging of columns in statistical tables and turning some statistics on/off.

The statistical table provide the following structure:

- **Evaluated parameter** - it is always the first column. It can be a number, a bonus number, sum, pair, triplet ....
- **Occurrence** - provides the frequency of occurrences of evaluated parameter in the whole set of processed tickets.
- **%** - gives the value of **Occurrence** as percentage.
- **Latest** - provides how many draws elapsed since the latest occurrence of evaluated parameter. Value "1" in this column means that the evaluated parameter exists in the latest draw in the current selection of winning numbers tickets.
- **Repeats** - provides information how many times the phenomenon given in the **Latest** column repeated in the selected period of the lottery history. If for example number "1" has value 6 in the **Latest** column and value 10 in the **Repeats** column then it means, that the situation where number "1" was drawn just 6 draws ago repeated 10 times in the lottery history.
- **Min Skip** - the minimum number of draws that elapsed between any two consecutive occurrence of the evaluated parameter in the selected range of winning numbers draws. For example in **Ticket Numbers** table value 8 in
column *Min Skip* for number 15 means that the minimum count of draws between any two adjacent occurrences of number 15 is 8. The value "1" in this column means that in the selected part of winning numbers database the number 15 occurred immediately in the next draw.

- **Max Skip** - the minimum number of draws that elapsed between any two consecutive occurrence of the evaluated parameter in the selected range of winning numbers draws. For example in Odd/Even table value 6 in column *Max Skip* for Odd/Even ratio 4/2 means that 6 draws at most elapsed since combination Odd/Even=4/2 was drawn again.

- **Average Skip** - provides average value for recurrence of phenomenon rounded to a whole number

- **Period** - provides exactly computed period of occurrence of assessed parameter in preset selection of winning numbers. It is in fact the total count of processed winning numbers draws divided by the total count of occurrences of the assessed parameter.

- **Due** - this value shows how much is the assessed parameter expected to appear in the next draw. The higher the value the more we can expect that the evaluated parameter will come up in the next draw (from statistical point of view). The value is calculated as *Latest divided by Period*. It means that if the evaluated parameter did not occur longer than its average period is then we can expect it in the next draw.

- **Rank** - the range of values in this column is 0 to 100. The value is calculated as *(Latest - Min Skip) / (Max Skip - Min Skip) * 100%. The higher the value, the higher statistical probability that the evaluated parameter will occur in the next draw.

Statistical charts provides graphical representation of the following columns from statistical tables: *Occurrence, Latest, Period, Due*. Click button *Options* under the chart window to change chart settings and/or to show/hide chart data.

Button *Print* button allows printing the currently displayed table or chart.

Button *Export* saves data from the current table to a file in a text format for processing in an external statistical and analyzing tool, e.g. spreadsheet processor.

**Filtering**
You can highlight one or more rows in any statistical table and click button *Filter* to open a filter window to keep in the package only tickets that match the selected statistical value(s). For example you can calculate statistics for 20 latest draws, switch to *Pairs table*, sort it by *Occurrence* column in descending order and highlight 15 most frequent pairs. Then you can use *Filter* button to keep in the package only tickets that contain one or more highlight pairs.

**Note.** Tickets with dummy numbers are included in statistics assessing number occurrences, pairs, triplets etc. However in case of statistics for sum assessment as well as in case of the statistics for Odd/Even ratios the tickets with dummy numbers are excluded from the results.

It is recommended to recalculate the statistics and apply filters again after replacing dummy numbers with real numbers.
Note: The calculation of statistics for tickets in the package runs in two execution thread. So if you have multi-core CPU then the process will be 30 to 40% faster (Expert Lotto Pro only).

Package Statistics Page

This package shows all tickets in package in a similar way like the Package page. However there are additional columns in the table showing an overview of values for some filters:

- **Sum** - sum of all numbers within ticket
- **Sum Root** - sum of individual digits in the sum; for example sum = 161, sum root = 8 (1+6+1)
- **StdDev** - standard deviation of individual numbers within ticket from their mean value.
- **Low/High** - ratio of low and high numbers within ticket
- **Odd/Even** - ratio of odd and even numbers within ticket
- **Odd/Even Positions** - information what kind of number exists in each individual position within ticket
- **Number Groups** - count of numbers form each individual preset group of numbers (see Number Groups filter)
- **Group Count** - the total count of groups the ticket falls in
- **Number Movement** - decrease or increase in numerical value in each ticket position against the latest ticket in the winning numbers database. According to lottery type it is possible to set in Options window which draw (for example 1st Sun, 2nd Wed) is to be used. (see also Position Filters ➔ Number Movement filter).
- **Movement Sum** - sum of all movements in individual ticket positions
- **Hit "xx" Prev** - the maximum match of ticket numbers with any of "xx" latest winning numbers draws. Value"xx" is customizable - click button Click Here for Options in table’s top left corner (see below)
- **First digit** - the first digits of numbers in individual ticket positions. Numbers 1 to 9 are considered as two-digits numbers: 01 to 09.
- **Last digit** - the last digits in individual ticket positions.
- **Max in Column** - the maximum count of numbers in one column of playslip panel
- **Max in Row** - the maximum count of numbers in one row of playslip panel
- **Repeated "xx"** - how many ticket numbers occur in the preset selection of "xx" latest winning numbers draws. Value "xx" is customizable - click button Click Here for Options in table’s top left corner (see below)
- **Ticket Index** - the column shows the position (index) of the ticket in the sequence of all possible combinations. For example in a 6/49 lottery the index "1" is assigned to ticket 1,2,3,4,5,6, index "13983816" (the highest value) is assigned to ticket 44,45,46,47,48,49.
- **Sum 0..10** - provides the value of WN History sums as if the ticket numbers were drawn (see also Draw Simulation in Summary Table)
- **Diff 0..10** - provides the value of WN History differences as if the ticket numbers were drawn (see also Draw Simulation in Summary Table)
• **StdDev(Diff)** - provides standard deviation computed from differences Diff -0 to Diff -10 (see Summary Table)

• **WNH Odd / Even** - shows which Winning Numbers History sums would be odd and which would be even if numbers of the given ticket were drawn. For example value O-E-E-O-O-O-O-O-E means that the sum in the first history column would be odd, sum in the second and third columns would be even etc. (see Summary Table)

• **WNH Odd / Even Count** - displays the ratio of odd and even sums from the WN History table.

• **WNH Segments 0 .. -10** - shows how the ticket numbers are distributed into the segments of History differences table. For example value 3-2-1 means that three ticket numbers belong to the first segment, two numbers are from the second segment and one number is from the last segment. The segment ranges are adjustable in application preferences.

You can handle the tickets in package the same way as in the Package page.

Clicking **Export** button saves the table contents in a text file (CSV), which you can load in other applications (e.g. spreadsheet processors).

Clicking table header **Click Here for Options** opens options window where you can edit the table layout:
You can show / hide any table column by ticking the appropriate check boxes in front of column name. Buttons Move Down and Move Up change the order of columns in table. For example if columns Sum and Low/High are displayed next to each other you can study conveniently how the higher occurrence of high numbers affects the Sum value.

You can assign any filter to each column in table to change the background color of corresponding fields if the ticket fails to match the filter conditions. So you get well-arranged overview for statistical values together with indication whether tickets match chosen filters. To assign a filter, click column name first, then tick option Use filter to highlight failed tickets and click button to select the desired filter and its parameters.

Clicking color field Background color for failed tickets opens standard window for color selection.

If more than one draw is drawn in one day or if numbers are drawn in particular days of week only, the lower part of this window will offer options for draw selection. These settings relate only to columns that are calculated from winning numbers: Hit "xx" Prev, Repeated "xx", Sum x, Diff x and StdDev(Diffs). Pay close attention to these options when working with columns Sum x and Diff x. The draw selection in this window should match the draw selection of winning numbers on WN History page or anywhere else in the program. If you are evaluating sums at History page for the 1st Sun and 2nd Sun draws only you should choose options 1st Sun and 2nd Sun in this window as well to calculate sums and diffs package tickets for the correct set of previous draws.

**Note:** You can change the count of draws ("xx") for Hit "xx" Prev and Repeated "xx" columns according to your preferences. When those fields are highlighted in the options window, a small edit field will appear at the bottom of the window allowing you to enter a new value.

### How to use

Usage of this table is very useful and wide-ranging. For example you can use filters corresponding to column type with an objective to identify how many tickets will pass your estimates for filter parameters. In such a case it is suitable to choose filter parameter using charts at Statistics page. Then you can find out how strict the filters are on tickets in the package.

However you can use non-corresponding filters as well. For example when estimating Sum value you can use filter Low/High = 4/2 - Matching Tickets Leave with coloring of failed fields in the Sum column (see example below). It is possible to use even filters that have no matching counter parts in this statistics table. For example for column Sum 0 you can use Winning Numbers History ➔ Segments filter and choose 3 to 5 numbers from the 1st segment of column "0" (or any other column and any segment).
Example

<table>
<thead>
<tr>
<th>Displayed columns</th>
<th>Preset filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>Low/High = 4/2</td>
</tr>
<tr>
<td>Repeated 5</td>
<td>WN History -column 0- the 1st Segment ends at 5th row and will contain from 2 to 4 numbers</td>
</tr>
<tr>
<td>Sum -0</td>
<td>WN History -column 0- the 1st Segment ends at 5th row and will contain from 2 to 4 numbers</td>
</tr>
<tr>
<td>Sum -1</td>
<td>without filter</td>
</tr>
<tr>
<td>Sum -2</td>
<td>contains number 19 or 23</td>
</tr>
<tr>
<td>Sum -3</td>
<td>without filter</td>
</tr>
</tbody>
</table>

The full list of all combinations was at first filtered using WN History filter preset to leave in the package tickets with *Sum 0* ranging from 360 to 380, *Sum-1* ranging from 740 to 770 and *Sum-2* ranging from 1170 to 1190.

With the above mentioned columns and filters the table will look like this:

<table>
<thead>
<tr>
<th>Click Here For Options</th>
<th>Sum</th>
<th>Repeated [5]</th>
<th>Sum 0</th>
<th>Sum -1</th>
<th>Sum -2</th>
<th>Sum -3</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>13</td>
<td>19</td>
<td>24</td>
<td>38</td>
<td>47</td>
<td>144</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>26</td>
<td>37</td>
<td>40</td>
<td>46</td>
<td>155</td>
</tr>
<tr>
<td>9</td>
<td>11</td>
<td>26</td>
<td>30</td>
<td>38</td>
<td>44</td>
<td>158</td>
</tr>
<tr>
<td>5</td>
<td>18</td>
<td>24</td>
<td>26</td>
<td>31</td>
<td>44</td>
<td>148</td>
</tr>
<tr>
<td>4</td>
<td>15</td>
<td>16</td>
<td>37</td>
<td>39</td>
<td>48</td>
<td>159</td>
</tr>
<tr>
<td>1</td>
<td>14</td>
<td>16</td>
<td>23</td>
<td>44</td>
<td>45</td>
<td>143</td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>26</td>
<td>36</td>
<td>40</td>
<td>44</td>
<td>158</td>
</tr>
<tr>
<td>20</td>
<td>31</td>
<td>33</td>
<td>37</td>
<td>44</td>
<td>46</td>
<td>211</td>
</tr>
<tr>
<td>14</td>
<td>32</td>
<td>33</td>
<td>43</td>
<td>44</td>
<td>48</td>
<td>214</td>
</tr>
<tr>
<td>5</td>
<td>22</td>
<td>31</td>
<td>32</td>
<td>38</td>
<td>46</td>
<td>174</td>
</tr>
<tr>
<td>5</td>
<td>14</td>
<td>43</td>
<td>44</td>
<td>45</td>
<td>48</td>
<td>200</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>40</td>
<td>42</td>
<td>45</td>
<td>49</td>
<td>194</td>
</tr>
<tr>
<td>7</td>
<td>15</td>
<td>32</td>
<td>33</td>
<td>35</td>
<td>48</td>
<td>170</td>
</tr>
</tbody>
</table>

Fields with pink and orange background indicate that the ticket failed the preset filter.

Filter Statistics Page

This is a tool to statistically evaluate the performance of a filter on previous winning numbers draws.
Selected filter is first applied to all tickets generated from a given range of numbers. The statistics of number occurrences are calculated for tickets that passed the filter. The resulting table then shows how many numbers of the most frequent ones match the actual winning numbers.

Control Description

- **Filter Input** - click button "->" and bring up options *Generator* and *Package*. 
  *Generator* - enter the number of test tickets and their number range to be used for statistic calculations. This is the same function as the Ticket Generator. It is recommended to choose all combinations from the complete range of drawn numbers to achieve the most accurate results. However it is possible to use randomly generated tickets or tickets from a limited range of numbers as well. 
  *Package* - current contents of package is used for evaluation.

- **Selected Filter** - click button "->" to select a filter and its parameters to be statistically evaluated.

- **Show filter hits for** - enter the number of winning numbers draws to be displayed in the table of results.

- **Calculate Hits** - click this button to update the results tables.

- **Print** - prints currently selected table or chart.

- **Export** - stores currently selected table to a text file in CSV format that is importable to any spreadsheet processor.

The statistics calculation can be replaced with other application features:

1. Generate into the package the selected number of tickets from the selected number range.
2. Apply the selected filter, choose *Matching Tickets Leave*.
3. Calculate statistics for the tickets in the package.
4. Show *Ticket Numbers Table* and sort it in descending order.
5. Take the first six, ten, fifteen, ... numbers from the sorted table and compare them with winning numbers. Write the match into the *Filter Statistics* table.

**Hits Table:** The first table column shows the draw date, the second column contains the drawn winning numbers. The rest of the table columns show how many numbers of the most frequently occurring ones match the actual winning numbers. For example, if column *First 6* shows value "2", then the winning numbers at this row contain two numbers of the six most frequent numbers. Value "4" in column *First 20* means that the twenty most frequent numbers include 4 winning numbers. Place your mouse cursor over any table cell to see a tooltip with the list of matching numbers.

**Hits Chart:** Shows data from the *Hits Table* as a chart. Use button *Options* to see chart data for other columns from the *Hits Table*.

**Numbers Table:** Shows number occurrences for tickets that passed filter's conditions. The total number of tickets that passed the filter is also available.

**Numbers Chart:** Shows data from the *Numbers Table* as a chart.
Note: If you select a filter that depends on the winning numbers database (Match Winning Numbers, Winning Numbers History or any compound or group filter containing any of these two), the statistics calculation will differ slightly. The calculation process will take longer because it will consist of several repeated step. The number of step depends on the option Show filter hits for. In each step the winning numbers database must simulate the situation when the last draw in the database is the latest date moved by the appropriate number of draws back to the history. It is necessary to ensure the correct evaluation of WN Selection option Latest XX in these two filters.

The data in the Numbers Table and Numbers Chart will differ according to the row (draw) currently highlighted in the Hits Table.

Example [Expert Lotto 6/49]

- Generate 100000 tickets with random numbers into the package.
- Switch to Filter Statistics page
- Choose Package in Filter Input field
- In Selected Filter choose filter Winning Numbers History - StdDev with the range of 14,0 to 21,0
- Enter 25/2009 as the cut-off date - the date of the last draw in the winning numbers database.
- Select Show filter hits for 10 latest draws.
- Click Calculate Hits button.

The resulting table will be similar to this:

From the resulting statistics we can see that after applying the selected filter there is one drawn number in the first six most frequent numbers (the first column) in four of the test draws. In six out of ten test draws there are two or more drawn numbers in the first 15 most frequent numbers (numbers of the tickets left after filtering) - column First 15.

Note: Page Filter Statistics is similar to Back-test feature, which shows how many past draws meet the filter criteria. However Filter Statistics evaluates the frequency of the numbers of tickets that passed the given filter. If you manage to find a filter that yields for example four or more winning numbers in the first 15 for most of the test...
draws then it might be a good idea to filter a full package with such a filter and then setup a wheel from 15 most frequent numbers from the filtered package.

**Winning Numbers History Page**

This page provides a tool for lottery strategy based on evaluation of the frequency of number occurrences in the lottery history. The reasons for this strategy are given here.

The upper left part of this window contains controls for winning numbers selection, where you can chose a subset of winning numbers database to be processed by the functions in this application page.

The right hand part of the window offers several sub-pages for each *Winning Numbers History* function:

- **Number History** - presents the history of occurrences of individual numbers up to their 11th occurrence back in lottery history. The next draw of winning numbers rearranges data in this table and you can correctly estimate this change using simple mathematical tools. The first column contains numbers from 1 up to the maximum drawn number according to currently selected lottery. Column labeled "0" shows the count of draws to the first occurrence of the number from a given row back in the lottery history. Remaining columns labeled "-1" to "-10" present subsequent repeated number occurrences in the lottery history displayed as the count of draws.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>-1</th>
<th>-2</th>
<th>-3</th>
<th>-4</th>
<th>-5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>15</td>
<td>19</td>
<td>20</td>
<td>28</td>
<td>35</td>
</tr>
</tbody>
</table>

From the table above you can see that number "1" came up just 3 draws ago; its second occurrence is 14 draws ago and the third occurrence of this number is 18 draws ago etc. (measured from the latest record in the winning numbers database). In parenthesis you can see the differences between neighboring columns (e.g. Difference(-5) = Value(-5) - Value(-4)). Option *Show* allows switching between *History and Differences, History only, Differences only and Differences and History* values being displayed in the table for better readability. The bottom part of this page shows row labeled *Sum*, which provides summary values for each column above. These sums then provide input for Summary Table. Detailed description and usage of this page is available here.

- **History Differences** - contains a table of differences for a single column of the *Number History* table. Each table row represents one possible difference value; each cell in the row then shows a drawn number for the given difference for the selected column. Basically this is an inverted table to the Number History table showing column differences only.
Option *History to Show* allows selecting the Number History column to be shown. Row headers show the difference value and the count of numbers in the row (in parenthesis), row cells contains all drawn numbers which have the same difference in the given column in the *Number History* table. According to the example above the difference (difference between column "-1" and "0") for number "4" has the value of 13. Above the table listing individual differences area the following data:

- **Max(-)** = provides the maximum negative difference which could arise should the last six numbers from the table list are drawn.
- **Sim** = provides numerical value of the future difference resulting from the simulated ticket.
- **Max (+)** = provides the maximum possible value of difference which could arise should the numbers in the first 6 positions in the appropriate table are drawn.

The table highlights numbers entered in the edit fields next to *Draw Simulation* option with a thick black border. The right hand part of this screen contains three segments where you can select conditions for package filtering invoked by *Filter* button. The button is disabled when the package is empty. Detailed description for these functions is available in a separate chapter for the History Differences page.

The bottom part of the screen contains *Simulate* button. This button starts random number generator to simulate winning numbers draws. After 100000 simulated draws the red/green progress bar provides the lowest and the highest sum values in selected column and also the median value and the number of steps carried out in simulation. When using this page for the first time these values are labeled as *n/a*. The progress bar shows the probability percentage of draws leading to decreasing sum value in the coming draw for the selected column.

- **Summary Table** - contains the sums for each columns back in the lottery history. The table displays 200 recent draws. You can change this count using menu *Lottery ➔ Preferences ➔ WN History - Number of rows in the Summary Table*. The row headers provide the date of the draw. Option *Show:* allows...
switching between History only, History and Differences, Difference only, Difference and History and Segments values being displayed in the table. The table data are also displayed graphically in History Chart page.

- **History Charts** - presents the development of sums from the Summary Table as a chart. The option in the upper left part of this screen allows switching between Summary Chart and Differences Chart. Each chart line represents one column from the Summary Table. The chart window appearance can be adjusted. If you drag the range lines of any chart then their new position(s) will be available as default parameter value(s) in Winning Numbers History filter window.

- **Simulation** - here you can simulate the sum development using (randomly) generated tickets or package contents. Table shows columns with sum values, estimates for their expected movement, average sum value after simulation with all the tickets from generator / package, average difference etc.

*Update* button updates the contents of all sub-pages for the selected winning numbers range.

*Print* button prints the contents of currently displayed table.

*Export* button allows exporting the currently displayed table to a file in a text format (CSV) suitable for processing in other applications, e.g. spreadsheet processors.

At the bottom of this screen you can find *Draw Simulation* option,

![Draw Simulation option](image)

which allows simulating the coming draw by entering your numbers into edit fields (numbers 1 to 7 are provided as defaults). The entered numbers are highlighted in History Differences table even if the Draw Simulation option is switched off. Turning the Draw Simulation option on recalculates the Number History table to simulate a draw (i.e. as if the entered numbers were drawn as the winning ones). The *Sum row* is updated as well and its values are added to the end of the Summary Table as a new row labeled *Draw Simulation*. These new sum values are also displayed in History Charts page.

Checking box *Use Package Tickets* the tickets are transferred from the to editing windows to package. You can scroll through package via arrows right from the number informing you about ticket position within the package. If the tickets in the package are tagged due to previous processing such tags are shown in the box "tag". You can also change this tag (insert/cancel tags).

You can also use favorite tickets to enter numbers for the Draw Simulation function.

**Note:** Detailed instructions for simplified use of this function is here.
Package

Menu Package

- **Generator** - allows generating new tickets into the package using either random or full wheels.

- **File** - allows inserting a file into the package. Invoking the function from the menu will first bring up a standard window for file selection. When working with files frequently you may also use the submenu with a list of up to ten files recently loaded into the package. Selecting any item from this submenu opens *Insert File* window with the chosen file name already preset. Choose *Browse* to select a file not in the list. Click *Clear* to remove all file names from the recent files list.

  You may also drag any ticket file e.g. from Windows Explorer and drop it anywhere in Expert Lotto's main window. This opens *Insert File* window with the file name already preset. Hold down the CTRL key when dropping the file to insert the file directly into the package without opening the *File Insert* window.

- **Wheel** - this function allows loading of wheels into package directly. Selecting this menu item opens dialog window *Insert Wheel*. This window works in a similar way as the *Insert File* window.

- **Winning Numbers** - inserts previously drawn numbers into package.

- **Save to File** - allows saving tickets in the package to a file. Invoking the function from the menu will first bring up a standard window for file selection.

- **Swap Numbers** - use this function to swap ticket numbers for other numbers.

- **Sort** - you can sort the tickets in the package in ascending or descending order. This way you can for example to quickly evaluate the occurrence of numbers in package tickets using Visual Package page.

- **Dummy Numbers** - allows swapping some tickets numbers for so called dummy numbers (i.e. numbers which are not drawn). This way you can work with combinations of only 2, 3, 4 numbers etc. This feature can be used for example to verify the coverage of your tickets in the package. You can also swap dummy numbers for your "hot" numbers.

- **Tagged Tickets** - any ticket in the package can be tagged. You can tag tickets in several application screens (*Package, Visual Package, Package Winnings* pages) and then work with tagged tickets only (save, remove or keep tagged tickets, invert the tags etc).

- **Shuffle** - allows shuffling tickets in the package. This function will randomly change the order of tickets in the package, which is especially useful if the package was sorted.

- **Remove Backups** - deletes all package backup files to free disk space. Package contents is automatically backed up before invoking any function which can add, remove or modify tickets in the package.

- **Empty** - removes current package contents.

- **Undo** - reverts the package contents to its previous state. You can set the number of undo steps in the *Preferences* window using the General page.

- **Redo** - cancels the effect of last *Undo* action.
Ticket Generator

Menu: Package ➔ Generator
Toolbar:

Generates tickets with random numbers or tickets for all combinations of a given range of drawn numbers.

Controls Description

- **Tickets to generate** - enter the count of tickets you wish to generate. The number to the right of this field shows the free disk space required to generate the given number of tickets. Should you choose Step option this information changes while the information in the Total field remains unchanged. Such way you can determine how the step size will affect the size of expected package.
- **Total** - shows the maximum number of tickets it is possible to generate from the given range of numbers. Masking any ticket position(s) with dummy numbers will decrease the count of possible combinations (e.g. when playing a "6/49" lottery one dummy number means that only combinations of 5 numbers will be generated, two dummy numbers mean that the generator will only create tickets for combinations of 4 numbers from the given range).
- **Ticket numbers range** - enter the range of numbers for generated tickets. You can change the lower range and upper range as well. Numbers from the chosen range are shown in red color, numbers outside the chosen range are shown in gray color and are not active on the panel. Changes to the range of numbers affect the count of possible combinations.
- **Bonus numbers range** - this options is visible only when playing a powerball lottery (i.e. bonus number(s) is drawn from a different pool of numbers than the main ticket numbers). See the instructions at the end of this chapter.
- **Generate maximum possible number of tickets** - choosing this option will make the Tickets to generate field inactive and it will automatically contain the maximum count of possible combinations.
- **Step size** - this field is active only when option Generate maximum possible number of tickets is selected. The number in this field instructs the ticket generator to write to package only every Nth ticket from the whole list. Thus entering value e.g. 100 means that the whole list of combinations will be reduced hundred times. The option is especially useful for Keno-type lotteries as it allows to process reduced number of tickets while maintaining ticket number statistics more or less even.
- **Panel** - allows swapping numbers in generated tickets.
- **Generate tickets with random numbers** - when this option is set the generated tickets will be composed of random numbers. The generator ensures that there will be no two tickets with the same numbers.
- **Maximum overlap** - you can specify the maximum allowed match between generated tickets. For example when set to "3" then it is guaranteed that no generated ticket will match other tickets in more than 3 numbers.
- **Dummy numbers** - the generator allows to use dummy numbers. You can mask any ticket position(s) using dummy numbers and thus work with only a part of the ticket. E.g. in a 6/49 lottery you can work with tickets composed of...
only 5, 4, 3 or 2 numbers from the given range. Dummy numbers are shown in the bottom of the panel.

- **Use Filter** - clicking this button enables an option to select any filter to be applied on generated ticket before they are stored in the package. Only tickets that pass filter's condition will be stored in the package.
- **Coloring** - this button brings up the *Panel Colors* window where you can switch the panel coloring on or off. The coloring represents the frequency of number occurrences in your selected range of winning numbers draws.
- **Action** - there are four different ways of inserting generated tickets into the package.
- **Toggle** - *Switch to Simple Mode/ Switch to Advanced Mode* will allow switching between easy and advanced mode of generator. The easy mode is the default mode when you start the Expert Lotto program for the first time.
- **OK** - choose this button to start the ticket generator, use the *Cancel* button to close this window.

**Usage**

Using the generator you can fill the package with either tickets composed of random numbers or tickets representing all possible combinations for a given range of numbers. Then you can use filters to reduce these tickets according to your lottery strategy.

**Example [Expert Lotto 6/49]**: Create 1000 random tickets with maximum allowed match in 3 numbers. The upper number range is set to 24. Some numbers are swapped for other numbers. Generated ticket will overwrite the current package contents. The settings in *Generator* window will look as follows:
The label to the right of the *Tickets to generate* shows the generated ticket will require 6.8kB of free disk space. The range of numbers was set to 1 to 24 in the *Ticket numbers range* field. These numbers are shown in red on the panel and are active. Other numbers are shown in gray and are inactive. In the example above we chose the following number swap: 1 for 28, 3 for 36, 5 for 42 etc. The maximum allowed match was set to 3 numbers. That means that no generated ticket will match other tickets in more than 3 numbers.

The generator will create the first 85-90% of the ticket very quickly then it will slow down because it must respect the *Maximum allowed match* settings. The speed of ticket generator depends on:

- number of tickets to generate - the more tickets you wish to generate, the longer it will take
- maximum allowed match - the lower the number, the longer it takes to find a random ticket which matches other tickets in the given count of numbers
- count of dummy numbers - dummy numbers reduce the count of maximum possible combinations the generator can work with

You can see a progress bar when tickets are being generated. The operation ends when all tickets have been generated or you can also cancel it yourself using the *Cancel* button. When generating random tickets the progress bar may stop in the middle because the generator is trying to lookup a ticket, which does not match
previously generated tickets in more numbers than the allowed maximum. In this case you should cancel the operation, the package will contain only tickets generated so far.

After the operation is finished you will get an announcement how many tickets were inserted into the package.

The number of generated tickets is limited only by the size of available memory and by available free disk space of your PC. For example when playing lotteries where 10 numbers are drawn from a pool of 80 numbers, tickets for all possible combinations would require 16TB of free disk space. This is far beyond the capacity of most today's home computers.

When the random tickets options is switched off the generator creates tickets composed of successive numbers covering all possible number combinations. For example when generating 1000 ticket from a range of 24 numbers the generated tickets will cover the first 1000 possible combinations. If you choose the Generate tickets with random numbers and enter the number of maximum possible combinations into the Tickets to generate field the generator will create tickets composed of successive numbers covering all combinations instead of generating random tickets.

You can reduce the count of generated tickets by checking appropriate ticket position(s) in the Dummy numbers list.

<table>
<thead>
<tr>
<th>Dummy numbers</th>
<th>Number range</th>
<th>Max. count of pentads</th>
<th>Max. count of quads</th>
<th>Max. count of triplets</th>
<th>Max. count of pairs</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>24</td>
<td>42504</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>24</td>
<td></td>
<td>10626</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>24</td>
<td></td>
<td></td>
<td>2024</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td>276</td>
</tr>
</tbody>
</table>

You can use tickets covering all combinations of two, three and four numbers to validate the coverage of your bet, such an example is here.

**Ticket generator for "powerball" lotteries**

The generator window is slightly different when playing powerball lotteries (i.e. lotteries where bonus number(s) is drawn from a different pool than the main ticket numbers). The panel contains main ticket numbers as well as powerball numbers. Generated random tickets will also have a random bonus number(s). You can set the range of main ticket numbers and the range of powerball numbers. When generating tickets from successive numbers each main numbers combination will be repeated for each powerball number. You can set the upper range of powerball numbers to "1"
to get only one combination of main ticket numbers. The rest of the ticket generator functions work the same way as described above.

**Insert File**

*Menu:* Package ➔ File
*Toolbar:* 📄

Allows to insert a ticket file into the package. Invoking this function from the menu will first bring up a standard window to browse a file you wish to insert. You can also drag and drop any ticket file into application's main window to bring up this window, which will have the dropped file pre-selected. Dropping the file while holding down the CTRL key inserts the file directly into the package.

The name of the file last loaded into package is shown in the status bar in the lower part of the program window.

**Controls Description**

- **File** - shows the name of the file that will be inserted. The text below this field shows the size of the file and number of tickets in the file. You can browse a different file by clicking 📄 button.
- **Tickets** - tickets in the file may be tagged. This option allows to insert tagged tickets only or un-tagged tickets only or all tickets from the file.
- **Action** - there are four different ways of inserting the file into the package.
- **OK** - inserts the selected file into the package.
- **Cancel** - closes this window.

**Usage**

You will find this function useful in many ways. You can save the package contents after its each modification when preparing tickets for your bet. The steps of your lottery strategy may branch and each saved file may contain different sets of tickets. Therefore it might be useful to return to a previous step and continue with a different branch of your lottery strategy. That means to browse for a saved file and insert it into the package.

It is also useful to insert a saved file when you wish to check your winnings. Insert the file into the package and switch to the Package Winnings page where you can find out your winnings.

**Insert Wheel**

*Menu:* Package ➔ Wheel
*Toolbar:* 📄

This function is similar to the Insert File function. The function allows inserting tickets stored in a plain text file (file extensions "csv" or "txt") - so called wheels. You can download wheel files from internet or you can create your own files using Expert
Lotto functions. Because of the nature of the wheel files this window does not contain options to change the type of insertion (i.e. overwrite, append, merge, remove). Thus the current package content is directly replaced with the wheel contents. The Insert Wheel window offers ticket panel for number swapping.

The name of file last loaded into the package is shown in the status bar at the bottom part of program window.

Attention: Wheel files for all lotteries have the same extension "txt" or "csv". Therefore it may be suitable to indicate the lottery type in the wheel name. Trying to load a wheel to a lottery with incompatible parameters will lead to an error message.

**Insert Winning Numbers**

*Menu: Package ➔ Winning Numbers*

*Toolbar: 📂*  

Allows to insert a selection of winning numbers draws into the package.

**Controls Description**

- **WN Selection** - here you can choose the range of winning numbers draws that will be loaded into the package. The description for the winning numbers selection is here.

- **Number positions to use** - this option allows to use only selected ticket number positions. Numbers at unselected positions will be filled with dummy numbers, powerball numbers (i.e. bonus numbers drawn from a different pool of numbers than the main ticket numbers) will be set to "1". When playing a lottery which draws more numbers than you can actually bet (Keno-type lotteries), you can select which part of winning numbers tickets will be loaded into the package. E.g. the first half of winning numbers ticket, numbers at odd positions only etc.

- **Action** - there are four different ways of inserting winning numbers into the package.

Winning numbers are loaded into the package in their natural order (the latest draw as the first one), the *Reverse order* options allows to insert the oldest draws as the first ones.

**Usage**

You can use this function for example to find out the match between the latest draw and all other historical winning numbers.
Example [Expert Lotto 6/49]: Switch to the Winning Numbers page. Select option All Draws and click the Select button. In the list click on the draw with the date 28/2009 2.Wed to initiate number coloring. Then hold down the SHIFT key and click on the draw with the date 23/2009 1.Sun. This way you selected 24 winning numbers draws for the panel coloring. Each color represents a frequency of numbers from the selected range of 24 draws. Use menu Package → Winning Numbers and insert winning numbers from 01/2008 to 28/2009. Switch to the Package Winnings page and choose Date Range 01/2008 to 28/2009. Click the Show Colors button and then click the Test button. The result is in the figure below:

The package content has been tested. The column for the first prize is always equal to 1 because the package contains winning numbers. Values in other columns indicate how often the latest winning numbers match winning numbers from the selected date range (in this case 01/2008 to 28/2009) in 5, 4 or 3 numbers. In this case you can see that the latest winning numbers match seven times in 3 numbers with winning numbers from the selected date range. Match in 4 numbers is not very frequent so that may lead to a conclusion that you should prefer tickets matching winning numbers from the selected range in at least 4 numbers. You can find more detailed explanation in chapter Package Winnings.

You can also use this function for example to evaluate, which numbers appear at the third ticket position in the date range 20/2009 to 28/2009. Select 3. number only in
the *Number positions to use* list and uncheck positions 1, 2, 4, 5 and 6. The result will look as follows:

Numbers from the third ticket positions are highlighted with yellow number for better transparency. (See also *Match and/or Statistics ➔ Winning Numbers Charts ➔ Options ➔ Ticket Position 3*).

### Save the Package into a File

**Menu:** Package ➔ Save to File  
**Toolbar:** 

Use this function to save the package contents to a file.

Invoking this function from the menu will first bring up a standard window to select a folder and a file name. You can enter a new file name or choose an existing file, which will be overwritten.

The default file format is binary which saves the disk space and allows fast loading of the files back to the package.  
To save tickets in a text format select *Files of type "CSV or Text Files"*. You can import files in this format into other applications, e.g. spreadsheet processors. See also detailed instructions for exporting the package contents in a text format.

The file name which the package contents was saved to is shown in the status bar at the bottom part of the program window. Asterisk behind the name indicates that the package contents with the loaded file was changed for example by using a filter.

### Controls Description
Expert Lotto Help

- **File** - name of the file, which the tickets will be saved to. You can select a different file name by clicking the button.
- **Tickets** - you can choose to save only tagged tickets, or to save only un-tagged tickets or to save all tickets in the package.
- **Append tickets to the end of the file** - select this option to append tickets from the package to the end of an existing file.
- **OK** - saves the package to the selected file. You will see a progress bar when saving a large number of tickets.
- **Cancel** - closes this window without saving.

**Usage**

You can use this function to store the package contents at any step while preparing the tickets for your bet.

**Swap Ticket Numbers**

*Menu: Package ➔ Swap Numbers*

Allows swapping numbers in tickets in the package for other drawn numbers. The function is not active if the package is empty.

**Controls Description**

- **Panel** - use panel boxes to select the numbers to be swapped. The numbers in red are active and are present in the package. Numbers in gray are inactive.
and do not appear in any package ticket. First click a number you wish to swap and then click a number to be replaced with.

- **OK** - swaps the numbers according to your settings.
- **Cancel** - closes this window.

You will find the number swap panel also in the Ticket Generator window. Therefore you can swap numbers while generating new tickets as well as when the package already contains tickets.

You can also swap ticket numbers for dummy numbers. If the package contains dummy numbers you can swap them for regular drawn numbers. Dummy numbers are shown in blue under the regular number in the panel.

Let's have a ticket with one dummy number (e.g. dummy number "94"). Now we want to swap some other number for dummy number "94". Then dummy number "94" will be used in all tickets which do not contain this dummy number yet. However if the ticket already contains dummy number "94" then the number being swapped will be replaced with dummy number assigned to its ticket number position (1st position = 94, 2nd position = 95, 3rd position = 96 etc). The resulting dummy number used will differ because the number being swapped can appear at different ticket positions. Now let's use the package from the figure above and let's swap number 6 for dummy number 94. The result is shown in the figure below. In the third ticket from the bottom number 6 was replaced with number 94. However the sixth ticket from the bottom already had dummy numbers 94 and 95 so number 6 was replaced with dummy number 96 instead.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>11</td>
<td>28</td>
<td>31</td>
<td>36</td>
<td>44</td>
</tr>
<tr>
<td>94</td>
<td>10</td>
<td>22</td>
<td>30</td>
<td>36</td>
<td>46</td>
</tr>
<tr>
<td>13</td>
<td>15</td>
<td>29</td>
<td>40</td>
<td>46</td>
<td>48</td>
</tr>
<tr>
<td>94</td>
<td>9</td>
<td>18</td>
<td>25</td>
<td>27</td>
<td>29</td>
</tr>
<tr>
<td>5</td>
<td>19</td>
<td>27</td>
<td>35</td>
<td>37</td>
<td>42</td>
</tr>
<tr>
<td>94</td>
<td>95</td>
<td>36</td>
<td>13</td>
<td>16</td>
<td>48</td>
</tr>
<tr>
<td>3</td>
<td>95</td>
<td>15</td>
<td>21</td>
<td>33</td>
<td>48</td>
</tr>
<tr>
<td>94</td>
<td>5</td>
<td>7</td>
<td>15</td>
<td>37</td>
<td>47</td>
</tr>
<tr>
<td>94</td>
<td>14</td>
<td>18</td>
<td>25</td>
<td>27</td>
<td>39</td>
</tr>
<tr>
<td>7</td>
<td>13</td>
<td>24</td>
<td>30</td>
<td>34</td>
<td>44</td>
</tr>
<tr>
<td>94</td>
<td>14</td>
<td>43</td>
<td>44</td>
<td>45</td>
<td>49</td>
</tr>
</tbody>
</table>

This way you can:

- Mask all ticket positions.
- Repeat the number swap and mask more than 6 numbers allowed in one step.

**Dummy Numbers**

*Menu: Package → Dummy Numbers*

Allows working with dummy numbers.
Controls Description

- **Dummy numbers positions** - select dummy numbers positions you wish to work with.

- **Action** - choose what to do with selected masked numbers positions:
  - *Set dummy numbers* - modify all tickets in the package so that their numbers will be replaced with dummy numbers at selected positions.
  - *Remove tickets from the Package* - remove from the package all tickets containing dummy numbers at selected positions. A ticket will not be removed if it contains also other dummy numbers than the selected ones.
  - *Leave tickets in the Package* - keep in the package all tickets, which contain dummy numbers at selected positions. All other tickets will be removed from the package.

- **OK** - starts the selected action during which you will see a progress bar window.

- **Cancel** - closes this window.

The figure above shows an example package with numbers masked using Swap Numbers function. Please remember that the Dummy Numbers function will process only tickets with the same dummy number as your selection. It means that a ticket with dummy numbers at positions “2”, “5” and any other position will be retained in the package when you select the Remove option. A ticket with only one selected dummy number will be retained in the package as well.

The following example demonstrates the Leave option:

Let’s start with the following package:
Using these settings only the following ticket will be kept in the package

```
5 95 8 13 24 40
```

because only this ticket has only one dummy number at position "2". In a similar way, tickets with masked position "1" will be kept in the package when removing tickets with masked positions 1 and 2.

You can also use this function to find the frequency distribution of numbers at any ticket position throughout the lottery history or in a given date range. Here is an example for the frequency distribution of numbers at the third ticket positions from the lottery start till 28/2009.

**Example:**

1. Use menu **Package ➔ Winning Numbers** and insert the complete winning numbers database into the package.
2. Use menu **Package ➔ Dummy Numbers** and mask numbers at positions 1, 2, 4, 5 and 6.
3. Switch to the **Statistics** page and choose the **Calculate Stats** button.
4. Show the **Ticket Numbers Chart**.

The result should be similar to this:
Notes:

1. The dummy numbers feature can be exploited in many ways and the only limit is your inventiveness when incorporating dummy numbers into your lottery strategy.

2. The tickets containing dummy numbers are indicated by * sign in the header of the Ticket Statistics window. Thus some values are not valid. See for
example function *Number movement* in the first position.

3. All filters accept tickets with dummy numbers. This may lead to unwanted results when working with dummy numbers until you swap dummy numbers for regular drawn numbers (namely the *Sum* and *Odd/Even* filters).

4. The only statistics that ignore tickets with dummy numbers are the *Sum* and *Odd/Even* statistics. In all other cases tickets with dummy numbers are included in the statistics results.

**Print Playslips**

*Menu: Print → Playslips*

This function allows printing tickets in the package to lottery's official playslips. The function is not active if the package is empty or when playing a lottery, which does not use paper playslips for bet submission.

When printing to playslips for a lottery, which does not have playslip layout and dimensions defined yet, you will first see a prompt to define playslip layout.

**Controls Description**

- **Print All** - choose this option to print all tickets in the package.
- **Print Selection** - choose this option to print only a range of tickets from the package and enter the range you wish to print into the edit fields. Your printer may load some playslips incorrectly so the printed playslip is unusable. This option allows to print tickets from such a playslip again.
- **Print Page Numbers** - select this option to print tickets ordinal numbers on the playslips (the number is printed in such a part of the playslip that does not affect the playslip scanning equipment).
**Playslip Orientation** - select how you load playslips into your printer. The *Portrait* option expects playslips to be loaded like this:

![Portrait example](image)

That means that the lowest number of the first panel is in playslip's upper left corner.

select the *Landscape* option when your printer loads playslips like this:

![Landscape example](image)

That means that the lowest number of the first panel is in playslip's bottom left corner.

**Print margin correction** - Each printer type has different unprintable margin settings so that the check marks may be printed outside the check boxes. In this case you can use the *Print margin correction* option. If the check marks are shifted to the left of the check boxes use a ruler to measure the shift.
distance and enter it into the \textit{left} field. If the check marks are shifted to the right, enter the measured distance as a negative number. If the check marks are shifted to the upper edge of the playslip, enter the shift distance into the \textit{top} field. If the check marks are shifted to the lower edge of the playslip, enter the measured distance as a negative number. Use decimal numbers for print margin correction to achieve better accuracy.

\textbf{Note:} You can change ellipse (circle) marking your bet on the playslip by rectangular box. To do so you must can cell checkbox in the menu \textit{Lottery-Manager-Edit labels and color settings- Playslip}.

- \textbf{Panel Options} - in this part of the window you can select additional check marks assigned to each playslip's panel (e.g. the count of check marks in the panel for Keno-type lotteries or the bet amount multiplier etc.). The count and purpose of these options depend on your lottery settings. The options are not available if the lottery playslip does not have any additional panel-related options.

- \textbf{Playslip Options} - in this part of the window you can select additional check marks that are common for the whole playslips (e.g. the number of repeated draws etc.). The count and purpose of these options depend on your lottery settings. The options are not available if your lottery playslip does not have any additional options.

To change the playslip layout or its dimensions open the Lottery Manager and choose the \textit{Edit Settings} button.
Filters

What is "Filter"

Filter is a simple yes/no condition, which you can apply to tickets. A ticket can either pass or fail this condition depending on your settings of the filter. You can also choose whether you wish to remove from the package tickets passing filter's condition or tickets failing filter's condition. You typically use a series of different filters to cover all your lottery strategy needs.

Each filter window includes the Matching Tickets option where you can select to Remove from the package all tickets passing filter's condition or to Leave them in the package.

Ok button starts filtering tickets in the package according to your filter settings. You can see a progress bar during the filtering process. The filtering can be interrupted at any time using Cancel button below the progress bar. When the filtering is done you will get a message with the number of tickets removed from the package and the number of tickets left in the package.

Apply button does the same as the Ok button however the filter window stays open when the filtering is finished. This way you can again apply the same filter using different filter parameters.

Cancel button closes the filter window.

All filters also include Preview button, which can be used to preview the filter results without actually removing any tickets from the package. You will get the number of tickets passing filter's condition (Passed) and the number of tickets failing filter's condition (Failed). The Total line shows the total number of tickets in the package.

Use button Back-test to check, how the filter performed in lottery history.

Filters are enabled only when the package is not empty. An exception is file filters, which process tickets in a selected file instead of package tickets. File filters are therefore enabled even when the package is empty.

The Filters menu offers tools to implement your lottery strategy. Let's look at some simple examples:

Example [Expert Lotto 6/49]:

- Let's assume that in the latest 5 draws no ticket had 3 odd and 3 even numbers.
  The statistics show that the combination of 3 odd and 3 even numbers is the
most common one. Using the Ticket Generator you create 1000 random tickets. Then you use the Odd/Even filter and leave in the package only tickets with 3 odd and 3 even numbers.

- Let's assume that in the latest 5 draws mostly high numbers were drawn. You can expect that in the next draw mostly lower numbers will be drawn to keep statistics even. When ticket numbers are evenly distributed their sum should be close to value of 150 (the sum of 6 numbers with an average value of 25). Therefore you use the Sum filter to keep in the package only tickets with sum values up to 150 to favor lower numbers.

- Very common is also the situation when the drawn numbers include a couple of successive numbers. Let's assume that there were no two successive numbers drawn in the latest 5 draws. However 3 successive numbers were drawn.
  You use Successive Numbers filter to remove from the package all tickets containing any four or three successive numbers and tickets containing two or three pairs of successive numbers. You keep only tickets with one pair of successive numbers. You also remove tickets with no successive numbers.

- Looking at the winning numbers database you may decide that the winning ticket should not match any winning numbers ticket from the last 30 draws in more than three numbers.
  You use the Match Winning Numbers filter to remove from the package all tickets matching winning numbers tickets in four and more numbers during the last 30 draws.

- The winning numbers database shows that the last 24 draws do not include numbers 2, 24 and 29. The most frequently drawn number for the last 24 draws is number 6.
  You decide to give preference to tickets containing at least one of the numbers 2, 24 or 29 together with number 6. You use the Tickets with Numbers filter to do so.

The examples above include simple filters only for better readability. Each lottery player chooses their own filters depending on the current state of the winning numbers database and implements their lottery strategy using these filters and their combinations. The filters can be combined and repeated at will. You can find detailed description of each filter in separate chapters of these help pages. When setting the filter parameters you can use additional tools the application offers, such as Statistics, Panel Coloring etc.

Majority of filters can apply also over any file of tickets regardless it is loaded into the package.

**Note:** Most filters run in two execution threads so if you have multi-core CPU then the filtering process should be 30 to 40% faster *(Expert Lotto Pro only)*.

**Odd/Even Filter**

**Menu:** Filters → Odd / Even

This Filter allows to leave/remove from the package tickets with given number of odd and even numbers.
The odd/even ratio can be a part of your lottery strategy. Statistics for large number of tickets show that the ratio of 3 odd and 3 even numbers has the highest occurrence. Tickets with only 6 odd numbers or only 6 even numbers occur very seldom. The best demonstration of this rule is the Odd/Even Chart in the Statistics calculated for the full package (i.e. all possible combination of drawn numbers).

You can only enter the count of odd numbers; the count of even numbers is updated automatically.

Tickets will pass filter's condition if and only if their odd/even ratio is exactly equal to your selected value. I.e. when filtering out tickets with 5 even numbers, tickets with 6 even numbers will be not removed from the package. You must select 0:6 ratio as filter's parameter to remove such tickets.

Example [Expert Lotto 6/49]: The sequence of Odd/Even filterings to remove tickets with 6 even numbers then to remove tickets with 5 even numbers, with one even number and then with no even numbers leads to a situation where the package contains only tickets with the following odd/even ratios: 4:2, 3:3 and 2:4. The application is very flexible so you can achieve the same result by using the filter to leave in the package only tickets with 3:3 ratio first and saving them to file. Then use the Undo function to restore previous package state and apply the filter for 2:4 ratio and append remaining tickets to the end of previous file. Now repeat the same for 4:2 ratio and again append remaining tickets to the end of the previous file.

Note: The filter evaluates dummy numbers as well. Dummy numbers affect the filter according to their value (94 is even number, 95 is odd number etc). You should be aware of this feature and eventually apply the filter again after replacing dummy numbers with regular numbers.

**Sum Filter**

*Menu: Filters ➔ Sum*

One type of ticket assessment is the sum of ticket numbers, which is how the Sum filter works: it removes or leaves in the package all tickets whose sum is in your selected range of values.

You can enter the sum range using your keyboard or you can click the spin buttons in edit fields.

You can enter the same value both for the minimum and the maximum sum values. This way you can remove/leave only tickets with the selected sum value.

It is also possible to filter tickets that have odd or even sum value only. When option Allow is checked then all filtered tickets will have the sum of ticket numbers in the given range AND the sum value will be odd or even only.

**Sum Root** is an additional filter parameter. Its numerical value ranges from 1 to 9 and it is calculated as a consecutive sum of individual digit in the sum value. For example the sum value 158 = 1 + 5 + 8 = 14 and subsequently 14 = 1 + 4 = 5. Thus the sum root for sum 158 is number "5". Using Check Sum Root and checking appropriate
boxes for individual sum roots you can filter tickets with uniform distribution of numbers while reducing the package contents significantly.

**Example:**
Let's consider ticket 1, 8, 12, 26, 31, 32 - sum for this ticket is 110 and sum root is "2". However also tickets 2, 7, 12, 26, 31, 32 or 3, 6, 12, 26, 31, 32 have the same filter results because they have the same sum value (110). Note that all these tickets match each other in 4 numbers.

See also the Statistics page.

**Note:** The filter evaluates dummy numbers as well. Dummy numbers increment the ticket sum according to their value. You should be aware of this feature and eventually apply the filter again after replacing dummy numbers with regular numbers.

**Note:** When playing a powerball lottery (i.e. bonus number(s) is drawn from a separate pool of numbers than the main numbers, e.g. Expert Lotto Powerball) the powerball number is **not included** in ticket's sum.

**Note:** You can track how this filter performed in the lottery history on page Statistics ➔ Winning Numbers ➔ Winning Numbers Table. Furthermore, Winning Numbers Chart page allows you to set parameters for this filter by drag & drop of margins to required position (chart window must be displaying one set of data only - see Options button under the chart window).

When the package is not empty you can click Filter button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the Filter button. The actual values of margin positions are displayed at the status bar under the chart window.

**Successive Numbers Filter**

*Menu: Filters ➔ Successive Numbers*
The filter allows to remove/leave in the package tickets with pair(s), triplet(s) and quad(s) of successive numbers.

After analyzing the winning numbers database you will probably find out that almost half of the draws contain one pair of successive numbers. On the other hand tickets with five or more successive numbers are very rare. Therefore you may decide to remove such tickets from your package.

Expert Lotto offers the *Successive Numbers* filter to do so.

This simple filter allows to remove or leave tickets that contain the given count of successive numbers (pairs, triplets, quads etc). The maximum count of successive numbers depends on the count of numbers in the ticket. There must be at least one quad of successive numbers. If the ticket can contain more than one quad (e.g. lotteries where you can bet 10 numbers in one ticket) it will pass filter's condition the same way as the tickets with only one quad.

To demonstrate how this filter works select the Expert Lotto Keno lottery and generate 100 tickets with 10 numbers in each. Then use the *Successive Numbers* filter to leave only tickets with one triplet of successive numbers. Now apply the filter again to filter the remaining tickets to leave only tickets with 1, 2 (or 3) pairs of successive numbers. Each triplet will be now considered as a pair only. That's why when filtering tickets with two pairs of successive numbers the resulting tickets will include also tickets with one triplet and another pair of successive numbers.

The filter leaves/removes tickets containing **at least** the required count of two- three- or four successive numbers. If you define requirement to remove tickets containing "1" couple also tickets containing 2 or 3 couples and 1 or 3 triplets or 1 quad will be removed.

Four successive numbers are considered as two pairs of successive numbers (it's in fact three pairs of successive numbers) and also as one triplet (it's in fact two triplets of successive numbers). Therefore a ticket will not be removed when filtering out tickets with only one pair. The ticket will remain in the package also when filtering out tickets with three pairs of successive numbers.

**Example [Expert Lotto 6/49]:** Enter into the package the following tickets "1,2,3,4,5,6" and "1,2,3,5,6,7" and "1,2,3,6,7,8" and "1,2,3,7,8,9" and "4,5,9,10,11,49". Ticket 1,2,3,4,5,6 matches the condition for two triplets of successive numbers in a ticket and also the condition for one triplet of successive numbers. At the same time the ticket matches condition for three pairs, two pairs and one pair of successive numbers. A ticket with one pair and one triplet of successive numbers (e.g., 4,5, 9,10,11,49) will match filter's condition for one triplet of successive numbers and also for two pairs of successive numbers.

So when you want to keep tickets with **one and only one** pair of successive numbers you must first select tickets with **at least** one pair of successive numbers and then filter out tickets with two and three pairs of successive numbers.

The filter does not take into account dummy numbers.
Match Winning Numbers Filter

Menu: Filters → Match Winning Numbers

This filter allows to compare your tickets with the complete winning number history or with only a subset of previously drawn numbers and find the given match.

The filter removes from the package or leaves in the package tickets matching winning numbers selection in the given count of numbers. You can select the winning numbers subset using the controls in the left hand part of the filter window. The ticket will pass the filter if it matches at least one ticket in the winning numbers database in the given count of numbers.

For example, using this function you can leave in the package only tickets that did not win any first, second, third and fourth prize during the last 60 draws.

Example [Expert Lotto 6/49]:

- Check all four draws in WN Selection
- Enter "60" into the Latest field
- Select Match in 4, 5, 5+1 and 6 numbers; leave columns Min, Max blank (option A)

- Enter 2 for the minimum match and 4 for the maximum match into columns Min, Max (option B)
Filters

65 tickets passed the filter for the 1st condition, 3 tickets passed the filter for the 2nd condition.

Note: Leaving column Min blank is equal to 1 to <max value>; leaving column Max blank is equal to <min value> to infinity.

- select Matching Tickets Remove

Note: Match selection means searching for the exact count of matching numbers only. For instance checking option to remove Match 4 will remove only tickets matching winning numbers in exactly four numbers. The filter will ignore tickets matching in 5 or more numbers and tickets matching in 3 or less numbers. To remove tickets matching in four and more numbers you must check options Match 4, Match 5, Match 5+1 and Match 6.

In the example above (option B) we ask for the removal of tickets that match in 4 numbers at least two and at most four winning numbers tickets from the last 60 draws. It means that tickets matching only one and/or 5 or more winning numbers tickets are left in the package.

It is solely up to you how to use this function. E.g. after analyzing the winning numbers database you can decide to bet only tickets matching the last 30 draws at least once in three numbers but no more than in four numbers.

It is very likely that no lottery drew the same winning numbers again during its history. So it is probably safe to remove from the package all tickets equal to any of the previously drawn tickets.
When the winning numbers tickets did not match each other in five numbers for a long time we can expect that such a match is likely to appear in the next lottery draw. Then you would prefer tickets matching any winning numbers tickets in five numbers. A strict mathematician will oppose that we are trying to statistically assess events, which are not statistically related and that each lottery draw is an individual event unrelated to the other drawings. However some correlations do exist. One that we know for sure is the usage of the same lottery drawing machine. (That's why some lotteries publish also the type and name of the used drawing machine).

**Match Tickets in the Package Filter**

**Menu: Filters → Match Package**

Using this filter you can compare tickets in the package with each other. This filter is similar to the Match Tickets in a File filter however the tickets are compared with each other.

The filter start with the first ticket in the package and compares it with the rest of the package until a matching ticket is found or end of package is reached. Then the filter continues with the second ticket and compares it with the rest of the package (starting with the third ticket in the package) etc. That's why the filter favors the end of the package when lower match requirements are selected.

**Example [Expert Lotto 6/49]:** Use the Generator to create 1000 random tickets from the whole range of 49 numbers. Select filter *Match Tickets in the Package* and choose options *Match 2* and *Remove Matching Tickets*. Only a few tickets should be left in the package. Switch to the Package and compare these tickets with each other. You will find out that they match each other in one number at most. Write down these tickets and restore the package using the Undo function from the *Package* menu. Switch to the Visual Package page and click the numbers of the first ticket in the panel. Ticket's numbers will be highlighted in the table. In the last table column showing the match count you'll probably see numbers greater than "2". Use table’s scroll bar to find the ticket you entered (the second blue row in the figure below).
The figure above shows another blue line showing a match in three numbers. It's because you **restored** the package with all 1000 tickets and these tickets were filtered out before.

**Notes:**

- Likewise when you choose match in "0" numbers and **Remove**, only the last matching ticket is left in the package.
- The filter is not suitable for tickets composed of successive numbers. When you use **Ticket Generator** to create tickets covering all possible combinations of a given range of numbers then each ticket in the package will match the following ticket in five numbers. The package is sorted so after filtering out match in 5 numbers the package will contain only the last ticket, after filtering out match in 4 numbers the package will contain the last 7 tickets, filtering out match in 3 numbers will lead to 28 last tickets remaining in the package etc. If you shuffle the tickets first then you can use this filter meaningfully. Filtering random tickets favors the end of the package especially when filtering out low matches.
- The **Generator** allows to specify the maximum allowed match of generated tickets from "0" to "6" numbers. Try generating 10000 random tickets with maximum allowed match in 6 numbers. Then use this filter to leave in the package only tickets matching in 6 numbers. Write down the resulting tickets (if any) and **Undo** the last operation to restore the original 10000 tickets. Switch to the Visual Package page, select all checkboxes in the **Remove match in** option except for the checkbox for 'match in 6' and click the **Remove** button. The package will contain only two identical tickets.
- The filter can be used to check large number of tickets for duplicates. This can be a case when merging several large files into the package without checking for duplicity.
When processing large numbers of tickets the progress bar's movement is slow at first but is speeding up later on because the filter is processing a decreasing number of tickets.

This function is suitable for quick and simple modification of package. It is recommended to combine it with some other filters.

The minimum and maximum counts for required matches can be entered into corresponding table cells. For example when entering Min 5 and Max 8 in row Match in 3 the filter will remove all tickets that matching in three numbers with at least 5 tickets but at most with 8 other tickets from the package. It is possible also to enter either the minimum or the maximum values only for required match.

### Match Tickets in a File Filter

**Menu:** Filters ➔ Match File

Filter *Match Tickets in a File* is similar to the Match Winning Numbers filter however it does not look for matching ticket in the winning numbers database but in a selected ticket file.

Invoking this filter from the menu will first bring up a standard window to browse a file you wish to compare with the package. The name of the selected file is then shown in the upper part of filter's window together with the count of tickets in the file. You can browse a different file by clicking button 📂.

Option *Tag matching tickets* allows to use so called *tagging mode* when applying this filter. It means that the filter compares the first ticket in the package with tickets in selected file. When a match is encountered then the matching ticket in the file is tagged and will not compared with package tickets any more (as if the ticket was not part of the ticket file).

Then you can load the file into the package and use functions for tagged tickets to see the percentage of matching tickets. You must realize that for e.g. a 6/49 lottery one ticket represents 20 different combinations of three numbers. Therefore when the ticket is ignored after being tagged another 19 possible combinations of three numbers are excluded from filter’s comparison. That’s why the filter’s results using the *Tag matching tickets* option will differ from the regular filter’s usage.

Option *Allow variable combination size* is available only when a text-based file has been chosen for matching. When checked, this options says that each line of text in the matching file may contain different count of drawn numbers. For example when playing a 6/49 lottery the matching file may look like this:

```
2, 3, 5, 7, 11, 35, 44, 46, 49
14, 22, 32
9, 5, 11, 33, 21, 14
12, 15, 18, 12, 19
```

Please note that lines may contain more than six numbers (the first line in the example above). In such a case the maximum match would be six numbers. Lines may also contain less than six numbers (the second line in the example), in this case...
the maximum match would be three numbers. Numbers on each line do not have to be in ascending order (the third line) and numbers at each line may even repeat (the fourth line in the example above). In this case the maximum match would be four numbers.
The field separator can be a comma ",", semicolon ";", space " " , tab char or colon ":" . Lines starting with "#" char ignored (can be used for user comments).

Example: Generate 100 random tickets from the whole range of drawn numbers and save the package into a file named test1. Then generate all possible combinations of three numbers (Generator - Dummy numbers at positions 6,5,4) and save them into a file named all3. Then use filter Match Tickets in a File to compare the combinations of three numbers in the package with file test1 (Tag matched tickets option is on). Load the test1 file into the package to review the tagged ticket. Then use the Remove Tags function to cancel tagging.
Now repeat the steps above to compare file test1 in the package with file all3. Again review the results in the all3 file by loading it in the package. In both cases select Matching Tickets Leave when using the filter.

Note: It is possible to enter the minimum and maximum possible values for required match. For example entering Min 5 and Max 8 in the row Match in 3 the tickets are "removed from /left in" the package when matching in three numbers with at least 5 tickets but at most with 8 tickets from the chosen testing file. It is possible also to enter either the minimum or the maximum values only for required match.

### Match Numbers Filter

**Menu:** Filters ➔ Match Numbers

Filter Match Numbers allows processing of package in such way that it will contain only those tickets matching selected set of numbers in defined count of numbers.

You can choose any count of numbers in the ticket panel. Then mark the required match count(s) in the table. After filtering the package will contain only tickets which contain the selected count of numbers from all numbers marked in the ticket panel.

Example: This function can take advantage of the Panel coloring feature. If you believe that frequently drawn numbers will appear also in the next draw, you can activate Panel Coloring and then you can check numbers with background color that indicates higher occurrences.

Because No Match option is also allowed this function can be used for removal of all tickets containing at least one number out of the selected ones.

### Random Selection Filter
**Menu: Filters ➔ Random Selection**

The filter removes from the package the given number of randomly selected tickets. The filter window contains only two fields where you can enter either the count of tickets you wish to remove or the count of tickets you wish to leave in the package. This filter is not available in the list of File Filters.

Entering a value into one edit field automatically updates the value in the other field. When opened for the first the default values are set to the half of the package tickets. This filter does not offer the Preview function, as it has no use in this case.

**Systematic Selection Filter**

**Menu: Filters ➔ Systematic Selection**

The filter removes from the package the given number of tickets at the given positions. Enter the number of tickets to be removed using your keyboard or by clicking the scroll buttons. Due to its nature this filter does not offer the Preview function. This filter is not available in the File Filters list.

**Single Numbers Filter**

**Menu: Filters ➔ Single Numbers**

The numbers for filter's condition are selected using the panel grid in the left hand part of the filter window. Click any number to select it for the filter, click the number again to unselect it.

Using option All must be present you can choose whether a ticket is filtered out if and only if it contains all selected number (Yes selected) or that a ticket is filtered out if it contains at least one of the selected numbers (No selected).

Switching the All must be present option from Yes to No and the other way round clears the panel.

As in other application screens where the panel is used you can take advantage of the Panel Coloring, which can offer additional information for your filtering decisions.

The filter processes tickets with dummy numbers as well.

**Pairs Filter**

**Menu: Filters ➔ Pairs**

The pairs for filter's condition are selected using the panel grid in the left hand part of the filter window. All numbers are shown in red except for the highest number box,
which is not active. Click any number box in the panel to select a pair; the second number of the pair is selected automatically. (That's why the highest number box is grayed out). Click the first number of the pair to unselect it. Option *All must be present* allows to choose if a ticket must contain all selected pairs to pass filter's condition (*Yes* selected) or if only one selected pair in the ticket is enough to pass filter's condition (*No* selected). You can select more pairs than the ticket can actually hold (e.g. a ticket can hold three pairs at most for a 6/49 lottery). When option *All must be present* is set to *Yes* then the filter works according to the following table:

<table>
<thead>
<tr>
<th>Pairs in a ticket</th>
<th>Selected pairs (All must be present set to Yes)</th>
<th>Pass Filter?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>1</td>
<td>4 and more</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>4 and more</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>4 and more</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*The table above demonstrates filter logic for tickets with six numbers (e.g. Expert Lotto 6/49), the logic is analogous when playing lotteries with different count of numbers in a ticket.*

Note that when option *All must be present* is on then pair's supplementary number is grayed out and is not active. Switching this option to *No* you can also click the supplementary numbers. This way the pairs can overlap so you can select pair 1,2 and also pair 2,3. Click number 2 box to select the second pair.

You can select any number of pairs in the panel.

Switching option *All must be present* from *Yes* to *No* and the other way round clears panel's selection.

As in other application screens where the panel is used you can take advantage of Panel Coloring, which can offer additional information.

The filter processes tickets with dummy numbers as well.

**Triplets Filter**
**Menu: Filters ➔ Triplets**

This filter is similar to the Pairs filter. The triplets for filter's condition are selected using the panel grid in the left hand part of filter window. All numbers are shown in red except for the last two number boxes, which are not active. Click any number box in the panel to select a triplet; triplet's supplementary numbers are selected automatically. (That's why the last two number boxes are grayed out). Click the first number of the triplet to unselect it. Option *All must be present* allows to choose if a ticket must contain all selected triplets to pass filter's condition (*Yes* selected) or if only one selected triplet in the ticket is enough to pass filter's condition (*No* selected).

You can select more triplets than the ticket can actually hold (e.g. a ticket can hold two triplets at most for a 6/49 lottery). When option *All must be present* is set to *Yes* then the filter works according to the following table:

<table>
<thead>
<tr>
<th>Triplets in a ticket</th>
<th>Selected triplets (All must be present set to Yes)</th>
<th>Pass Filter?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>1</td>
<td>3 and more</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>3 and more</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*The table above demonstrates filter logic for tickets with six numbers (e.g. Expert Lotto 6/49), the logic is analogous when playing lotteries with different count of numbers in a ticket.*

Note that when option *All must be present* is on then triplet's supplementary numbers are grayed out and are not active. Switching this option to *No* you can also click the supplementary numbers. This way the triplets can overlap so you can select triplet 1,2,3 and also triplets 2,3,4 and 3,4,5. Click number 2 and number 3 boxes to select the other triplets.

You can select any number of triplets in the panel.

Switching option *All must be present* from *Yes* to *No* and the other way round clears panel's selection.

As in other application screens where the panel is used you can take advantage of Panel Coloring, which can offer additional information.

The filter processes tickets with dummy numbers as well.

**Ticket Numbers Range Filter**

**Menu: Filters ➔ Ticket Numbers Range**
This filter allows tickets selection based on scattering of their numbers throughout the range of drawn numbers.

**Controls Description**

The filter has two switches: *The maximum difference of every* and *any*:

**Filtering The Maximum difference of every**

The filter ensures that matching ticket will have the difference of starting and ending numbers of all sequences of given length in the given range. (If the ticket contains 6 numbers then the sequences can be any two, three, four or five tickets' neighboring numbers. E.g. for ticket 1 - 2 - 3 - 4 - 5 - 6 the sequences are 1-2, 2-3, 3-4, 4-5, 5-6 (two numbers); 1-2-3, 2-3-4, 3-4-5, 4-5-6 (three numbers); 1-2-3-4, 2-3-4-5 a 3-4-5-6 (four numbers) etc.)

Let's use the following four tickets in the package as an example:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>4</th>
<th>8</th>
<th>10</th>
<th>15</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>4</td>
<td>8</td>
<td>10</td>
<td>15</td>
<td>18</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>3</td>
<td>4</td>
<td>8</td>
<td>15</td>
<td>18</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

When you select *The maximum difference of every 3 neighboring numbers in the ticket is "2 to 7"* and choose to *Leave* matching tickets in the package then the result will be:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>4</th>
<th>8</th>
<th>11</th>
<th>15</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

Because the differences of starting and ending numbers of 3-number sequences are in the range of 2 to 7:

<table>
<thead>
<tr>
<th>Sequence (Ending Number - Starting Number)</th>
<th>Difference</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-1</td>
<td>7</td>
<td>OK</td>
</tr>
<tr>
<td>11-4</td>
<td>7</td>
<td>OK</td>
</tr>
<tr>
<td>15-8</td>
<td>7</td>
<td>OK</td>
</tr>
<tr>
<td>18-11</td>
<td>7</td>
<td>OK</td>
</tr>
</tbody>
</table>

However tickets 1, 4, 8, 10, 15, 18 and 1, 3, 4, 8, 15, 18 have at least one sequence with difference greater than "7".

<table>
<thead>
<tr>
<th>Sequence (Ending Number - Starting Number)</th>
<th>Difference</th>
<th>Result</th>
</tr>
</thead>
</table>
Using this filter you can control how ‘far’ (or how ‘close’) are ticket’s numbers from each other throughout the whole range of drawn numbers. You can understand the filter advantages better when applied to lotteries like Expert Lotto Keno. It is important to realize that all number sequence must pass the difference condition. The filter is suitable for example when processing tickets with dummy numbers - see Example 2.

**Filtering The Maximum difference of any**

The filter ensures that matching ticket will have the differences of starting and ending numbers of at least one 3-number sequence in the range of 3 to 19 as shown in the figure above. The ticket added - 1, 3, 22, 27, 42, 49 - has all these differences greater then 19 thus it fails the filter (22-1= 21, 27-3=24, 42-22=20, 49-27=22)

Selecting filter parameters as shown in figure below yields the following results:
The filtered-out tickets are in the table below. No 3-number sequence of these tickets has the difference of starting and ending numbers lower or equal to the specified value.

```
1 4 8 10 15 18
1 4 8 11 15 18
1 3 22 27 42 49
1 4 8 10 15 48
```

**Number Distance Filter**

*Menu: Filters ➔ Number Distance*

This filter is focused on how the ticket numbers are spread throughout the whole range of drawn numbers.

```
Match the numbers at neighboring positions
```

```
Passed: 4
Failed: 996
Total: 1000
```

*Neighboring positions* are positions such as: 1 - 2; 2 - 3; 3 - 4; 4 - 5; 5 - 6
The options set in the figure above require that the filtered tickets must have the absolute value of the difference of at least 3 and at most 5 neighboring positions at least 12 and 14 at most. You can verify this result in the figure below that shows such four tickets:

<table>
<thead>
<tr>
<th>Click Here For Options</th>
<th>Number Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 7 20 32 33 46</td>
<td>04 13 12 01 13</td>
</tr>
<tr>
<td>2 14 18 30 42 46</td>
<td>12 04 12 12 04</td>
</tr>
<tr>
<td>7 20 21 33 37 49</td>
<td>13 01 12 04 12</td>
</tr>
<tr>
<td>3 16 18 21 34 46</td>
<td>13 02 03 13 12</td>
</tr>
</tbody>
</table>

The ticket in the 1st row shows difference 13 between the 2nd and the 3rd position; difference 12 between the 3rd and 4th positions and difference 13 between the 5th and the 6th positions.

**Standard Deviation Filter**

*Menu: Filters ➔ Standard deviation*

Filter *Standard Deviation* offers parameters to set the minimum and the maximum values of standard deviation calculated for the average value of all ticket numbers.

In general, if the first and the last ticket number are close to each other then standard deviation value is very low (for example ticket 1, 4, 5, 6, 9, 12 has standard deviation 3.87 or ticket 34, 35, 42, 43, 44, 45 has standard deviation 4.76). On the other hand, tickets with numbers distributed into two separate groups have the highest value of the standard deviation (for example ticket 1, 4, 5, 6, 46, 49 has stddev 22.55 and ticket 3, 7, 41, 43, 47, 49 has stddev 20.89).

**Note:** The tickets mentioned above are from a 6/49 lottery. Tickets 1,2,3,4,5,6 and 44,45,46,47,48,49 have the lowest possible value of the standard deviation (1.87), ticket with numbers 1,2,3,47,48,49 has the highest possible stddev value (25.21).

**Note:** The term *Standard Deviation* is used in several places within the program. These are *Standard deviation* in Winning Numbers History (page WN History, Summary Table column StdDev(Diffs)) and standard deviation labeled as Diffs StdDev in Simulation table on WN History page) and finally standard deviation labeled as StdDev applied for differences between calculated mean number and individual numbers within one ticket, which is also used in this filter window.

**Note:** You can track how this filter performed in the lottery history on page Statistics ➔ Winning Numbers ➔ Winning Numbers Table. Furthermore, Winning Numbers Chart page allows you to set parameters for this filter by drag & drop of margins to
required position (chart window must be displaying one set of data only - see Options button under the chart window).

When the package is not empty you can click Filter button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the Filter button. The actual values of margin positions are displayed at the status bar under the chart window.

Panel Filter

Menu: Filters ➔ Panel

The filter removes from the package (or leaves in the package) all tickets that have the given maximum numbers in each playslip panel's row and/or column. The maximum count of numbers in each panel's row and column depends on playslip panel layout (see Lottery Manager) and on the count of number you can bet.

Note: The expression and/or appears in more topics in this context help. It means that two options can be applied together or separately.
The filter will ignore all tickets when the maximum allowed values are entered into edit fields.

The filter does not take into account dummy numbers.

The figure above shows that at most two numbers are allowed in each panel's row and at most three numbers can appear in the same panel's column. Therefore only tickets with numbers placed evenly on the whole panel should remain in the package.

When the count of panel columns is lower than the count of bet numbers, the filter will not allow to filter out tickets with only one number in each column. (E.g. when playing a lottery where six numbers are bet and the playslip panel has 5 columns then the minimum value you enter is 2 numbers in each column).

**Note:** You can track how this filter performed in the lottery history on page *Statistics ➔ Winning Numbers ➔ Winning Numbers Table*. Furthermore, *Winning Numbers Chart* page allows you to set parameters for this filter by drag & drop of margins to required position (chart window must be displaying one set of data only - see *Options* button under the chart window).

When the package is not empty you can click *Filter* button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the *Filter* button. The actual values of margin positions are displayed at the status bar under the chart window.

### Powerball Filter

**Menu:** Filters ➔ Powerball

Some lotteries draw one or more additional bonus numbers for each winning numbers set - so called *powerball* lotteries. When the bonus number(s) is included in the numbers you bet then the list of filters contains also the *Powerball* filter.

As said above some lotteries may draw more than one bonus number so the filter offers the *All must be present* option. The filter removes/leaves only tickets with the
Filters

selected bonus (powerball) numbers. The All must be present option is ignored if only one bonus number is drawn.

**Number Groups Filter**

*Menu: Filters ➔ Number Groups*

Filter Number Groups allows to distribute the ticket numbers into several user-defined number groups.

<table>
<thead>
<tr>
<th>Group:</th>
<th>Numbers in group min:</th>
<th>max:</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ 1 - 10</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>☑ 11 - 20</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>☑ 21 - 30</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>☑ 31 - 40</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>☑ 41 - 49</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Logical Condition: [And] [Or]

Check that ticket falls into [ ] to [ ] number groups.

The top part of the window shows number groups ranges. Use check boxes to add number groups to filter's condition. The count of numbers in each group ranges from "0" to the maximum count of numbers in the ticket or to the number group size (whichever is lower).

In the example above the following settings are selected: group 1 to 10 is required to contain at least 2 and at most 4 ticket numbers; group 31 to 40 is required to contain at least 1 and at most 3 ticket numbers and finally group 41 to 49 must contain again at least 1 and at most 3 ticket numbers. Using buttons for logical conditions you can modify filter's logic. Button And means that the ticket will contain at least the minimum and at most the maximum count of numbers from each active group at the same time.

It is also possible to specify how many unique numbers groups the ticket numbers must fall into. This data can be tracked in Package Statistics page for tickets in the package and in Winning Numbers statistics table for past draws.

The count of number groups and their ranges is customizable using button Customize Groups. The groups need not be of identical size. This filter setting affects also appropriate column in the Winning Numbers Table (Statistics) and calculations carried out in the Package Statistics page.

Using the Back test button you can find out how the filter applied in the past. The distribution of past winning numbers into number groups is available in Statistics -
Winning Numbers Table in column Number Groups. The content of this column corresponds to the current definition of number groups.

Note: You can track how this filter performed in the lottery history on page Statistics ➔ Winning Numbers ➔ Winning Numbers Table. Furthermore, Winning Numbers Chart page allows you to set parameters for this filter by drag & drop of margins to required position (chart window must be displaying one set of data only - see Options button under the chart window).

When the package is not empty you can click Filter button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the Filter button. The actual values of margin positions are displayed at the status bar under the chart window.

The steps above apply to Group Count chart as well.

First/Last Digit Filter

Menu: Filters ➔ First/Last Digit

Filter First/Last Digit filter controls which first/last digit a ticket should contain. The First Digit is the digit at the first position of a ticket number, for example if a ticket has numbers 2, 15, 23, 34, 37, 49 then its first digits are 0, 1, 2, 3, 3, 4.
The Last Digit is the digit at the second position of ticket number, for example if a ticket has numbers 2, 15, 23, 34, 37, 49 then its first digits are 2, 5, 3, 4, 7, 9.

Controls Description

- **First Digit/ Last Digit** - choose which digit the filter should use.
- **Digit** - check boxes for digits a filtered ticket must contain.
- **Logical Condition** - choose whether a matching ticket must contain all selected digits ("And") or whether a matching ticket must have at least one of the selected digits.
- **Check that** - use these option to define how many digits may repeat in a matching ticket. You can also select the minimum and the maximum number of repeating occurrences.
Example [Expert Lotto 6/49]:

The example above will leave in the package only tickets that have two numbers with digit "1" in the first position And two numbers with digit "2" in the first position And two numbers with digit "3" in the first position (e.g. 11,14,21,23,36,39). If you uncheck option Check that then the matching tickets will have at least one number with digit "1" in the first position and at least one number with digit "2" in the first position and at least one number with digit "3" in the first position. (e.g. 6,11,14,24,35,37 or 6,11,24,35,42,47).

Checking box for digit "0" only for the first position together with the following options will result only in tickets as: 1, 2,4,7,8, 9 or 1,3,5,6,8,9.

Note: All ticket numbers are considered to contain two digits. Numbers 1 to 9 have zero as their first digit.

Low / High Filter

Menu: Filters → Low / High

Filter allows filtering of the package so that matching tickets will have the required count of low/high numbers. Low numbers are numbers from the lower half of the range of drawn numbers, high numbers are number from the higher half. If the range of drawn numbers is 1 to 49, then low numbers are from the range 1 to 24, high numbers are from the range 25 to 49.
Ticket Index Movement Filter

Menu: Filters ➔ Ticket Index Movement

Each combination of numbers is assigned an index which defines its position in the list of all possible combinations. In a 6/49 lottery the ticket index “1” is assigned to ticket with numbers 1, 2, 3, 4, 5, 6, ticket index “2” is assigned to ticket with numbers 1, 2, 3, 4, 5, 7 and the ticket index 13983816 is assigned to the last ticket with numbers 44, 45, 46, 47, 48, 49.

This filter allows to find tickets that correspond to the following equation:

\[ x = \frac{\text{AbsoluteValueOf(TicketIndex} - \text{TicketIndexOfSelectedDraw})}{\text{TotalCountOfAllPossibleCombinations}} \]

\[ 0.0 \leq x \leq 1.0 \]

Controls Description

- **Draw Selection** - contains all winning numbers tickets to compare the ticket index with.
- **Min, Max** - define the range (in absolute value) for the difference of ticket index of the selected draw and ticket indexes of tickets in the package divided by the total count of all possible combinations.

Ticket Index Filter

Menu: Filters ➔ Ticket Index

Each combination of numbers is assigned an index which defines its position in the list of all possible combinations. In a 6/49 lottery the ticket index “1” is assigned to ticket with numbers 1, 2, 3, 4, 5, 6, ticket index “2” is assigned to ticket with numbers 1, 2, 3, 4, 5, 7 and the ticket index 13983816 is assigned to the last ticket with numbers 44, 45, 46, 47, 48, 49. This filter will remove/keep tickets whose index is in the given range (inclusive).

Winning Numbers History Filter

Menu: Filters ➔ Winning Numbers History ➔ Sums

This is one of the most important application filters closely related to the Winning Numbers History page. The filter allows to process large numbers of tickets including the full list of all possible number combinations. If you manage to estimate correctly the minimum and maximum values for filter parameters (in the range of +/- 10) you
Can reduce the full package to a small set of tickets, which is guaranteed to include the Jackpot winning ticket!

The left hand part of this window offers controls for winning numbers selection.

The rest of the window contains controls to setup filter's parameters. It also includes buttons Update Sums and Lookup Min & Max Ranges. The filter is not active if the package is empty.

The right hand part of the window offers a table where you can enter the minimum and maximum allowed values for sums calculated in the Number History page to filter tickets in the package. See also Winning Numbers History.

Example [Expert Lotto 6/49]

- Select Expert Lotto 6/49 lottery and switch to WN History page. Click Update button and scroll down to the last row in the Summary Table.
- Write down the date of the last visible draw (e.g. 28/2009 2nd Wed) and also write down the sum values in columns labeled "0" to "-10" for this draw.
- Select Edit from the Winning Numbers menu. Search for ticket for the selected draw date (28/2009 2nd Wed in this example). Write down the ticket numbers and mark it as hidden by clicking the checkbox in column Hide.
- Use menu Package -> Generator to create a complete list of tickets for all possible number combinations (approximately 14 million of combinations).
- Select Winning Numbers History in the Filters menu. Make sure that all draw checkboxes are selected in the WN Selection panel and All Draws option is set.
- Click button Update Sums and enter values you wrote down earlier decreased by 10 into the Min column and the same values increased by 10 into the Max column. Select all checkboxes in the first column.
- Make sure that Matching Tickets Leave is selected and click button Apply. Filter's window should look like follows:
After filtering the package will contain only tens to hundreds of tickets. **These tickets will always contain the ticket you wrote down earlier and marked as Skipped in previous steps, i.e. the Jackpot winning ticket.** You can verify this in the **Visual Package** page by entering ticket's numbers into the panel and **Removing match in 0, 1, 2, 3, 4, 5.**

**Example [Expert Lotto 6/49]:**

1. Generate tickets for all combinations from 49 numbers into the package. Use button **Simulate** in the History differences page to find the average, minimum and maximum values and the percentage of probability that the sum value will decrease. Write down these values and also the current value. The table in our example looks like this:

<table>
<thead>
<tr>
<th>Column number (header)</th>
<th>Current value</th>
<th>Median value</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Probability of decrease [%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>373</td>
<td>376</td>
<td>301</td>
<td>413</td>
<td>39</td>
</tr>
<tr>
<td>-1</td>
<td>754</td>
<td>756</td>
<td>661</td>
<td>795</td>
<td>32</td>
</tr>
<tr>
<td>-2</td>
<td>1210</td>
<td>1203</td>
<td>1109</td>
<td>1248</td>
<td>60</td>
</tr>
<tr>
<td>-3</td>
<td>1631</td>
<td>1628</td>
<td>1556</td>
<td>1671</td>
<td>56</td>
</tr>
<tr>
<td>-4</td>
<td>2018</td>
<td>2019</td>
<td>1958</td>
<td>2057</td>
<td>44</td>
</tr>
<tr>
<td>-5</td>
<td>2406</td>
<td>2407</td>
<td>2324</td>
<td>2447</td>
<td>45</td>
</tr>
<tr>
<td>-6</td>
<td>2774</td>
<td>2777</td>
<td>2719</td>
<td>2815</td>
<td>38</td>
</tr>
<tr>
<td>-7</td>
<td>3123</td>
<td>3129</td>
<td>3032</td>
<td>3166</td>
<td>35</td>
</tr>
<tr>
<td>-8</td>
<td>3496</td>
<td>3499</td>
<td>3432</td>
<td>3536</td>
<td>40</td>
</tr>
<tr>
<td>-9</td>
<td>3836</td>
<td>3843</td>
<td>3786</td>
<td>3876</td>
<td>29</td>
</tr>
<tr>
<td>-10</td>
<td>4232</td>
<td>4232</td>
<td>4161</td>
<td>4270</td>
<td>46</td>
</tr>
</tbody>
</table>

2. **Note:** value in the last column [%] could differ slightly as they are the result of random processing.

3. Now use the history charts - Summary Chart, Differences Chart - to refine the minimum and maximum values and to estimate the future values for column "0" to "-10" (the sum will increase or the sum will decrease).

4. Return back to the History Differences page. Use your estimated min and max values and the trend for sum values to divide drawn numbers into segments. For a large decrease in sum values you should favor the last segment and require that each ticket should contain one to two numbers from this segment. The figure below shows settings for estimated sum decrease in the 1st
5. Click **Filter** button to filter tickets in the package according to your segment settings. Repeat this for all columns in the History Differences page.

6. Use menu **Filters - Winning Numbers History - Sums**. Click button **Update Sums** and then **Lookup Min & Max Ranges** to see your filtering results from the previous steps.

7. Compare values in the table with your estimates from the second step and make corrections if needed. The tickets remaining in the package will again include the jackpot winning ticket.

**Notes:**

1. In the example above we used functions from the History Differences page (**Simulate**) to estimate the min and max sum values. However you can use any 'reasonable' value. Keep in mind that the maximum sum value increment for all columns is +43 (for a 6/49 lottery). The maximum sum decrease in all columns is the sum of six largest differences.

2. You can reduce tickets in the package using all rows in the table, using any rows combinations or using a single row only. To use all checked table rows in filter's condition select **And** in the **Logical Condition** option. If one row only is enough to pass the filter select **Or**.

3. Entering lower value into the Max column then the Min column is not allowed and is indicated by an error message.

4. You can use also the following condition for ticket filtering:

   ![Filter conditions](image)

   The condition is that the given number of columns (4 to 6 in this case) must have the difference of the next sum from the current sum from the given range (-10 to +10 in this case). Setting difference range "0 to 0" for "1 to 1" column will enforce that at least one column will have the same sum value in the next draw.
5. Option *At least X to Y columns must pass* can make the filter more relaxed. This option is especially useful if you are not sure with your estimates. You can define values for all columns and using this option you may specify that it is enough if ticket meets filter condition in e.g. 3 to 6 columns only.

6. Using history differences is an approximate method. Therefore you can allow wide range of value at first and refine them in next steps.

7. You can use table columns labeled *Odd* and *Even* as another part of filter condition. This way you can choose whether the history sum value in the appropriate history column must be odd or even. Therefore it is possible to use wider sum ranges and then reduce the number of tickets left after filter by approximately by half by choosing the odd or even option.

8. Table column labeled *Lock* blocks the appropriate history index against the usage of option *At least X to Y columns must pass* - the filter condition for sum range of the 'locked' must be met at all times and the option *At least...* applies to the remaining "unlocked" columns only. This switch is especially useful for columns where you are absolutely sure with your sum range estimate.

9. Buttons with up and down arrows to the right of the table are enabled when one or more cells are highlighted in column *Min Diff* or column *Max Diff*. Using these buttons you can increase or decrease the values in highlighted cells.

10. The required values for differences and sums can also be transferred from external applications (e.g. spreadsheet processor) using Copy (Ctrl+C) and Paste (Ctrl+V) feature of your operating system.

---

**Note:** If you move both margins with your mouse in chart *WN History ➔ History Charts ➔ Summary Charts/Differences Charts* these new resized positions are offered in appropriate dialog for this filter inside the columns *Min, Max*.

---

**Winning Numbers History Differences Segments Filter**

**Menu:** Filters ➔ Winning Numbers History ➔ Segments

Using this filter you filter the package by estimating the count of numbers in individual segments within History Differences tables.

**Example [Expert Lotto 6/49]:**

You use this filter for one history column at a time only (option *History to show*). The order of columns when applying this filter does not matter. It is recommended to use Apply button to keep the filter window open to repeat the filtration for other column(s). When switching the history columns the segment sizes will revert to their default values however your minimum and maximum settings for each segment will be remain intact.

The default segment size is approximately one third of all rows in the table. So the first segment ends at one third of the maximum difference value, the second segment starts on the next row and ends at the second third of the maximum difference and the third segment starts on the next row and ends at the last table row (row with the maximum difference).
**Controls Description**

- **Draw selection** - select the range of winning numbers draws the filter will work with.
- **Update** - click this button if you changed the selection of winning numbers draws to recalculate values in the table. The segment sizes are also updated at the same time. Values set in the Min and Max fields remain unchanged.
- **History to show** - select column you wish to use for package filtration
- **Labels Max (-), Max(+)** provide information about the maximum possible negative and the maximum possible positive difference in the selected column. The values are taken from WN History - History Differences tables.
- **Segment 1, Segment 2, Segment 3** - when you open the filter window the segment sizes and Min/Max values are set automatically - change these values according to your estimates. Pay attention when playing Keno type lotteries as these lotteries allow lower count of numbers in the ticket than the actual count of drawn numbers.
- **Auto-update segments** - this option is applicable only when the filter is a part of a compound or group filter. Leaving the option blank will recalculate the segment sizes to their default size before each application of a compound or group filter. When this option is checked then segment sizes will remain unchanged when this filter is used inside a compound or group filter.

**Note:** A possible strategy is to have the first segments to always end at the 4th table row while requiring at least 2 and at most 5 numbers in these segments. Such filter is generic enough and works in most cases. This is an example where the Auto-update option should remain unchecked.

The example above for 1000 random tickets specifies that:
• Segment 1 will contain at least 3 and at most 6 numbers. Row 4 is the last row of the Segment 1.
• Segment 2 starts at the 5th row and ends at the 10th row. We want this segment to contain at least 2 and at most 6 numbers.
• The segment 3 starts at the 11th row and ends at the last table row. We tickets to contain at least 1 and at most 6 numbers from this segment.

Filtered tickets must meet all conditions set above. Because each ticket consists of 6 numbers, the filtered tickets will contain 3 numbers from the 1st segment and 2 numbers from the 2nd segment and 1 number from the 3rd segment.

If you change filter parameters to: 3 to 4 numbers from the 1st segment, 2 to 4 from the 2nd segment and 0 from the 3rd segment the remaining tickets in the package will contain 3 to 4 numbers from the 1st segment together with 2 to 3 numbers from the 2nd segment.

The figure above shows also panel coloring created e.g. on Winning Numbers page.

**Winning Numbers History Standard Deviation Filter**

*Menu: Filters ➔ Winning Numbers History ➔ StdDev*

There’s Summary Table at the History showing sums and/or differences for each past winning numbers draw. The last but one column in this table is labeled StdDev (Diffs) and it contains the standard deviation calculated for the difference value in all columns. You can see the corresponding chart at History Chart tab - select Show: Differences Chart, click button Options under the chart window and make sure the last row is checked in the Chart Options window.

Lower StdDev value means that the difference value in most columns will not be very high and it can be expected that there will more differences in the +/-10 range (the recommended value is 4 to 6 differences in the +10/-10 range) - see filter Winning Numbers History - Sums.

Higher StdDev value means that negative and positive differences in each column will be higher as well and the number of differences in the +10/-10 range will be lower.

**Numbers Position Filter**

*Menu: Filters ➔ Position Filters ➔ Numbers*

This filter controls what numbers are allowed in any and/or in all ticket positions. Click Numbers button to open the panel window to (un)select numbers for each individual ticket position. Numbers allowed for individual positions are painted red, disabled numbers are painted grey.

The ticket positions can be linked together using And / Or logical operators.
As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.

**Note:** If you combine this filter with position filter *Number Range* you can remove particular numbers for particular position from defined range of numbers.

### Number Range Position Filter

**Menu:** Filters ➔ Position Filters ➔ Number Range

Position Filter *Number Range* allows to define the range of numbers at selected ticket positions.

**Controls Description**

- The checkbox on the left hand selects the required ticket number position. When checked the position will be taken into account during filtering, unchecked positions are ignored.
- *Range min* "x" *max* "y" - defines the smallest and the highest value of number at the given position.
- *Logical condition* "And", "Or" - determine the logical link to apply to checked positions. When "AND" is selected then each filtered ticket must pass all conditions at checked positions. When "OR" is selected then each filtered ticket must pass at least one condition at checked positions.

As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.

The options at the bottom of the filter window are common to all filters and their description is here.

**Example [Expert Lotto 6/49]:**

<table>
<thead>
<tr>
<th>Position</th>
<th>Range min</th>
<th>max</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>27</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>23</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>18</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>47</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>48</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>49</td>
</tr>
</tbody>
</table>

Logical Condition: [And] [Or]
**Logical Condition "AND"**

In the example above the minimum value "1" and the maximum value "27" is chosen for the first position. However for the second position the minimum is "10" and the maximum equals to "23". The second position range is lower than the maximum value for the first position. Because ticket numbers are sorted in ascending order, after filtering the package will contain only tickets that have at most "22" in the first position and at most "23" in the second position. The lowest value in the second position will start from "10".

**Logical Condition "OR"**

In order to demonstrate how the filter works for the "Or" condition, the parameters should change as follows:

- chose min "1" and max "5" for the first position
- chose min "10" and max "23" for the second position
- uncheck positions 4, 5 and 6

A ticket must pass at least one of the two conditions. Tickets passing condition for the first position do not have to pass the second condition, i.e. such tickets can have numbers lower than 10 and higher than 23 at the second position. However if the first condition is not met, e.g. the first number is "6" then the second condition must pass. That means that the number at the second position will be at least "10" and at most "23".

**Note:** You can track how this filter performed in the lottery history on page Statistics ➔ Winning Numbers ➔ Winning Numbers Table ➔ Ticket Position. Furthermore, Winning Numbers Chart page allows you to set parameters for this filter by drag & drop of margins to required position (chart window must be displaying one set of data only - see Options button under the chart window).

![Graph](image)

When the package is not empty you can click Filter button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the Filter button. The actual values of margin positions are displayed at the status bar under the chart window.

**Number Movement Position Filter**
Filters

**Menu:** Filters ➔ Position Filters ➔ Number Movement

Filter *Number Movement* is based on the increase or decrease of the numerical value in selected ticket number positions when compared to selected winning numbers draw(s).

**Controls Description**

*Winning numbers selection panel* - select the winning numbers draw(s) that will be used for comparison.

*All draws must pass* - when this option is on then the number movement conditions selected in the filter window must apply to all winning numbers draws selected in the panel. It is very likely that no tickets will pass this filter if too many past draws are selected and this option is on.

*At least one draw must pass* - a ticket will pass the filter if the number movement conditions apply to one or more past draws from the selection.

*Position* - use check boxes to select ticket number positions you wish to evaluate in filter's condition. To the right of the check boxes there are fields for the minimum and the maximum values of the number movement in the given position. Let's assume for example that the selected winning numbers draw has number 16 at its first position, then settings

<table>
<thead>
<tr>
<th>Movement min</th>
<th>max</th>
</tr>
</thead>
<tbody>
<tr>
<td>-10</td>
<td>10</td>
</tr>
</tbody>
</table>

mean that the first position in the ticket is to be evaluated and that filtered tickets will have numbers "6" to "26" in the first position because the maximum allowed decrease/increase is 10.

*Logical condition And / Or* - the logical operator defining whether tickets must pass conditions for all checked positions or if it is enough to meet condition for at least one checked position.

*Movement total min - max* - the actual number movement values for each position (even un-checked ones) are summed and these define the minimum and the maximum value of the sum.

*The maximum movement in "m" to "n" positions is "x" to "y"* - this condition allows uniform setting of the number movement for selected range of positions. Therefore the following settings

<table>
<thead>
<tr>
<th>Maximum movement in:</th>
<th>to</th>
<th>positions</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>6</td>
<td>positions</td>
</tr>
<tr>
<td>is</td>
<td>-3</td>
<td>to</td>
</tr>
<tr>
<td>to</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

mean that in addition to other selected conditions, the number movement must be "-3" to "+3" for at least 4 and at most for 6 positions only.

As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.
Note: You can track how this filter performed in the lottery history on page *Statistics → Winning Numbers → Winning Numbers Table*. Furthermore, *Winning Numbers Chart* page allows you to set parameters for this filter by drag & drop of margins to required position (chart window must be displaying one set of data only - see *Options* button under the chart window).

When the package is not empty you can click *Filter* button under the chart to open this filter window and have the filter options preset with values corresponding to chart margins. You must move both margins to enable the *Filter* button. The actual values of margin positions are displayed at the status bar under the chart window.

### Odd / Even Position Filter

**Menu:** Filters → Position → Odd/Even

This filter controls whether ticket numbers at selected positions should be odd or even numbers. Similar to other filters, it is possible to select *And* or *Or* conditions to link selected ticket positions.

As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.

### Low / High Position Filter

**Menu:** Filters → Position → Low/High

This filter controls whether ticket numbers at selected positions should be low or high numbers. Similar to other filters, it is possible to select *AND* or *OR* conditions to link selected ticket positions.

*Low* numbers are numbers from the lower half of the range of drawn numbers, *high* numbers are number from the higher half. If the range of drawn numbers is 1 to 49, then *low* numbers are from the range 1 to 24, *high* numbers are from the range 25 to 49.
As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.

**Note:** When filtering low/high numbers at individual ticket positions you should also consider the ticket-wide Low/High Filter (applied for all positions). Naturally it make no sense to require a low number at the third position while previous filtering required to leave only tickets containing 2 low and 4 high numbers. Because ticket numbers are sorted in ascending order it makes no sense to require low numbers at positions behind the position with a high number either.

**First / Last Digit Position Filter**

*Menu: Filters ➔ Position Filters ➔ First /Last digit*

This filter controls which digits will appear at the first or the second digit at each ticket number position. The digits are "0" to "9" for both the first and the last digits. Ticket numbers "1" to "9" are considered to have a leading zero digit (1 = 01, 2 = 02 .. .9 = 09)

As with all other positional filters you can specify the minimum and maximum number of ticket positions that must pass the filter condition.
Example [Expert Lotto 6/49]: Filtering a file with 1000 randomly generated tickets

According to figure above the options are set for the last digits in all ticket positions except the third one. Numbers allowed at the first ticket position are 1, 2, 3 and 4. The second position must have last digits 0, 1, 2 and 6. The third position is not included in filter's condition. Digits allowed for the fourth position 2, 3 and 4 etc. (see figure above).

Logical condition is set to *And*, which means that matching tickets must meet all selected conditions (positions) at the same time. *Preview* button shows that 17 tickets passed the filter. They are listed in graphical view below:

![Graphical view of filtered tickets](image)

### Optimizer Filter

**Menu:** Filters ➔ Coverage ➔ Optimizer

This function reduces the count of tickets in the package while maintaining the coverage of pairs/triplets/quads for a given pool of numbers. This way you can significantly reduce your bet.
### Controls Description

- All numbers found in the tickets in the package are displayed in the panel in **bold italics**. The numbers for which optimization is to be performed are displayed in red. The numbers, which are not present in the package are displayed in a regular way (either in red or gray). The number range for optimization can be also set for numbers, which are not present in the package. It allows identifying what coverage can be reached with the actual content of the package in case the range of selected numbers becomes wider. Use the panel to swap numbers.

Using button *Options ➤ Show Colors* you can set panel coloring according to frequency of occurrences of each number within any chosen period of winning numbers.

The *Clear* button cancels all current number swap settings.

- **Number range to use** - it is possible to set the range for optimization also for numbers not present in the package. It allows to identify what coverage could be reached by current contents of package in case you make range of betted numbers wider.

- **Select Optimizer type** - choose algorithm to apply for tickets optimization in package. The *Scattered package optimizer* algorithm provides better results (higher reduction with maximum coverage for required combinations) and it is more suitable in case the tickets in package match each other at minimum.
means the tickets have minimum of common triplets, quads etc. These are for example randomly originated wheels or wheels arising by step by step package filtering. The Full wheel optimizer provides better results in case of full wheels - i.e. wheels containing successive combinations. So when optimizing the coverage of e.g. triplets the Optimizer filter will act in the same way as Minimizer filter does.

- Button Calculate coverage provides information how many pairs/triplets/quads are covered by the current package contents for the given number range. Calculated coverage values are displayed by clicking the Calculate coverage button, for example Coverage: 91 out of 91 pairs (100%) means that all possible pairs from 14 numbers are covered.
- The Number range to use edit fields allow selecting the range of numbers for which the coverage calculation as well as optimization is to be carried out."
- Button OK starts the optimization process and displays a progress window; when the optimization is finished the filter window is closed.

- Apply button optimizes the package and the window stays open allowing to carry out another optimization.
- Cancel button closes the filter window.

The remaining controls are common for all filter windows.

Usage

Use menu Package -> Generator to generate tickets from 16 numbers. The total count of tickets which you can create from 16 numbers is 8008. Enter "1000" to field Tickets to generate, chose Generate tickets with random numbers and select "4" for Maximum Match: "4" numbers. Cancel the generator by clicking the Cancel button when the progress bar stops. About 400 to 420 tickets should appear in the package. Click menu Filters and chose Optimizer. Check the values in the Number range to use fields and change them to match the actual count of numbers in the package if necessary. The numbers displayed in gray bold italics are in the package but they will not be used neither in the coverage calculation nor in the optimizing process.

Use radio buttons "pairs", "triplets" and "quads" and the Calculate Coverage button to find out the current coverage. Keep in mind that it is possible to create 15 pairs and 20 triplets and 15 quads from each ticket (when playing a 6/49 lottery).

Make sure the quads option is selected and then optimize for quads by clicking the Apply button. The number of tickets in the package should be significantly reduced. When repeating the optimization and the count of tickets remains unchanged, the optimization process is complete.
It is recommended to repeat each optimization step to ensure that the best results have been reached.

Notes:

- You can also optimize even tickets with dummy numbers
You can also optimize even for a part of the whole range of numbers. For example if you chose to optimize for the range of numbers from 7 to 14 and the package contains numbers from 1 to 16, the optimization as well as the coverage calculation will apply for pairs/triplets/quads from the given range only.

Using Number Swap function you can also optimize for non-continuous range of numbers.

The general rules of combinatorial mathematics apply.

The Back - Test button is not available due to the nature of this filter.

Minimizer Filter

Menu: Filters ➔ Coverage ➔ Minimizer

This filter is an extension to the Optimizer filter and allows reducing the number of tickets in the package while preserving the given win guarantee. The feature is especially useful for situations when after applying your lottery strategy the package contains a large number of tickets making the bet very expensive. Using the Minimizer you can significantly reduce the package to a small number of tickets that:

a) Meet all conditions and criteria of your lottery strategy.

b) Have defined win guarantee when hitting given count of numbers of the wheel.

Always use Win Coverage button to check the current wheel coverage before applying the filter! For example, if tickets in the package cover only two thirds of all possible triplets, then a requirement to have 100% chance of Match 3 when hitting any three numbers of the wheel will have no effect and no tickets will be removed from the package.

Controls Description

- Enter the desired win guarantee into the first row. Value "100%" means full guarantee, value "50%" means that the desired win situation will be achieved only in half of all possible combinations of winning numbers, i.e. with probability of 50%.

- Enter the desired number and type of winnings into the second row. For example at least 2 matches in 3 numbers means you want to have at least two Match 3 prizes. The number of possible winnings depends on the count of hit numbers that is set on the next row.

- Enter the count of numbers of your wheel that will be drawn (according to your assumption). This is the minimum count of numbers you must hit otherwise the win guarantee will not be met.

- Ticket panel - shows package numbers. All numbers found in the package are highlighted using bold italic font. Numbers from the range selected for minimization (see below) are displayed in red. All other numbers are displayed in gray color. Numbers in the panel can be swapped.

Use Reset button to cancel current number swap settings.

Use Coloring button to review panel coloring settings.

- Win Coverage - opens a new Win Coverage window where you can check the current win guarantee of the tickets in the package.
• **Number range to use** - use the edit fields to define the range of numbers for coverage calculation. You can reduce the range of numbers in the package to filter out more tickets out of the package. On the other hand, the remaining tickets may not fully meet your lottery strategy conditions as some numbers may be missing in your wheel.

The rest of the filter screen are options common to all filter windows.
It is possible to *Leave* minimized tickets in the package or to *Remove* them from the package.

**Example [Expert Lotto 6/49]:**

Generate into the package 1000 random tickets from numbers 1 to 20 (choose menu **Package - Generator**, enter **Tickets to generate**: 1000 tickets, **Ticket numbers range**: 1 to 20, **Maximum overlap**: 6 numbers, **Generate tickets with random numbers**, click button **Ok**). Now let’s assume that these 1000 tickets are the result of your lottery strategy after applying many filters. Let’s also assume that all tickets meet your expectations of winning in the next draw.

Now choose filter **Minimizer** and click button **Win Coverage**. In the new window enter **What can I win when I hit 3 numbers?** and click button **Show**. The coverage table should look approximately like the following picture:

![Win Coverage Table](image)

You can see from the figure above that when hitting three numbers out of range 1 to 20 the minimum winnings are six Match 3 prizes.
Close the coverage window and in the Minimizer select "I want to have 100% chance of at least 1 match in 3 numbers when I hit 3 numbers", choose Number range to use 1 to 20, Matching Tickets Leave and click button Ok. 100 to 150 tickets should remain in the package. Use menu Win Test - Win Coverage to verify that the desired win guarantee applies. 85% to 90% of tickets has been removed from the package while preserving the guarantee of at least one Match 3 prizes when hitting any three numbers out of 20.

Generate again 1000 random tickets out of 20 numbers and in the Minimizer choose "I want to have 100% chance of at least 1 match in 3 numbers when I hit 6 numbers" and click button Ok. The package will be filtered down to about twenty tickets. Use menu Win Test - Win Coverage to verify the win guarantee again.

Therefore when hitting 6 number of the wheel, only about twenty tickets out of the original thousand are needed to win at least one Match 3 prize!

Notes:

- The Minimizer works also with tickets containing dummy numbers.
- You can also optimize even for a part of the whole range of numbers. For example if you chose to optimize for the range of numbers from 7 to 14 and the package contains numbers from 1 to 16, the optimization as well as the coverage calculation will apply for pairs/triplets/quads from the given range only.
- Using the Number Swap function you can also optimize for non-continuous range of numbers.
- The general rules of combinatorial mathematics apply.
- Because of the filter nature the Back-testing feature is not available.
- The filter does not create a new wheel from the numbers in the package. It only removes tickets that are not required to achieve the given win guarantee.
- Filter requires large part of computer operating memory thus it is suitable to use the filter as one out of last steps of your approach in betting when the set of tickets in the package is small enough.
- The algorithm of this filter must compare very large numbers of tickets with each other. So depending on the speed of your computer the filter may take a few hours to process tickets in the package. The filter will work faster if you choose lower number range in the filter window. Another option is Fast Minimizer filter.

Fast Minimizer Filter

Menu: Filters → Coverage → Fast Minimizer

Fast Minimizer works the same way as the Minimizer filter. However as its name implies this filter works much faster. That is due to the fact that the Fast Minimizer has only input settings::
Coverage is always optimized for the full count of ticket numbers. That means that in e.g. 6/49 lottery the filter will find the minimum coverage for a case when 6 numbers were hit.

- It is possible to find coverage only for a single match of 3, 4 or 5 numbers when any six numbers were hit (6/xx lotteries).

The rest of the filter window is the same as in Minimizer filter window.

**Custom Combinations Coverage Filter**

*Menu: Filters ➔ Coverage ➔ Custom Combinations*

This filter is similar to the Minimizer filter with the exception that the coverage is not calculated for all combinations from selected range of numbers but only for user defined sub-set of combinations from a selected file.

Invoking the filter from menu first brings up a standard window where you can browse the combinations file. If you wish to optimize e.g. the coverage of triplets you must use dummy numbers to fill up the tickets in the file to the required count of numbers. All tickets in the selected file must contain the same count of dummy numbers.

Always use button *Custom Combinations* to check the wheel win guarantee before applying the filter! For example, if the tickets in the package cover only two thirds of all triplets from the selected file, then requirement to have *100% guarantee of Match 3 when hitting any three numbers of the wheel* will have no effect and no tickets will be removed from the package.

**Controls Description**

- **Combinations File** - shows the name of the file with combinations that will be used for coverage calculation. Click button 🗂️ to select a different file.
- The next row contains options to set the required win guarantee. The last edit field shows the size of combinations in the selected file, i.e. whether the filter will calculate the coverage of triplets, quads or pentads etc.
- You can also specify the minimum number of combinations that the tickets in the package must cover. You can enter either percentage value or exact number of combinations. The last edit field shows the total number of combinations in the selected file.
- **Custom Combination** - opens the Custom Coverage window where you can check the current coverage details.

**Example:**

Let's have a combinations file with 5000 triplets. The requirement *I want to have 1 match in 3 numbers out of 3 numbers in 90% combinations out of 5000* will reduce the number of tickets in the package so that the remaining tickets will cover at least 4500 triplets (90%) from the file.
Let's have a combinations file with 1000 quads. The requirement I want to have 1 match in 3 numbers out of 4 numbers in 100% combinations out of 1000 will reduce the number of tickets in the package so that all quads will match at least one ticket remaining in the package in three numbers. That means we would have at least one Match 3 prize if the winning numbers contained any quad from our file.

**Note:** Because of the nature of this filter, the Back-testing feature is not available.

**Note:** If the combinations file contains all combinations from a given range of numbers (triplets, quads, etc) then the filter will yield exactly the same results as the Minimizer filter.

### Best Tickets Filter

**Menu:** Filters → Coverage → Best Tickets

This filter selects tickets from package, which have the highest match with all other tickets in package. Filter compares each ticket with rest of the package in similar fashion like the Match Summary function on the Visual Package page and it leaves the desired count of tickets with the best results.

#### Controls Description

- **Leave in the Package xx best tickets** - choose the count of tickets to be left in the Package after filtering. If the original package includes the winning ticket then you can reduce the number of tickets in the package to your desired value with increased chances to win (see also the tutorial in Example 6).

- **Show result when finished** - this option is suitable especially when processing larger numbers of tickets. When checked this option will display complete match-breakdown table for the best tickets when filtering is finished. Then you review the match results for lower rank matches (e.g. Match in 3 number, Match in 4 numbers etc).

The primary key for best tickets comparison the count of matches in six numbers (for a 6/xx lottery), the secondary key in the match in 5 numbers, the tertiary key is match in 4 numbers etc. However since in most cases there are no duplicate tickets expected in the package the primary key is insignificant. If you choose to filter for only one best ticket then the ticket with the highest match in 5 numbers is shown.

The resulting best tickets are sorted in their natural order as they were positioned in the original package before filtering. When using Show result when finished function the first displayed ticket may not be the actual best one with the best coverage. Furthermore significantly higher match in lower count of number may indicate the
correct way to optimum selection while difference in *Match in 5* could be negligible. Such selection is strongly dependent on the way the original package was generated and on the filters applied before the Best Tickets filter.

If the package was generated using random tickets with maximum overlap in 4 numbers and it contains the Jackpot winning ticket then there won't be any *Match 5* tickets at the same time. Similarly if we leave in the package only tickets with a single *Sum Root* value there won't be any *Match 5* ticket either (if it contains the Jackpot one). Therefore in such cases the significance of *Match 4* is higher then *Match 5*.

**Compound Filter**

*Menu: Filters ➔ Compound*

Using compound filters you can apply two or more filters in a single step thus speeding up the filtering process significantly. Another advantage of compound filters is that you can link compound filter parts using logical operators AND and OR. Therefore it is possible to create a compound filter that leaves in the package only tickets with odd/even ration 3:3 OR tickets that match ten previous draws in three to five numbers.

To create a new compound filter, use menu *Filters - Compound - Add New* or use Compound Filters Manager.

**Logical operators AND / OR**

Logical operator AND has higher priority than operator OR.

For tutorial purposes we can express the logical links as mathematical operations. Logical operator AND becomes arithmetical multiplication, operator OR becomes arithmetical addition, value "1" represents situations when a ticket passes filter condition, value "0" represents failed tickets.

Then the expression:

condition1 (pass) AND condition2 (pass) OR condition3 (fail)
OR condition4 (fail) OR condition5 (pass)

can be interpreted using arithmetical operations as:

1 multiply 1 multiply 0 plus 0 plus 1 = 1

The result is non-zero therefore the ticket passes the whole compound filter.

Compound filter parts are evaluated in the order as they are shown in the filter parts table. Compound filters use shortened evaluation of logical expressions to speed up the filtering process. For example, if a compound filter is

condition1 AND condition2 AND condition3

and condition1 is evaluated as fail then condition2 and condition3 will not be evaluated because it is clear that the complete condition of the compound filter will never be satisfied (*zero multiply anything multiply anything is always zero*).
Likewise, if a compound filter consists of three parts linked with operator \textit{OR} and the first condition passes, then the other two conditions will not be evaluated because the complete condition of the compound filter will always pass (\textit{one plus anything plus anything} is always non-zero).

Therefore it is recommended to place faster filters (\textit{Odd/Even}, \textit{Sum}, etc) at the beginning of the filter parts list while keeping slower filters (e.g. \textit{Match File}, \textit{Match Winning Numbers}, \textit{WN History} etc) at the end of the list. This way you can significantly speed up the application of a compound filter.

\textbf{Note}: If a compound filter contains only parts that support back-testing, you can back-test the whole compound filter as well. Adding a part without back-test support makes the \textit{Back-test} button disabled.

\textbf{Note}: Other compound filter can be used as a part of compound filter. In such a case it is suitable to switch to \textit{Hierarchy} view where also components of inner compound/group filters are shown as a tree of filters. Then buttons \textit{OK}, \textit{Apply}, \textit{Preview} and \textit{Back-test} apply \textbf{only to selected} (highlighted) filter component in the filter tree.

\section*{Filter Groups}

\textit{Menu}: \textit{Filter} \rightarrow \textit{Group filter}

Most filters can be grouped together to form a group filter. Group filters are based on the same rules as the \textit{compound filters} with the following exceptions:

- All group filter parts are linked using logical operator \textit{AND} only, operator \textit{OR} is not used.
- It is possible to define how many sub-filters must pass so that a ticket will pass the complete group filter condition (e.g. at least 2 and at most 4 filter parts out of the total number of 6 sub-filters must pass). For example option \textbf{At least 0 to 3 sub-filters must pass} defines that at least "0" to "3" filter parts must pass so that a ticket will pass the complete group filter condition.

To create a new group filter, use menu \textit{Filters} - \textit{Group} - \textit{Add New} or use Group Filters Manager.

\textbf{Notes}:

- Any filter can be added to a group filter more than once. For example you can choose two different sum ranges. Of course, each ticket will pass only one of these conditions then. Likewise, you can filter several ranges of \textit{WN History} parameters in a single step.
- If a group filter contains only parts that support back-testing, you can back-test the whole group filter as well. Adding a part without back-test support makes the \textit{Back-test} button disabled.
• When assembling a new group filter, it is recommended to use *Preview* button frequently to check the results of each filter part before adding it to the group filter.
Winning Numbers

Add Winning Numbers

*Menu:* Winning Numbers ➔ Add

Allows adding winning numbers manually. Choose the date of the draw you wish to add in the table of missing draws. Enter numbers drawn at the selected date and click *Add* button.

**Controls Description**

- **Edit fields** - enter winning numbers for the draw date selected in the list below.
- **Add** - choose this button to add entered winning numbers to the database.
- **Skip** - the draw date(s) selected in the list will be flagged as skipped and will not appear in the list anymore. You can reset this flag in the Edit Winning Numbers window.
- **List of missing draws** - select the date of the missing draw that you wish to add. The number in parenthesis under the list shows the count of missing draws.
- **Close** - choose this button to close this window.

**Usage**

Use this function to manually add missing winning numbers draws.

The lottery operator may have added additional draw days over the time. However the list of missing draws is built using the current lottery rules. For example if winning numbers were drawn on Saturdays only when the lottery started and Wednesdays drawings were added later on then the list of missing draws will also include all Wednesdays from the lottery start till the date the Wednesday drawings were introduced. In such a case use *Skip* button to remove them from the list. You can *skip* multiple draw dates in one step. Select the first draw date then hold down the SHIFT key and select the last draw date of the range you wish to skip. Then click the *Skip* button. These draw dates will not appear in the list next time you use the *Add Winning Numbers* function.

**Note:** The draw dates in the list are sorted from the oldest one to the latest draw date. So be careful when skipping large number of dates because you could skip a date which the winning numbers were actually drawn for. Use function Edit Winning Numbers - *Show skipped entries* to fix any mistakes.

**Edit Winning Numbers**

*Menu:* Winning Numbers ➔ *Edit*
Allows to edit winning numbers database. You can also switch the *skip* flag on and off for selected draw dates or search for particular numbers.

**Controls Description**

- **Draw Date** - this column shows the draw date in the format of the current lottery. This column is not editable.
- **Other table columns** - these columns contain the drawn numbers. You can edit any number by clicking on its cell. Depending on current lottery the last column(s) may contain bonus number(s).
- **Skip** - use your mouse to flag any draw as skipped. The draw will be kept in the database however all Expert Lotto functions working with the winning numbers database will ignore this draw.
- **Show hidden entries** - use this option to see draws there were temporarily hidden in the winning numbers database.
- **Show skipped entries** - choose this option to see skipped draws in the list.
- **Remove Selected** - use your mouse or keyboard to select one or more draws in the list to enable this button. Clicking the button will permanently remove all selected entries from the database. The deleted entries will then appear in the list of missing date in the Add Winning Numbers window.
- **Search** - enter the numbers of the ticket you are looking for and click this button. If the ticket exists in the database it will be highlighted in the list. Clicking the **Search** button will bring up a list of favorite tickets.
- **Close** - closes this window.

**Usage**

You can use this function to fix potential errors made when adding winning numbers manually. Using this function you can temporarily return the database into the state before the last winning numbers draw. It is especially useful when comparing your estimates in the Winning Numbers History page with the real data. See below.

**Example:**
Select Expert Lotto 6/49 lottery, switch to the Winning Numbers page and display all winning numbers. Write down the numbers for the latest draw. Then choose menu **Winning Numbers** ➔ **Edit** and flag the first draw in the list (the latest draw) as *hidden* in the *Hide* column. Now switch to the WN History page and choose **Update** button. Enter ticket numbers into edit fields at the bottom of the page. Now you can compare your original estimate in the History Differences page with the real data. The table highlights the numbers entered into the edit fields with a thick black border.

**Attention:** Make sure that the **Draw Simulation** button is not pressed down. Otherwise the values in the table would have been recalculated as if the numbers of the hidden draw were actually drawn.

After clicking **Draw Simulation** button you can compare other functions, e.g. History Chart, Summary Table.

**Note:** Do not forget to return back to the Winning Numbers ➔ **Edit**, choose the **Show hidden entries** option and cancel the Hide flag of the first two entries. This will restore the winning numbers database to its original state.
Note: Both flags - *Hide* and *Skip* - can be used to temporarily remove one or more draws from the winning numbers database. However we recommend using *Skip* flag to hide draw dates which no numbers were drawn at. And use *Hide* flag to temporarily remove the latest draw from your database to back-test your estimates. When this flag is on then it is indicated with a star sign in all panels for the selection of winning numbers. This way you can be sure that your estimates for the next draw will not be based on incorrect data.

**Export Winning Numbers**

*Menu:* *Winning Numbers ➝ Export*

This function exports winning numbers to a file. The file format can be either binary or text. The binary format is intended for data exchange between Expert Lotto users. Text files can be loaded into other applications (e.g. a spreadsheet processor) and eventually analyzed with other tools, the text format description is here.

Invoking this function from the menu will first bring up a standard window to select a name of the exported file. You can enter name of a new file or select an existing file, which will be overwritten.

To export data as text select *Files of type "CSV or Text Files"*, to export in binary format select *Files of type "Winning Numbers Files"*.

**Controls Description**

- **File** - shows the name of the file you selected. Click button 📂 to choose a different file.
- **WN Selection** - here you can choose the range of winning numbers draws that will be exported. The description for winning numbers selection is here.

**Import Winning Numbers**

*Menu:* *Winning Numbers ➝ Import*

Allows to import winning numbers from a file. The file format can be either binary or text format.

Invoking this function from the menu will first bring up a standard window to browse a file you wish to import. Select *Files of type "CSV or Text Files"* to import winning numbers in a text format, select *Files of type "Winning Numbers Files"* to import winning numbers in binary format, which is the default format of the Expert Lotto application.

Use this feature to import winning number previously exported by the Export function. If you wish to bulk-update your winning numbers database from a different source (e.g. lottery web page or other text file) you should use Import Wizard function.

**Controls Description**
Expert Lotto Help

- **File** - shows the name of file you selected before. You can browse for a different file by clicking button.
- **Merge with existing data** - when this option is set the imported data will be appended to your existing database (i.e. missing draws will be added and existing draws will be overwritten with numbers from imported file). When the option is not selected the complete existing database is replaced with data from imported file.

**Text format description**

The imported file must follow these rules when the text format is used:

- All drawn numbers and draw date of each drawing must be in a single line of text.
- Numbers in the line must be separated with a comma ",", semicolon ";", space " ", tab char or colon ":".
- Lines starting with "#" are ignored and can be used for comments.
- Each line must follow this order of fields: draw date, drawn numbers, bonus/powerball numbers (only where appropriate).
- Format of a draw date of type **day/month/year** (e.g. demo lottery Expert Lotto Keno):

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year of the draw</td>
<td>A number greater or equal to 1980</td>
<td></td>
</tr>
<tr>
<td>Month of the draw</td>
<td>Number from the range of 1 to 12</td>
<td></td>
</tr>
<tr>
<td>Day of the draw</td>
<td>Number from the range of 1 to 31</td>
<td></td>
</tr>
<tr>
<td>Draw number</td>
<td>Number 1 to maximum number of drawings made on a single draw day</td>
<td>This field is mandatory only when lottery draws multiple sets of winning numbers in a single draw day, otherwise this field is absent. The value for the first draw is 1, the value for the second draw is 2 etc.</td>
</tr>
</tbody>
</table>

- Format of a draw date of type **week/year** (e.g. demo lottery Expert Lotto 6/49):

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year of the draw</td>
<td>A number greater or equal to 1980</td>
<td></td>
</tr>
<tr>
<td>Week of the draw</td>
<td>Number from the range of 1 to 53</td>
<td></td>
</tr>
<tr>
<td>Draw day</td>
<td>Number from the range of 1 to 6</td>
<td>This field is mandatory only when lottery draws winning numbers multiple times a week.</td>
</tr>
<tr>
<td>Draw number</td>
<td>Number 1 to maximum number of drawings made on a single draw day</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>

otherwise this field is absent. E.g. if winning numbers are drawn on Wednesdays and on Saturdays then use value 1 for Wednesday drawings and value 2 for Saturday drawings etc.

This field is mandatory only when lottery draws multiple sets of winning numbers in a single draw day, otherwise this field is absent. The value for the first draw is 1, the value for the second draw is 2 etc.

You can create an example file in this text format by using the Export Winning Numbers function.

**Note:** You can also use the Import Wizard to import winning numbers in format different from the one described above.

**Import Winning Numbers Wizard**

**Menu:** Winning Numbers ➔ Import Wizard

You can use this feature to import winning numbers from any text data, e.g. from lottery's official website.

This is an alternative to manual adding of winning numbers. It is especially useful when lottery's official website publish previous winning numbers results for the past year or month. You can then copy and paste the text from your browser into this wizard's window and import winning numbers for the whole past year or month.
The import is divided into several steps. Use the Next button to continue with wizard's next step, use the Previous button to return to wizard's previous step. The Help button shows help pages for the current wizard's step. The Cancel button closes wizard's window without importing any winning numbers.

Wizard's first step is a short description of the Import Winning Numbers Wizard feature.
## Statistics

### General Statistics

General Statistics provides basic information about the type and range of processed tickets. This information includes:

- the total number of tickets (package + winning numbers database when appropriate)
- count of tickets with winning numbers
- count of tickets with bonus numbers
- count of tickets with dummy numbers

### Ticket Numbers Statistics

This statistics gives frequency of occurrence of numbers in tickets: The statistics can be calculated for package tickets, for winning numbers selection or for both at the same time.

The table structure is explained here. The assessed parameter is ticket number occurrence. The table can be sorted by any column and it shows panel coloring from e.g. *Winning Numbers* page.

#### Example

<table>
<thead>
<tr>
<th>Number</th>
<th>Occurrence</th>
<th>%</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>117</td>
<td>2.6%</td>
<td>8</td>
<td>5</td>
<td>44</td>
<td>8</td>
<td>6.21</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>104</td>
<td>2.4%</td>
<td>2</td>
<td>19</td>
<td>40</td>
<td>9</td>
<td>9.23</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>116</td>
<td>2.6%</td>
<td>2</td>
<td>1</td>
<td>48</td>
<td>8</td>
<td>8.28</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>136</td>
<td>2.4%</td>
<td>1</td>
<td>5</td>
<td>21</td>
<td>7</td>
<td>7.06</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>105</td>
<td>1.6%</td>
<td>1</td>
<td>5</td>
<td>46</td>
<td>9</td>
<td>9.14</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>121</td>
<td>2.1%</td>
<td>3</td>
<td>10</td>
<td>56</td>
<td>8</td>
<td>7.99</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>128</td>
<td>2.2%</td>
<td>25</td>
<td>0</td>
<td>33</td>
<td>7</td>
<td>7.51</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>130</td>
<td>2.3%</td>
<td>5</td>
<td>11</td>
<td>56</td>
<td>7</td>
<td>7.88</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>136</td>
<td>2.4%</td>
<td>4</td>
<td>1</td>
<td>41</td>
<td>7</td>
<td>7.06</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>105</td>
<td>1.6%</td>
<td>16</td>
<td>1</td>
<td>49</td>
<td>9</td>
<td>9.14</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>110</td>
<td>1.9%</td>
<td>5</td>
<td>8</td>
<td>37</td>
<td>8</td>
<td>8.73</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>119</td>
<td>2.1%</td>
<td>4</td>
<td>6</td>
<td>49</td>
<td>8</td>
<td>8.07</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>122</td>
<td>2.1%</td>
<td>2</td>
<td>10</td>
<td>36</td>
<td>8</td>
<td>7.89</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>128</td>
<td>2.2%</td>
<td>5</td>
<td>10</td>
<td>45</td>
<td>9</td>
<td>8.86</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>122</td>
<td>2.1%</td>
<td>7</td>
<td>12</td>
<td>51</td>
<td>8</td>
<td>7.86</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>110</td>
<td>1.9%</td>
<td>1</td>
<td>11</td>
<td>43</td>
<td>9</td>
<td>8.73</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>128</td>
<td>2.2%</td>
<td>2</td>
<td>14</td>
<td>28</td>
<td>8</td>
<td>7.68</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>121</td>
<td>2.1%</td>
<td>1</td>
<td>16</td>
<td>28</td>
<td>8</td>
<td>7.89</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>120</td>
<td>2.1%</td>
<td>3</td>
<td>12</td>
<td>44</td>
<td>8</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>121</td>
<td>2.1%</td>
<td>6</td>
<td>8</td>
<td>46</td>
<td>8</td>
<td>7.93</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>120</td>
<td>2.1%</td>
<td>15</td>
<td>4</td>
<td>64</td>
<td>8</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>108</td>
<td>1.9%</td>
<td>1</td>
<td>9</td>
<td>44</td>
<td>9</td>
<td>8.66</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>115</td>
<td>2.0%</td>
<td>1</td>
<td>11</td>
<td>48</td>
<td>8</td>
<td>8.35</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>105</td>
<td>1.8%</td>
<td>1</td>
<td>8</td>
<td>51</td>
<td>9</td>
<td>9.32</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>120</td>
<td>2.1%</td>
<td>2</td>
<td>11</td>
<td>42</td>
<td>8</td>
<td>8.00</td>
<td></td>
</tr>
</tbody>
</table>
The table above provides assessment of occurrence of numbers in the whole history of model Expert Lotto 6/49 lottery. Number "1" occurred 117 times which presents 2.0% of all occurrences of all numbers in the table. The last draw appearance of this number was 8 draws ago. Such situation (the number was drawn just 8 draws ago) repeats 5 times in the lottery history. The minimum interval between occurrences (Min Skip) is "1" draw. The largest interval between two subsequent repeats of this number is 44 (Max Skip). Column Period shows the calculated average period between occurrences of this number. Because of the lottery nature the period value is usually close to the average draw interval (Avg Skip) which is given as an integer number. 

Data in the columns Occurrence and % always relate to the set of tickets being assessed (package, winning numbers selection or both). Data in columns Latest, Repeats, Min Skip, Max Skip, Avg Skip and Period relate always to the set of winning numbers draws selection from the lottery past and are given even if the statistics apply to package tickets only. Thus you can assess the frequency of occurrences of individual numbers in the package after filtering and exploit some important data from the defined period of lottery history (Latest, Skips) at the same time. When a field contains n/a then it means that the number cannot be assessed in the required period (either it does not appear at all - columns Occurrence, % - or it appears only once in the selected period - Skips, Period).

You can highlight numbers in the list with your mouse which initiates a new panel coloring being transferred to other part of application that use this feature:

<table>
<thead>
<tr>
<th>Number</th>
<th>Occurrence</th>
<th>%</th>
<th>Latest</th>
<th>Repeats</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>117</td>
<td>2.0%</td>
<td>8</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>104</td>
<td>1.6%</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>116</td>
<td>2.0%</td>
<td>21</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>136</td>
<td>2.4%</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>105</td>
<td>1.6%</td>
<td>9</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>121</td>
<td>2.1%</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>7</td>
<td>128</td>
<td>2.2%</td>
<td>25</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>130</td>
<td>2.3%</td>
<td>5</td>
<td>11</td>
</tr>
<tr>
<td>9</td>
<td>136</td>
<td>2.4%</td>
<td>14</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>105</td>
<td>1.6%</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>110</td>
<td>1.9%</td>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>12</td>
<td>119</td>
<td>2.1%</td>
<td>8</td>
<td>6</td>
</tr>
</tbody>
</table>

Note: The data statistics takes into account also numbers from tickets containing dummy numbers.

**Bonus Numbers**

Statistics ➔ Bonus Numbers

This statistics shows bonus number occurrences as a table and a chart.

This function does not apply for statistical evaluation of package tickets when playing a lottery where the bonus number is drawn from the same pool as the main number.
(the bonus number does not match any other drawn number in a ticket) because the package does not contain bonus numbers. In such a case this function applies for winning numbers statistics only.

In case of *Powerball* lotteries where one or more bonus numbers are drawn from a separate pool of numbers, the table shows bonus numbers for package tickets as well.

The table structure is described in chapter *Statistics*.

**Note:** Value "1" in column *Latest* for bonus number e.g. "2" means that number 2 was drawn just in the latest draw.

### Sum Statistics

This function offers several tools for statistical assessment of sum of ticket numbers.

- **Sums Table** - provides statistical overview of sum of numbers in tickets.

  The example above shows table with sum statistics for all winning numbers in Expert Lotto 6/49 demo lottery. It is evident that the most frequent sum is 163. This sum occurred 19 times in the selected period of lottery history which represents 2% from all possibilities. The last occurrence of a ticket with this sum was 11 draws ago. This situation did not repeat in the lotto history so far. The minimum interval between two subsequent occurrence of this sum (163) is one draw the maximum interval between two occurrences of this sum is 167 draws and the average value of lag for this sum is 50 draws. The calculated period of occurrences is 50,53 draws. Tickets containing dummy numbers are not taken into account in the sum statistics.

- **Sums Chart** - shows data from the *Sums Table* as a chart.
• **Sums Root Table** - sum root is the sum of all digits in the sum of ticket numbers. Sum root ranges from 1 to 9. Each sum root filtration leaves in the package tickets whose sum values are spaced by multiples of 9. If you filter the package for sum range difference 8 (for example sum range 171 to 179) then the remaining tickets will match each other in four numbers at most for each sum root value. Sum range filtering with difference higher than 9 leaves tickets matching each other in 5 numbers for one particular sum root value.

<table>
<thead>
<tr>
<th>Sum Root</th>
<th>Occurrence</th>
<th>[%]</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>114</td>
<td>11.4%</td>
<td>1</td>
<td>10</td>
<td>1</td>
<td>44</td>
<td>9</td>
<td>8.57</td>
</tr>
<tr>
<td>2</td>
<td>114</td>
<td>11.4%</td>
<td>18</td>
<td>2</td>
<td>1</td>
<td>41</td>
<td>8</td>
<td>8.28</td>
</tr>
<tr>
<td>3</td>
<td>110</td>
<td>11.0%</td>
<td>23</td>
<td>2</td>
<td>1</td>
<td>41</td>
<td>8</td>
<td>6.28</td>
</tr>
<tr>
<td>4</td>
<td>104</td>
<td>10.4%</td>
<td>6</td>
<td>9</td>
<td>1</td>
<td>47</td>
<td>8</td>
<td>8.42</td>
</tr>
<tr>
<td>5</td>
<td>116</td>
<td>11.6%</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>35</td>
<td>10</td>
<td>9.90</td>
</tr>
<tr>
<td>6</td>
<td>110</td>
<td>11.0%</td>
<td>24</td>
<td>0</td>
<td>1</td>
<td>59</td>
<td>9</td>
<td>5.14</td>
</tr>
<tr>
<td>7</td>
<td>113</td>
<td>11.3%</td>
<td>20</td>
<td>1</td>
<td>1</td>
<td>52</td>
<td>11</td>
<td>10.55</td>
</tr>
<tr>
<td>8</td>
<td>106</td>
<td>10.6%</td>
<td>5</td>
<td>8</td>
<td>1</td>
<td>33</td>
<td>9</td>
<td>6.81</td>
</tr>
<tr>
<td>9</td>
<td>113</td>
<td>11.3%</td>
<td>3</td>
<td>5</td>
<td>1</td>
<td>59</td>
<td>10</td>
<td>5.60</td>
</tr>
</tbody>
</table>

In the table above shows sum root occurrences for 1000 random tickets. Each sum root value appears approximately in one ninth of cases.

- **Sum Root Chart** - shows data from the *Sum Root Table* as a chart.
- **Odd/Even Sums** - provides ratio for Odd/Even sums.

**Odd / Even Statistics**

This function calculates the occurrence of odd and even numbers for package tickets, for selected winning numbers draws and/or for combination of both.

The example in the figure above shows occurrences of Odd/Even ratios in winning numbers database from 16/2005 to 28/2009 (900 hundreds tickets in total). This screen shows also the total count of odd and even numbers in selection.
Statistics

Tickets containing dummy numbers are not taken into account in this statistics

Low / High Statistics

Statistics for the ratio of low and high numbers in tickets. Low numbers are the first half of the whole range of drawn numbers, high numbers are the second half. For example in a 6/49 lottery the low numbers are 1 to 24, high numbers are 25 to 49.

Low/High statistics contains two tabs Low/High Table and Low/High Chart. The table layout is with defined structure of the Statistics tables.

<table>
<thead>
<tr>
<th>Low/High</th>
<th>Occurrence</th>
<th>[%]</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-6</td>
<td>16</td>
<td>1.7%</td>
<td>31</td>
<td>0</td>
<td>16</td>
<td>165</td>
<td>55</td>
<td>60.00</td>
</tr>
<tr>
<td>1-5</td>
<td>57</td>
<td>9.1%</td>
<td>4</td>
<td>6</td>
<td>1</td>
<td>165</td>
<td>11</td>
<td>11.03</td>
</tr>
<tr>
<td>2-4</td>
<td>235</td>
<td>24.5%</td>
<td>6</td>
<td>19</td>
<td>1</td>
<td>18</td>
<td>4</td>
<td>4.69</td>
</tr>
<tr>
<td>3-3</td>
<td>316</td>
<td>32.5%</td>
<td>5</td>
<td>17</td>
<td>1</td>
<td>16</td>
<td>3</td>
<td>3.04</td>
</tr>
<tr>
<td>4-2</td>
<td>222</td>
<td>23.1%</td>
<td>1</td>
<td>59</td>
<td>1</td>
<td>29</td>
<td>4</td>
<td>4.32</td>
</tr>
<tr>
<td>5-1</td>
<td>75</td>
<td>7.8%</td>
<td>23</td>
<td>2</td>
<td>1</td>
<td>58</td>
<td>13</td>
<td>12.80</td>
</tr>
<tr>
<td>6-0</td>
<td>9</td>
<td>0.9%</td>
<td>26</td>
<td>0</td>
<td>13</td>
<td>202</td>
<td>96</td>
<td>106.67</td>
</tr>
</tbody>
</table>

Low Numbers Total: 2822

High Numbers Total: 2938

The table corresponds to winning numbers database from the model lottery Expert Lotto 6/49.

Low/High value of “0 - 6” means that all ticket numbers are higher than 24. The occurrence of this ratio in the lottery history is 16 times (1.7%). The latest occurrence is 81 draws ago (8th week of 2009 1st Draw Wed) and such a situation (occurrence of this L/H ratio just before 81 draws) did not occur in the past. The minimum lag between any two subsequent occurrences of such L/H ratio is 16 and the maximum lag is 165; the average skip (average number of draws between two occurrences) is 55 draws and the calculated period of repeating is 60.

Under the table you will find the total count of low and high numbers in the selected range of lottery history.

Tickets containing dummy numbers are not considered in this statistics.

Odd/Even + Low/High Statistics

This function combines the statistics of occurrences for Odd/Even ratios together with all possible Low/High ratios.

Sum Root + Odd/Even

This function combines statistics for occurrence of Sum Root together with statistics for ratio of Odd/Even numbers.
Sum Root + Low/High Statistics

This function combines statistics for occurrence of *Sum Root* together with statistics for ratio of *Low/High* numbers.

Statistics - Pairs

This function provides table with statistics of occurrences of all possible number pairs.

<table>
<thead>
<tr>
<th>Pair</th>
<th>Occurrence</th>
<th>[%]</th>
<th>Latest</th>
<th>Repetts</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-42</td>
<td>2</td>
<td>0.0%</td>
<td>352</td>
<td>0</td>
<td>57</td>
<td>57</td>
<td>304</td>
<td>450.00</td>
</tr>
<tr>
<td>11-44</td>
<td>2</td>
<td>0.0%</td>
<td>391</td>
<td>0</td>
<td>140</td>
<td>140</td>
<td>265</td>
<td>450.00</td>
</tr>
<tr>
<td>10-40</td>
<td>3</td>
<td>0.0%</td>
<td>358</td>
<td>0</td>
<td>159</td>
<td>369</td>
<td>295</td>
<td>300.00</td>
</tr>
<tr>
<td>16-40</td>
<td>3</td>
<td>0.0%</td>
<td>2</td>
<td>0</td>
<td>60</td>
<td>301</td>
<td>121</td>
<td>300.00</td>
</tr>
<tr>
<td>28-47</td>
<td>3</td>
<td>0.0%</td>
<td>263</td>
<td>0</td>
<td>47</td>
<td>173</td>
<td>161</td>
<td>300.00</td>
</tr>
<tr>
<td>39-42</td>
<td>3</td>
<td>0.0%</td>
<td>99</td>
<td>0</td>
<td>74</td>
<td>600</td>
<td>256</td>
<td>300.00</td>
</tr>
<tr>
<td>2-5</td>
<td>4</td>
<td>0.0%</td>
<td>43</td>
<td>0</td>
<td>25</td>
<td>621</td>
<td>202</td>
<td>225.00</td>
</tr>
<tr>
<td>4-11</td>
<td>4</td>
<td>0.0%</td>
<td>320</td>
<td>0</td>
<td>34</td>
<td>410</td>
<td>220</td>
<td>225.00</td>
</tr>
<tr>
<td>5-45</td>
<td>4</td>
<td>0.0%</td>
<td>148</td>
<td>0</td>
<td>13</td>
<td>245</td>
<td>132</td>
<td>225.00</td>
</tr>
<tr>
<td>5-47</td>
<td>4</td>
<td>0.0%</td>
<td>43</td>
<td>0</td>
<td>109</td>
<td>372</td>
<td>197</td>
<td>225.00</td>
</tr>
</tbody>
</table>

The table in the example above is sorted by column *Occurrence* and numbers in column *Pair* are colored according to selection made on *Winning Numbers* page. If you highlight one or more pairs with your mouse (use SHIFT key for continuous selection and CTRL for scattered selection) then the coloring will change according to the occurrences of numbers in highlighted pairs. This coloring is transferred to all other parts of application that use this feature.

This function is used mostly to identify the most frequent pair in the package after its reduction by different filters. You can use this function also to find pairs that were not drawn so far in selected period of lottery history.

Triplets Statistics

This function provides table with statistics of all possible triplets. The table is similar to *Pairs* table and has the same meaning and usage with the exception that the assessed parameter is a triplet of numbers.
Number Matrix Statistics

Similar to Pairs this statistics shows occurrences of all pairs of drawn numbers. The statistics can be calculated for any range of lottery history, for tickets in the package or combination of both. The pairs are displayed as a cross-matrix of appropriate pairs. See also Inverted Matrix.

You can switch between Occurrences and Latest Draws tables. When Latest Draws table is used the fields in table show the number of draws elapsed since the last occurrence in the selected range of lottery history. If the pair was not drawn so far (0 in table Occurrence) then the cell in the Latest Draws table for such a pair contains "-".

The matrix size is 49 rows and 49 columns. Each raw and each column represents one drawn number. Each matrix cell then shows occurrence of the number pair consisting of the row and the column numbers. The figure above shows number "1" occurs 6 times together with number "2", 9 times together with number "3", 12 times together with number "4" etc. The number "18" occurs 10 times together with number "1". You can sort each row and each column in increasing or decreasing order by
clicking their respective headers.

<table>
<thead>
<tr>
<th></th>
<th>34</th>
<th>30</th>
<th>37</th>
<th>10</th>
<th>42</th>
<th>38</th>
<th>20</th>
<th>15</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>19</td>
<td>17</td>
<td>16</td>
<td>16</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>14</td>
<td>13</td>
<td>13</td>
<td>2</td>
<td>14</td>
<td>9</td>
<td>13</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>11</td>
<td>13</td>
<td>14</td>
<td>12</td>
<td>13</td>
<td>10</td>
<td>10</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>12</td>
<td>9</td>
<td>12</td>
<td>18</td>
<td>12</td>
<td>9</td>
<td>9</td>
<td>17</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>7</td>
<td>10</td>
<td>6</td>
<td>16</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>11</td>
<td>8</td>
</tr>
</tbody>
</table>

The example shows the data sorted by the number "1" in decreasing order and you can see that number "1" occurs most frequently together with number "34". Table columns can be sorted as well.

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3²</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>14</td>
<td>11</td>
<td>20</td>
<td>18</td>
<td>10</td>
<td>11</td>
<td>20</td>
<td>8</td>
<td>-</td>
</tr>
<tr>
<td>40</td>
<td>13</td>
<td>11</td>
<td>17</td>
<td>17</td>
<td>13</td>
<td>13</td>
<td>12</td>
<td>14</td>
<td>12</td>
</tr>
<tr>
<td>25</td>
<td>9</td>
<td>11</td>
<td>17</td>
<td>17</td>
<td>7</td>
<td>12</td>
<td>13</td>
<td>10</td>
<td>-</td>
</tr>
<tr>
<td>18</td>
<td>10</td>
<td>11</td>
<td>17</td>
<td>14</td>
<td>16</td>
<td>8</td>
<td>8</td>
<td>15</td>
<td>14</td>
</tr>
<tr>
<td>35</td>
<td>8</td>
<td>10</td>
<td>15</td>
<td>16</td>
<td>13</td>
<td>13</td>
<td>9</td>
<td>15</td>
<td>15</td>
</tr>
</tbody>
</table>

The number "3" occurs most frequently together with number "9".

Option *Sum range for Inverted Matrix* relates to presentation of the Inverted Matrix of Numbers.

![Sum range for Inverted Matrix: 2 to 22](image)

The example above shows the range of occurrences to be displayed in *Inverted Matrix*. According to the picture the *Inverted Matrix* will show pairs with occurrences from range of 2 to 22 only. You can enter a new range from keyboard or use scroll buttons. After calculating or updating the statistics data the default range is set to the minimum and maximum values in the matrix.

You can also reduce the contents of the *Inverted Matrix* table by highlighting two or more rows using your mouse in the *Matrix* table. The *Inverted Matrix* table will then contain data only for pairs composed from numbers in the selected rows.

**Example:** Rows "1" to "9" are highlighted so the *Inverted Matrix* table will contain list of occurrences for all the pairs created from numbers 1 to 9.

<table>
<thead>
<tr>
<th></th>
<th>4</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2 - 5</td>
<td>1 - 2</td>
<td>2 - 3</td>
<td>1 - 3</td>
<td>1 - 0</td>
<td>2 - 9</td>
<td>1 - 4</td>
<td>1 - 7</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>5 - 7</td>
<td>2 - 6</td>
<td>5 - 9</td>
<td>3 - 4</td>
<td>3 - 6</td>
<td>3 - 7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>8 - 9</td>
<td>3 - 8</td>
<td>6 - 9</td>
<td>4 - 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5 - 0</td>
<td>5 - 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6 - 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Usage**

This function is mainly used to identify the most frequently occurring pairs of numbers in the package ticket after applying various filter and/or lottery strategies. The function is often used together with *Inverted Matrix* statistics.
Inverted Number Matrix

*Inverted Number Matrix* provides a list of all number pairs sorted by their occurrences. The table in the figure below shows statistics calculated for 500 random tickets for the whole range of drawn numbers (49). Switching between *Occurrences* and *Latest Draws* tabs allows displaying either occurrences or number of draws elapsed since the last occurrence of any pair. In the first case the first column labeled "0" shows pairs which does not exist in your selection (package tickets and/or winning numbers draws). The other columns show how many times the appropriate pairs occurred in the selected history and/or package. In the second case the column header shows the number of draws elapsed since the last occurrence of the pair in this column. Label "n/a" means that pairs were not drawn in the selected range of winning numbers draws. Column "0" shows pairs from the latest draw (15 pairs of 6 numbers), column "3" then shows pairs drawn three draws ago (since the latest draw in the selected range of winning numbers) etc.

Table columns represent occurrences of appropriate number pairs; the occurrence values are shown in column headers. Each table row contains number pairs with occurrences shown in column headers. In the example above pairs 9-16 and 12-30 were not found at all; the lowest occurrence (1x) belongs to twelve pairs in total (1-45, 3-26, 8-24, 8-45, 14-45, 19-26, 20-35, 26-27, 33-34, 34-42, 35-40, 37-42). The pairs are sorted by the first and by the second number in the pair. *Latest Draws* tab allows displaying number pairs divided into columns according to how many draws elapsed since the last occurrence of any given number pair in the selected winning numbers range. Column labeled "0" then shows all number pairs from the very last draw.

You can use Highlight number option to lookup a particular number more easily. You can enter the number you are searching for from keyboard or you can use scroll.
button. Headers of columns that contain the searched number are painted in dark color.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9 - 16</td>
<td>1 - 45</td>
<td>1 - 16</td>
<td>1 - 5</td>
</tr>
<tr>
<td>2</td>
<td>12 - 30</td>
<td>3 - 26</td>
<td>2 - 37</td>
<td>1 - 22</td>
</tr>
<tr>
<td>3</td>
<td>8 - 24</td>
<td>3 - 35</td>
<td>1 - 37</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4 - 45</td>
<td>8 - 34</td>
<td>2 - 26</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>19 - 45</td>
<td>5 - 30</td>
<td>3 - 30</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>19 - 25</td>
<td>5 - 42</td>
<td>4 - 21</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>20 - 35</td>
<td>6 - 13</td>
<td>4 - 37</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>26 - 27</td>
<td>6 - 26</td>
<td>4 - 13</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>33 - 34</td>
<td>6 - 39</td>
<td>5 - 16</td>
<td></td>
</tr>
</tbody>
</table>

Table cells containing the searched number are painted with blue background. Numbers in the pairs are sorted by their values.

500 tickets in total were used to calculate the statistics above so normal distribution should be expected. Therefore the highest amount of number pairs will occur with approximately half of the maximum occurrence.

The highest occurrences are displayed in the rightmost table column. Use the scrollbars when the table is too large.

**Usage**

This function is often used with filters. It is very useful to identify how filters modify the package content and to lookup, which tickets the filter ‘prefers’. This function can also calculate occurrences of number pairs in any data range in the lottery history.

**Example**

We can use the same logic for number pairs as when classifying numbers into *hot*, *warm* and *cold* numbers.

Each ticket containing 6 numbers presents 15 number pairs. The total count of all pairs from 49 numbers is 1176. It means that in case of uniform occurrences of number pairs each pair should be drawn at least once within approximately 80 draws. Calculate statistics for 80 latest draws and display the *Inverted Matrix*. You will find pairs that were not drawn at all and pairs that were drawn more frequently.

**Note:** For other details on individual pairs and triplets see also *Pairs* and *Triplets* statistics.

**Successive Numbers Statistics**

The successive numbers statistics provides the following:

- *Overview* - provides an overview of pairs triplets and quads of successive numbers in assessed tickets
Statistics

- **Table and Chart of Pairs** - provides statistics of occurrence for pairs of successive numbers, it means 1-2, 2-3, 3-4 etc. Generally this statistics is just a sub-section of Pairs statistics thus it has the same meaning and usage.
- **Table and Chart of Triplets** - provides statistics of occurrence for triplets of successive numbers, it means 1-2-3, 3-4-5, 5-6-7 etc. Generally this statistics is just a sub-section of Triplets statistics thus it has the same meaning and usage.

In order to explain function we will use the following example:

![Statistics Calculation Example](image)

The figure above shows the result of statistics calculation for package containing 1000 random tickets. You can see that the package contain 512 tickets with pairs of successive numbers. Out of those, 380 tickets contain one pair only and 66 tickets contain two pairs. 554 tickets do not contain any pair. However 37 tickets contain one triplet of successive numbers. Triplets are considered as a separate element even though each triplet can be treated as two successive pairs. Five tickets contain quads of successive numbers.

**Dummy Numbers Statistics**

This function evaluates occurrences of dummy numbers in tickets in the package. Let's consider the following example:
Number "3" was replaced with number 94 in tagged tickets using Swap Numbers function and then number "12" was replaced with number 95. In tickets containing both original numbers the dummy numbers are positioned next to each other. In tickets containing only number "12" the replacing dummy number 95 took the second ticket number position. The last but one ticket before the number swap was 3, 8, 9, 12, 39, 48. After the swap the numbers at the second and the third positions were shifted to the right because the dummy numbers 94 and 95 took the first two ticket number positions.

Then the statistic for the tickets above look as follows:

<table>
<thead>
<tr>
<th>Ticket Positions</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dummy Number</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>94</td>
<td>4</td>
</tr>
<tr>
<td>95</td>
<td>4</td>
</tr>
<tr>
<td>96</td>
<td>0</td>
</tr>
<tr>
<td>97</td>
<td>0</td>
</tr>
<tr>
<td>98</td>
<td>0</td>
</tr>
<tr>
<td>99</td>
<td>0</td>
</tr>
</tbody>
</table>

The first table shows that the count of tickets without any dummy number is 5; the count of tickets with one dummy number is 2 and the count of tickets with two dummy numbers is 3. The second table shows the dummy numbers used for the number swap and their occurrences.

**Number Groups Statistics**

This statistics corresponds to *Number Groups* filter and provides two kind of information related to number groups. It concerns occurrence of numbers in each group and the count of unique groups a ticket falls in.
Column *Group* shows the range of each group. The count of groups and their ranges correspond to your settings from *Number Groups* filter window. Up to 10 groups with different ranges can be set. These groups do not need to be of the same size. The example above evaluates occurrence of individual numbers from 7 equal-sized groups for winning numbers from Expert Lotto 6/49 model lottery in the range of 16/2005 to 28/2009.

Column *Occurrence* in the first row in the figure above evaluates the occurrence of numbers 1 to 7 in the selected lottery history. Column *Latest* shows that at least one number from this group was drawn just 2 draws ago and such situation repeated 360 times in the lottery history. The minimum draw interval between two subsequent occurrences of numbers from the first group is one draw and the maximum interval is 6 draws. The average skip is one draw.

*Group Count Table* provides statistics how many unique groups are covered by each ticket from your selection.

From the figure above you can that there was no case where ticket numbers do not belong to any group. This case is possible only when the groups do not cover the whole range of drawn numbers. For example you can try set only two groups in *Number Groups* filter window. The first group will range 1 to 15 and the second group will range 35 to 49. Then there may appear tickets whose numbers do not belong to any of these two groups. However in the figure above shows results for 7 equally-sized number groups (each group contains 7 numbers). From this table you can see that the most frequent occurrences are ticket numbers belonging to 4 to 5 groups. It indicates that two adjacent numbers are drawn with the highest frequency.

**Ticket Positions Statistics**
This statistics gives table and chart for occurrence of drawn numbers at individual ticket positions.

<table>
<thead>
<tr>
<th>Ticket Position</th>
<th>Occurrence (%)</th>
<th>Lasted</th>
<th>Repeatability</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
<th>Date</th>
<th>Rank</th>
<th>Strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>112.4%</td>
<td>7</td>
<td>8</td>
<td>1</td>
<td>41</td>
<td>9</td>
<td>9.04</td>
<td>0.97</td>
<td>10</td>
<td>9.10</td>
</tr>
<tr>
<td>2</td>
<td>86.9%</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>39</td>
<td>10</td>
<td>13.33</td>
<td>0.10</td>
<td>0</td>
<td>4.79</td>
</tr>
<tr>
<td>4</td>
<td>87.9%</td>
<td>22</td>
<td>2</td>
<td>1</td>
<td>69</td>
<td>10</td>
<td>19.04</td>
<td>2.15</td>
<td>31</td>
<td>4.74</td>
</tr>
<tr>
<td>5</td>
<td>96.9%</td>
<td>9</td>
<td>10</td>
<td>1</td>
<td>39</td>
<td>9</td>
<td>9.47</td>
<td>0.96</td>
<td>21</td>
<td>5.17</td>
</tr>
<tr>
<td>6</td>
<td>59.9%</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>63</td>
<td>16</td>
<td>14.98</td>
<td>4.61</td>
<td>15</td>
<td>7.99</td>
</tr>
<tr>
<td>7</td>
<td>63.7%</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>83</td>
<td>14</td>
<td>14.27</td>
<td>5.00</td>
<td>7.54</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>65.7%</td>
<td>64</td>
<td>0</td>
<td>1</td>
<td>63</td>
<td>14</td>
<td>13.85</td>
<td>4.90</td>
<td>100</td>
<td>7.04</td>
</tr>
<tr>
<td>9</td>
<td>52.5%</td>
<td>6</td>
<td>5</td>
<td>1</td>
<td>74</td>
<td>16</td>
<td>17.21</td>
<td>0.37</td>
<td>7</td>
<td>2.82</td>
</tr>
<tr>
<td>10</td>
<td>44.6%</td>
<td>13</td>
<td>1</td>
<td>1</td>
<td>53</td>
<td>10</td>
<td>19.97</td>
<td>0.47</td>
<td>21</td>
<td>2.80</td>
</tr>
<tr>
<td>11</td>
<td>22.4%</td>
<td>15</td>
<td>1</td>
<td>1</td>
<td>216</td>
<td>40</td>
<td>49.51</td>
<td>0.38</td>
<td>7</td>
<td>1.20</td>
</tr>
<tr>
<td>12</td>
<td>39.3%</td>
<td>20</td>
<td>0</td>
<td>1</td>
<td>142</td>
<td>30</td>
<td>39.06</td>
<td>0.69</td>
<td>15</td>
<td>3.69</td>
</tr>
<tr>
<td>13</td>
<td>31.4%</td>
<td>17</td>
<td>1</td>
<td>1</td>
<td>123</td>
<td>27</td>
<td>29.05</td>
<td>0.62</td>
<td>13</td>
<td>1.69</td>
</tr>
<tr>
<td>14</td>
<td>29.2%</td>
<td>80</td>
<td>0</td>
<td>3</td>
<td>170</td>
<td>40</td>
<td>48.50</td>
<td>2.01</td>
<td>101</td>
<td>1.09</td>
</tr>
<tr>
<td>15</td>
<td>23.7%</td>
<td>84</td>
<td>0</td>
<td>0</td>
<td>159</td>
<td>47</td>
<td>42.98</td>
<td>2.03</td>
<td>51</td>
<td>1.18</td>
</tr>
<tr>
<td>16</td>
<td>19.2%</td>
<td>66</td>
<td>0</td>
<td>4</td>
<td>122</td>
<td>44</td>
<td>50.00</td>
<td>1.49</td>
<td>51</td>
<td>1.08</td>
</tr>
<tr>
<td>17</td>
<td>16.1%</td>
<td>49</td>
<td>0</td>
<td>4</td>
<td>234</td>
<td>50</td>
<td>50.00</td>
<td>0.36</td>
<td>18</td>
<td>0.92</td>
</tr>
<tr>
<td>18</td>
<td>12.7%</td>
<td>62</td>
<td>0</td>
<td>4</td>
<td>133</td>
<td>64</td>
<td>75.00</td>
<td>0.47</td>
<td>40</td>
<td>0.65</td>
</tr>
<tr>
<td>20</td>
<td>8.3%</td>
<td>60</td>
<td>0</td>
<td>1</td>
<td>499</td>
<td>71</td>
<td>81.82</td>
<td>0.38</td>
<td>12</td>
<td>0.60</td>
</tr>
<tr>
<td>21</td>
<td>9.7%</td>
<td>310</td>
<td>0</td>
<td>22</td>
<td>317</td>
<td>249</td>
<td>409.00</td>
<td>2.13</td>
<td>100</td>
<td>0.50</td>
</tr>
<tr>
<td>22</td>
<td>9.7%</td>
<td>260</td>
<td>0</td>
<td>10</td>
<td>261</td>
<td>99</td>
<td>109.00</td>
<td>1.00</td>
<td>32</td>
<td>0.22</td>
</tr>
<tr>
<td>23</td>
<td>8.9%</td>
<td>45</td>
<td>0</td>
<td>14</td>
<td>34</td>
<td>183</td>
<td>255.00</td>
<td>0.42</td>
<td>0</td>
<td>0.22</td>
</tr>
</tbody>
</table>

The table structure is described here.

The label of the first table column indicates the ticket position currently being displayed in the table, use the combo-box above the table to select a different position.

Numbers in example reflect panel coloring from e.g. Winning Numbers page. Click any table row(s) to replace the current coloring with a new one. You can use SHIFT key for continuous selection or CTRL key for scattered selection.

Ticket Position Chart displays data from the table as chart. Use Options button to change the ticket position being displayed in the chart. The ticket position selected in the table does not affect the chart display. This allows to show occurrences of numbers for all particular positions in one window at the same time.

Note: For better comprehension it is suitable to switch the chart window to line chart type and change the colors of each ticket position.

**Number Distance Statistics**

This function provides statistics for differences between numbers at neighboring ticket positions. The assessed parameter is the size of difference between numbers in two adjacent ticket positions. If ticket numbers are $N1, N2, N3, N4, N5, N6$ then the statistics show data for values of $N2-N1, N3-N2, N4-N3, N5-N4, N6-N5$
The table above shows that value "2" is the most frequent difference between ticket numbers at the second and first positions \((Distance 2-1)\) occurs 100 times) and difference "1" is the second most frequent difference between these two positions etc. The distance at ticket positions 2-1 from the latest draw is "2". Situation that the distance "2" occurred just in the latest draw repeated two times in the lottery history of Expert Lotto 6/49 demo lottery from the 16th week 2005 to 28th week 2009.

Number distance chart allows displaying these differences for all combinations of adjacent pairs together. The course of all charts for all possible combinations of adjacent pairs is roughly the same.

**First / Last Digit Statistics**

These statistics provides a review of occurrences of first/last digits at all ticket number positions.

If ticket number is e.g. 20 then the **first digit** is 2 and the **last digit** is 0. If ticket number is e.g. 8 then the **first digit** is 0 and the **last digit** is 8.
The figure above shows statistics for winning numbers of Expert Lotto 6/49 demo lottery from 16/2005 to 28/2009.

The first table gives statistics for the first digit, the second table with the same structure gives statistics for the last (second) digit in number. It is evident from the first table that values 1 and 2 were the most frequent ones in the first (leading) digit in the 3rd position in the ticket. It indicates high frequency of 3/3 Low/High ratio.

From the second table you can see that the last digits of numbers in the 3rd position within the ticket are equally present (in the model database of Expert Lotto 6/49 containing over 900 tickets).

The first table shows:

<table>
<thead>
<tr>
<th>First Digit</th>
<th>Occurrence (%)</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>64 6.7%</td>
<td>25</td>
<td>0</td>
<td>1</td>
<td>50</td>
<td>15</td>
<td>15.00</td>
</tr>
<tr>
<td>1</td>
<td>361 37.6%</td>
<td>2</td>
<td>90</td>
<td>1</td>
<td>10</td>
<td>3</td>
<td>2.66</td>
</tr>
<tr>
<td>2</td>
<td>358 37.3%</td>
<td>1</td>
<td>124</td>
<td>1</td>
<td>14</td>
<td>3</td>
<td>2.68</td>
</tr>
<tr>
<td>3</td>
<td>165 17.2%</td>
<td>4</td>
<td>22</td>
<td>1</td>
<td>33</td>
<td>6</td>
<td>5.82</td>
</tr>
<tr>
<td>4</td>
<td>12  1.2%</td>
<td>75</td>
<td>0</td>
<td>7</td>
<td>214</td>
<td>62</td>
<td>80.00</td>
</tr>
</tbody>
</table>

The second table shows:

<table>
<thead>
<tr>
<th>Last Digit</th>
<th>Occurrence (%)</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>108 11.2%</td>
<td>22</td>
<td>1</td>
<td>1</td>
<td>34</td>
<td>9</td>
<td>8.30</td>
</tr>
<tr>
<td>1</td>
<td>96 10.0%</td>
<td>11</td>
<td>4</td>
<td>1</td>
<td>43</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>2</td>
<td>87 9.1%</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>72</td>
<td>10</td>
<td>11.03</td>
</tr>
<tr>
<td>3</td>
<td>92 9.6%</td>
<td>14</td>
<td>5</td>
<td>1</td>
<td>43</td>
<td>10</td>
<td>10.43</td>
</tr>
<tr>
<td>4</td>
<td>98 10.2%</td>
<td>3</td>
<td>9</td>
<td>1</td>
<td>49</td>
<td>10</td>
<td>9.80</td>
</tr>
<tr>
<td>5</td>
<td>101 10.5%</td>
<td>6</td>
<td>5</td>
<td>1</td>
<td>49</td>
<td>9</td>
<td>9.50</td>
</tr>
<tr>
<td>6</td>
<td>93 9.7%</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>47</td>
<td>10</td>
<td>10.32</td>
</tr>
<tr>
<td>7</td>
<td>93 9.7%</td>
<td>17</td>
<td>2</td>
<td>1</td>
<td>51</td>
<td>10</td>
<td>10.32</td>
</tr>
<tr>
<td>8</td>
<td>66 9.0%</td>
<td>12</td>
<td>5</td>
<td>1</td>
<td>51</td>
<td>11</td>
<td>11.16</td>
</tr>
<tr>
<td>9</td>
<td>106 11.0%</td>
<td>5</td>
<td>4</td>
<td>1</td>
<td>32</td>
<td>9</td>
<td>9.06</td>
</tr>
</tbody>
</table>

The statistics are always calculated for all ticket positions in one step. Thus switching ticket position changes only values displayed in tables.

Using this statistics you can affect your decision making process when you select values for The First / Last Digits and Position Filters ➔ The First / Last Digits filters.
This function evaluates decrease/increase in numerical value of number in each position within the ticket.

When statistically evaluating package tickets the value is calculated as the difference between numbers of package tickets and the numbers from the latest draw from the selected range of lottery history.

For example if the latest draw in your winning numbers selection is:

28/2009 1st Wed, 16, 18, 22, 23, 28, 29, 24

and the package tickets are:

09, 15, 25, 26, 33, 41
04, 07, 11, 38, 41, 43
18, 23, 38, 42, 46, 49

Then the calculated number movement values for package tickets are:

-07, -03, +03, +03, +05, +12
-12, -11, -11, +15, +13, +19
+02, +05, +16, +19, +18, +20

The statistics for winning numbers are calculated as the difference in ticket numbers between two consecutive draws.

For example if the selected range of winning numbers draws is:

28/2009 1st Sun, 06, 13, 14, 19, 41, 42, 29
28/2009 2nd Sun, 23, 29, 36, 42, 44, 47, 07
28/2009 1st Wed, 16, 18, 22, 23, 28, 29, 24
28/2009 2nd Wed, 02, 13, 16, 17, 25, 40, 27

Then the calculated number movement values for winning numbers are:

-17, -16, -22, -23, -03, -05
+07, +11, +14, +19, +16, +18
+14, +05, +06, +06, +03, -11

<table>
<thead>
<tr>
<th>Position</th>
<th>Occurrence</th>
<th>[%]</th>
<th>Latest</th>
<th>Repeats</th>
<th>Min Skip</th>
<th>Max Skip</th>
<th>Avg Skip</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>62</td>
<td>6.9%</td>
<td>25</td>
<td>1</td>
<td>1</td>
<td>57</td>
<td>14</td>
<td>14.50</td>
</tr>
<tr>
<td>1</td>
<td>58</td>
<td>6.5%</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>51</td>
<td>15</td>
<td>15.50</td>
</tr>
<tr>
<td>2</td>
<td>57</td>
<td>6.3%</td>
<td>24</td>
<td>1</td>
<td>1</td>
<td>59</td>
<td>15</td>
<td>15.77</td>
</tr>
<tr>
<td>3</td>
<td>52</td>
<td>5.8%</td>
<td>7</td>
<td>3</td>
<td>1</td>
<td>76</td>
<td>17</td>
<td>17.29</td>
</tr>
<tr>
<td>4</td>
<td>51</td>
<td>5.7%</td>
<td>55</td>
<td>0</td>
<td>1</td>
<td>70</td>
<td>17</td>
<td>17.63</td>
</tr>
<tr>
<td>5</td>
<td>47</td>
<td>5.2%</td>
<td>23</td>
<td>1</td>
<td>1</td>
<td>95</td>
<td>19</td>
<td>19.13</td>
</tr>
<tr>
<td>6</td>
<td>46</td>
<td>5.1%</td>
<td>11</td>
<td>2</td>
<td>1</td>
<td>88</td>
<td>19</td>
<td>19.54</td>
</tr>
<tr>
<td>7</td>
<td>43</td>
<td>4.8%</td>
<td>19</td>
<td>2</td>
<td>1</td>
<td>86</td>
<td>21</td>
<td>20.51</td>
</tr>
<tr>
<td>8</td>
<td>38</td>
<td>4.2%</td>
<td>26</td>
<td>0</td>
<td>1</td>
<td>104</td>
<td>23</td>
<td>23.66</td>
</tr>
<tr>
<td>9</td>
<td>37</td>
<td>4.1%</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>79</td>
<td>23</td>
<td>24.30</td>
</tr>
<tr>
<td>10</td>
<td>34</td>
<td>3.8%</td>
<td>66</td>
<td>0</td>
<td>1</td>
<td>94</td>
<td>25</td>
<td>26.44</td>
</tr>
<tr>
<td>11</td>
<td>29</td>
<td>3.2%</td>
<td>16</td>
<td>0</td>
<td>4</td>
<td>81</td>
<td>29</td>
<td>31.00</td>
</tr>
<tr>
<td>12</td>
<td>27</td>
<td>3.3%</td>
<td>12</td>
<td>0</td>
<td>1</td>
<td>137</td>
<td>32</td>
<td>33.30</td>
</tr>
<tr>
<td>13</td>
<td>23</td>
<td>2.5%</td>
<td>20</td>
<td>0</td>
<td>2</td>
<td>154</td>
<td>37</td>
<td>39.09</td>
</tr>
<tr>
<td>14</td>
<td>22</td>
<td>2.4%</td>
<td>16</td>
<td>0</td>
<td>2</td>
<td>128</td>
<td>37</td>
<td>40.66</td>
</tr>
</tbody>
</table>

The decrease is indicated by "-" sign. As it can be seen from the table and charts the distribution in all positions of assessed lottery (when the selected range of lottery
history is long enough) is roughly equal to the normal distribution with the peak around the difference with value "0". It means that there are very frequent situations where individual drawn numbers are repeated, albeit in one ticket position only. The distribution in the package depends on how the tickets were generated and which filters were applied.

The chart of number movement shows the occurrence of individual number movement values in both directions (decrease/increase). Use Options button to display charts for different ticket positions. The movement distributions can be displayed for all ticket positions at the same time however it is not very useful as the charts overlap each other significantly due to the nature of assessed parameter.

The following chart shows assessment for the first ticket position for 1000 random tickets. The tickets are compared against the last ticket in the winning numbers database (1st draw Sun from Expert Lotto 6/49 demo lottery with numbers 6,13,14,19,41,42).

Because the highest drawn number in the first position is "6", the largest negative change is to number 1 which means reduction by -5. It can be seen from the chart that there is really no lower decrease. If the file is statistically significant (equal distribution) then it should apply that sum of occurrences of negative movement (movement "-1" to "-5") is roughly the same as the sum of all occurrences of positive movement (i.e. values equal to zero and values higher than zero).

Note: Pay attention to the selection of winning numbers draws when evaluating tickets in the package as that selections defines the draw that the package tickets will be compared with.

**Trailing Numbers Statistics**
This function indicates how numbers from the latest draw announce or predict numbers for the next draw. The numbers of the latest draw from the current selection of winning numbers are always chosen as announcers. When the program calculates statistics it searches the selected section of winning numbers database for occurrences of numbers which follow immediately after any draw that contains at least one announcing number. The table then displays the occurrences of these follow up - trailing - numbers.

**Example [Expert Lotto 6/49]:**

Select Expert Lotto 6/49 demo lottery and switch to *Statistics* page. Choose to *Calculate Stats* for the last 10 draws of the 1st Sun draw only:

Select *Trailing Numbers* in *Show Stats for* option sort the table by *Occurrence* column in descending order:

In this case the announcing numbers are the numbers from draw 28/2009, 1st Sun, which is the latest draw in the chosen selection. The numbers are 6, 13, 14, 19, 41,
42. As you can see from the table above if at least one out of these numbers has been drawn then in the immediately following draw the most frequent number was 19 followed by 29, 11, 23 etc. In contrary, numbers 4, 5, 6 7 etc. were not drawn at all - i.e. numbers with zero occurrence from the statistical table.

<table>
<thead>
<tr>
<th>Date</th>
<th>Sun</th>
<th>6</th>
<th>13</th>
<th>14</th>
<th>19</th>
<th>41</th>
<th>42</th>
<th>Occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td>28/2009 1.</td>
<td>6</td>
<td>13</td>
<td>14</td>
<td>19</td>
<td>41</td>
<td>42</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>27/2009 1.</td>
<td>2</td>
<td>15</td>
<td>22</td>
<td>29</td>
<td>30</td>
<td>37</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>26/2009 1.</td>
<td>5</td>
<td>6</td>
<td>11</td>
<td>31</td>
<td>40</td>
<td>43</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>25/2009 1.</td>
<td>16</td>
<td>21</td>
<td>24</td>
<td>25</td>
<td>35</td>
<td>46</td>
<td>47</td>
<td></td>
</tr>
<tr>
<td>24/2009 1.</td>
<td>11</td>
<td>19</td>
<td>28</td>
<td>29</td>
<td>32</td>
<td>39</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>23/2009 1.</td>
<td>3</td>
<td>13</td>
<td>14</td>
<td>19</td>
<td>23</td>
<td>48</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>22/2009 1.</td>
<td>3</td>
<td>13</td>
<td>19</td>
<td>27</td>
<td>31</td>
<td>44</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>21/2009 1.</td>
<td>1</td>
<td>12</td>
<td>20</td>
<td>23</td>
<td>30</td>
<td>34</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>20/2009 1.</td>
<td>12</td>
<td>19</td>
<td>24</td>
<td>30</td>
<td>44</td>
<td>45</td>
<td>27</td>
<td></td>
</tr>
<tr>
<td>19/2009 1.</td>
<td>9</td>
<td>23</td>
<td>25</td>
<td>27</td>
<td>30</td>
<td>38</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

The table above displays drawn numbers from the selected range of winning numbers database, it means the latest 10 draws of the 1st Sun draw. Announcing numbers are in bold, trailing number 19 highlighted by pink background appears in two draws:

- 23/2009 announced by numbers 13 and 19 from the preceding draw
- 24/2009 announced by numbers 13, 14 and 19 from the preceding draw

Thus the number 19 was announced 5 times in total which is the value shown in the Occurrence column in the statistics table.

*Position Table* works in a similar way. The announcing and trailing numbers are divided according to their ticket positions.

**Example [Expert Lotto 6/49]:**

Use the same selection of drawn numbers as in the previous example. Set *Ticket position to display* to *Position 2* and sort the table by column *Occurrence* in
descending order:

It can be seen from this table that announcing number for Position 2 is number 13 which has been followed again by numbers 13 and 19 at the same ticket position.

The table above displays drawn numbers from the selected range of winning numbers database, it means the latest 10 draws of the 1st Sun draw. Announcing number 13 at the second ticket position is highlighted in bold. Each trailing number (13 and 19) highlighted by pink background appears only once. Thus the value in Occurrence column for both trailing numbers is “1”.

Repeating Numbers

Statistics ➔ Repeating Numbers

The table shows how many times each number repeated in the selected range of winning numbers draws.

Example [Expert Lotto 6/49]
The figure above shows that numbers most frequently repeating in the very next draw are 35 and 48 and that they were repeated in the next draw 16 times in the whole history of the demo Expert Lotto 6/49 lottery.
The following figure shows that the most repeating numbers are 5, 17, 29, 30, 35, 36, 37, 46, 48 which appeared 4 times in a row (repeated 3 times).

**Note:** The values in this table are not affected by the tickets in the package. The table shows data only for the selected range of winning numbers draws.

**Filters Statistics**

This table allows defining of custom statistical data using filters and then evaluation of their statistical parameters such as *Occurrence, Latest, Skip* etc. In this case the statistical data is a fact that a ticket passed (compound) filter’s condition.

Buttons at the bottom of the table:

- **Add Filter** - shows a menu with available filters, including compound and group ones, which the statistics can be calculated for. The table must be refreshed by clicking *Calculate* button after adding a filter.
- **Edit** - allows editing of input parameters of selected filter.
- **Remove** - removes selected filter from the table.
- **Move Up** - moves selected filter one row up.
- **Move Down** - moves selected filter one row down.

**Example [Expert Lotto 6/49]:**

1. Create a new compound filter consisting of two parts: Odd / Even 3:3 and Sum in the range of 120 to 180. That means a combination of two statistically most common values.
2. Switch to *Statistics* page and click *Calculate* button.
3. Show *Filters* table.
4. Click *Add Filter* button at the bottom of the screen and select the filter created in previous step.
5. Recalculate the statistics by clicking *Calculate* button.
6. The resulting table will look as follows:
From the figure we can see that four draws elapsed from the last occurrence of "Odd/Even 3:3 AND Sum 120 to 180" and the average skip is 5 draws. So from the statistical point of view, this event can be expected in the next draw.

**WN History Segments**

The table and chart show occurrence of WN History segments for selected history column or combined occurrences for all History columns.

**Example [Expert Lotto 6/49]**

From the table above it is possible to assume that in the next draw the segment distribution in column "-1" will be "3-2-1" because this combination has average skip of 7 draws and its last occurrence is 10 draws ago.

**Winning Numbers**

This function is not a 'real' statistics. Instead, it provides an overview of values of statistically assessed parameters for majority of filters thus it closely relates to statistics.

The data in the table and in charts are calculated automatically after pressing Calculate Stats button even if you choose to show statistics for package tickets only. The range of draws within the table corresponds to the current selection of winning numbers however for performance reasons the table shows 1000 rows at most (1000 latest draws from selection) and the charts show at most 100 latest draws from selection.

**Winning Numbers Table**

The winning numbers table is powerful tool providing overview on how some important filters did apply in the lottery past.

**The table contents:**

- The first column contains draw date.
• The second column contains drawn numbers and bonus numbers in brackets (where appropriate).
• Sum - gives the sum of all numbers in ticket (bonus numbers are not included in the sum).
• Sum Root - is part of Sum filter and its values are 1 to 9 calculated as a sum of all digits of appropriate sum value.
• StdDev - gives standard deviation. The standard deviation is computed for an average value of all numbers within ticket. Bonus numbers are not included into StdDev calculation.
• Low / High - shows the ratio of low and high numbers. Bonus numbers are not included in calculation.
• Odd / Even - gives ratio of odd and even numbers within ticket. Bonus numbers are not included in calculation.
• Odd/Even positions - symbol E (even) indicates even number, symbol O (odd) indicates odd number at appropriate ticket position.
• Number Groups - show how many ticket numbers fall into each Number Group. The data in this column always relate to the last used setting of number groups. If you change the count of groups in the filter window it is necessary to use Calculate Stats button again to reflect this change in the table.
• Group Count - how many unique groups the ticket numbers fall in.
• Number Movement - shows decrease/ increase of numerical value in each ticket position. Value in this field always relate to immediately preceding draw:

<table>
<thead>
<tr>
<th>Click Here For Options</th>
<th>Number Movement</th>
<th>Movement Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>23/2009 1st Sun</td>
<td>+04 -02 -08 -10 +11 +05</td>
<td>0</td>
</tr>
<tr>
<td>27/2009 1st Sun</td>
<td>-03 +03 +11 -02 -19 -06</td>
<td>-1</td>
</tr>
<tr>
<td>26/2009 1st Sun</td>
<td>-11 -15 -19 +06 +05 -03</td>
<td>-31</td>
</tr>
<tr>
<td>25/2009 1st Sun</td>
<td>+05 +02 -04 +04 +03 +07</td>
<td>9</td>
</tr>
</tbody>
</table>

Number 5 appears in draw 26/2009 1st Sun in the first ticket position and number 2 appears at the same ticket position in the following draw (27/2009 1st Sun). Thus the resulting movement is decrease by -3 (5-2). The following draw has number 6 at its first position therefore the number movement is increase by +4.

• Movement Sum - an auxiliary reading given by the sum of number movement values at all ticket positions.
• Hit xx Prev - these columns provide the highest count of numbers (Match 1, Match 2, Match 3 etc) in which the given ticket matches any of previous xx (5, 15, 30...etc) draws. Hover your mouse above the field to see the list of matching numbers. The count of previous draws to be checked (value xx) is customizable, see below.
• First / Last Digit - show first / last digits at each ticket position.
• Max in Column / Max in Row - these two columns gives the highest count of numbers in any column/row of playslip panel. Expert Lotto 6/49 demo lottery has playslip playslip panel with 5 columns (except the last row with 4 columns) and 10 rows (except for the last column that has 9 rows only). The ticket has 6 numbers therefore the maximum count in a column can be 6 and the maximum count of numbers per row is 5 numbers.
• Repeated xx - these columns show how many numbers of the given ticket appeared at last once in xx previous draws (i.e. table rows). Hover your mouse above the cell to see the list of repeating numbers. Value xx is customizable, see below.
The figure above shows that 3 unique numbers from the latest draw repeat in 5 previous draws.

- **Index Movement** - each ticket is assigned a number which identifies its position in the full list of all possible combinations. The index movement is then defined as follows:

\[
\text{AbsoluteValueOf(IndexOfCurrentDraw - IndexOfPreviousDraw)} / \text{NumberOfAllPossibleCombinations}
\]

The number of all possible combinations depends on the lottery type. For example a 6/49 lottery has 13983816 combinations, then ticket 1, 2, 3, 4, 5, 6 has index value 1 and the last ticket (44, 45, 46, 47, 48, 49) has index 13983816.

Value in this column ranges from -0.999 to +0.999.

- **Ticket Index** - shows the position of the ticket in the sequence of all possible combinations. For example a 6/49 lottery has 13983816 combinations, then ticket 1, 2, 3, 4, 5, 6 has index value 1 and the last ticket (44, 45, 46, 47, 48, 49) has index 13983816.

- **Number Distance** - provides differences of numbers in two adjacent positions: \( \text{NumberAtPosition2} - \text{NumberAtPosition1} \), \( \text{NumberAtPosition3} - \text{NumberAtPosition2} \) etc.

- **Position 1 to X** - contains ticket numbers from appropriate positions. These columns are included only to support ticket numbers predictions.

- **Adjacent Numbers** - shows the count of numbers that are adjacent to numbers from previous draw.

Clicking table header **Click Here For Options** opens options window where you can arrange the table layout:

It is possible to hide/display any column in the table by checking the appropriate checkboxes in front of column names. Using **Move Up, Move Down** buttons you can
change the order of columns within the table. For example when columns \textit{Sum} and \textit{Low/High} are displayed as adjacent columns you can comfortably observe how the distribution of high numbers affects the \textit{Sum} value.

You can assign any filter to each table column to change background color of corresponding cells if the ticket fails to pass the filter condition. This way you get well-arranged overview for statistical values together with indication whether tickets match chosen filters. To assign a filter click column name to which the filter is to be assigned and then check option \textit{Use filter to highlight failed tickets} and use button $>$ to select the filter.

To change the background color of failed tickets, click option \textit{Background color for failed tickets} (the colored rectangle) which opens a standard window for color selection.

\textbf{Notes}

- You can move within the table using scrollbars.
- All columns in the table can be sorted in ascending or descending order.
- You can print table and export it to text files.
- The table displays only 1000 latest draws from the chosen selection of winning numbers.

\textbf{Winning Numbers Chart}

This function is intended for those who prefer to base their filters on visual perception of the latest trends of filter parameters. This tab displays some data from the winning numbers table as a chart. Using \textit{Options} button under the chart window you can display or hide data lines for other columns of winning numbers table. You can display several lines at the same time which is suitable looking for correlation between filters. However you should keep in mind that the scale of chart's vertical axis is always adjusted to the highest range of displayed values.

If you display some chart lines separately (one per screen) you can invoke the appropriate filter window directly using \textit{Filter} button. This button becomes active only after changing the position of both dragable range lines. To do so, drag the black dashed lines with your mouse. The range values are automatically transferred into appropriate controls in filter window.

The minimum and maximum values of displayed parameter are shown under the chart window. There are also numerical values representing the current positions of dragable range lines. These values are automatically transferred to appropriate fields in corresponding filter window.

For performance reasons the charts display the latest 100 draws at most.

\textbf{Statistics - Options}
The last item in the list of statistics does not offer statistical data but it allows changing some parameters for the display of statistical tables and charts.

- **Hide table rows with zero occurrence** - this option will hide rows in the statistical tables which have "0" in the column *Occurrence*. This switch is especially suitable for analysis of pairs and triplets.
- **Hide chart points with zero occurrence** - the same switch as for statistical tables.
- **Table columns to show** - list of default columns for tables with statistics. By checking the corresponding box you can hide or display appropriate column in the table.
- **Move Up / Down** - using these buttons you can change the order of columns within all statistical tables.
- **Show table row number in a tooltip** - enables displaying of row numbers which can contribute to better orientation in statistical tables.
- **Module List** - here you can turn some statistical modules on/off and thus speed the statistics calculation up.
Winning Numbers History

Why do we study winning numbers history?

The goal of betting is to find the winning combination of numbers. One of the most common strategies is to select a set of numbers larger than the count of winning numbers being drawn and then create tickets covering all or the most of combinations of these numbers. Majority of Expert Lotto features will help you in doing so.

However in this part of the application we are trying to use a different strategy. The strategy is based on evaluation of frequency of number occurrences in the lottery history.

To understand this strategy you should be familiar with Winning Numbers History page.

Expert Lotto presents the winning numbers arranged in tables and provides simple functions and visual tools helping you to estimate the future values in Winning Numbers History tables. Your estimates then provide input parameters for Winning Numbers History filter. If you manage to fit your estimates into +10 and -10 error margin from the actual value then your can reduce the list of all possible tickets (almost 14 million tickets in lotteries drawing 6 numbers from a pool of 49 numbers) in such a way that the resulting set contains tens to hundreds tickets. However this resulting set is guaranteed to contain the Jackpot winning ticket.

Example [Expert Lotto 6/49]

1. Write down the last two draws from Winning Numbers page (28/2009 1st Wed a 2nd Wed). The tickets used in this example are: 16,18,22,23,28,29 (28/2009 1st Wed) and 2,13,16,17,25,40 (28/2009 2nd Wed)
2. Switch to WN History page. Make sure that options 1st Wed, 2nd Wed. and 1st Sun, 2nd Sun as well as All Draws are selected and click Update button. The data in the table are updated. Click the header of column labeled "0" to sort the numbers in ascending order according to their occurrences in the winning numbers history.

Numbers 2, 13, 16, 17, 25 and 40 are given as the latest draw with the history period "1". The sum values in Summary Table are as follows:

Write these values down, you will need them in following steps. These values are automatically provided in the Winning Numbers History filter. Also note the values in the Summary Table page. In this case the values are: 368, 746, 1202, 1646, 2008, 2407, 2773, 3154, 3500, 3867, 4241

3. Select Edit in the Winning Numbers menu. Click Hide box in the row for the 2nd Wed 28/2009 draw. The record will change as follows (see the highlighted ticket):
Note: Should you wish to repeat the exactly same example then you must skip all recent draws.

4. Switch to Winning Number History page and press button Update. The table is recalculated as if the 2nd Wed 28/2009 draw has not been made yet.

5. Go to Ticket Generator and select Ticket Numbers range 1 to 49, check option Generate maximum possible number of tickets and then click OK. The maximum possible count of tickets 13,983,816 is loaded into the package.

6. Select filter Winning Numbers History and enter the sum values you wrote down earlier into appropriate table cells while adding 10 in the Max column and subtracting 10 in the Min column.

   Note: Make sure you are entering values into the table in Sums tab. The filter window should look like follows:
Fields *1st Wed, 2nd Wed, 1st Sun, 2nd Sun* are options for winning numbers selection. All checkboxes to the left of *History Index* column must be selected. Select *And* as the *Logical Condition*. Also select *Leave* in the *Matching Tickets* panel. Now click button *Apply*.

The tickets in the package are backed up first and then you will see filter's progress bar showing the number of tickets processed so far. Because of the large number of tickets being processed this task is very time consuming, especially on slow PCs.

7. When the filtering is finished you will get a message how many tickets are left in the package as well as how many tickets were removed from the package. In this case the number of tickets left in the package is 196. These remaining tickets always contain the Jackpot winning ticket (2,13,16,17,25,40 in this example).

8. To verify this switch to Visual Package page and click the winning numbers on the panel (right hand side). The numbers are highlighted in table's header. The last table column shows the match with the Jackpot winning ticket. (The ticket with blue background in the figure below)
Note: Only tickets matching the winning numbers in 5 or 6 numbers were left in the package. The Jackpot winning ticket has blue background.

All 196 tickets in the package met filter settings (error margin +/-10 from the expected sums in each column). After using option Remove Match in (see figure above) the ticket you were looking for remains in the package.

9. As the last step in this example you must edit the winning numbers database again. Select function Edit in Winning Numbers menu and switch option Show skipped entries. Remove the "Skip" flag of the winning ticket to restore the winning numbers database record.
1. The number of tickets in the package can be reduced even more. When evaluating entries in the Summary Table you can see that quite frequently the differences in 3 to 5 columns are lower or equal to +/-10. Then the filter settings should change as follows:

<table>
<thead>
<tr>
<th>Draw Date</th>
<th>n/a</th>
<th>n/a</th>
<th>n/a</th>
<th>n/a</th>
<th>n/a</th>
<th>n/a</th>
<th>Hide</th>
<th>Skp</th>
</tr>
</thead>
<tbody>
<tr>
<td>28/2009 1st Wed</td>
<td>10</td>
<td>18</td>
<td>22</td>
<td>23</td>
<td>28</td>
<td>29</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>28/2009 2nd Sun</td>
<td>23</td>
<td>29</td>
<td>36</td>
<td>42</td>
<td>44</td>
<td>47</td>
<td>07</td>
<td></td>
</tr>
<tr>
<td>28/2009 1st Sun</td>
<td>06</td>
<td>13</td>
<td>14</td>
<td>19</td>
<td>41</td>
<td>42</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>27/2009 2nd Wed</td>
<td>20</td>
<td>23</td>
<td>25</td>
<td>30</td>
<td>33</td>
<td>35</td>
<td>07</td>
<td></td>
</tr>
<tr>
<td>27/2009 1st Wed</td>
<td>08</td>
<td>11</td>
<td>19</td>
<td>26</td>
<td>48</td>
<td>49</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>27/2009 2nd Sun</td>
<td>01</td>
<td>06</td>
<td>12</td>
<td>24</td>
<td>32</td>
<td>41</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>27/2009 1st Sun</td>
<td>02</td>
<td>15</td>
<td>22</td>
<td>29</td>
<td>30</td>
<td>37</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>25/2009 2nd Wed</td>
<td>04</td>
<td>18</td>
<td>26</td>
<td>33</td>
<td>35</td>
<td>47</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>26/2009 1st Wed</td>
<td>05</td>
<td>12</td>
<td>25</td>
<td>31</td>
<td>44</td>
<td>46</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>25/2009 2nd Sun</td>
<td>08</td>
<td>11</td>
<td>18</td>
<td>32</td>
<td>36</td>
<td>38</td>
<td>06</td>
<td></td>
</tr>
<tr>
<td>24/2009 1st Sun</td>
<td>05</td>
<td>06</td>
<td>11</td>
<td>31</td>
<td>40</td>
<td>43</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>
As you can see additional filter condition is defined:

This condition requires that in any of 3 to 5 columns the difference between the last known sum value and the expected sum value is to be at most between -10 to +10. Usually the number of tickets left in the package is higher (in the order of hundreds).

2. Winning Numbers History page offers other supporting tools helping you to determine more accurate filter parameters, e.g. you can evaluate Differences Chart for more accurate ranges of sum differences in each column.

3. You can also reduce the package contents by using functions from History Differences tab.

4. This function can be used for a selected draw(s) in a week only. In the example below the function will process the 2nd Wednesday draws only:

However in this case you must also change all values used in the procedure - sums, tables with history of numbers, charts etc.

5. When using these functions for other lotteries and/or other winning numbers periods, you must realize that the values of sums, ranges, count of the latest draws, number of tickets left in the package etc. will differ from the example provided above! However the function principle does not change and it always provides a small set of tickets containing the Jackpot winning ticket.

Notes:
1. The setting for margins to +/- 10 is recommended only. You can change these values in any way. The wider margins the more tickets are left in the package after filtering.

2. *Min/Max* settings in the rows of *Winning Numbers History* filter need not be identical. Some margins can be left wider and you can omit some margins at all.

3. By checking option *At least "xx" to "yy" columns must pass* you choose the minimum and maximum count of columns that must meet filter conditions. This applies to any combination of columns. The resulting sums (use button *Lookup Min & Max Ranges* to look them up) will not match your original estimated margins but they should be wider. This option is suitable when we expect mistakes in our estimates because the tickets left in the package will still contain the Jackpot winning ticket you are looking for. The larger the difference between "x" and "y" the more tickets will remaining in the package after filtering.

4. The program remembers the last used settings for margins in this filter.

5. Check that your selection of winning numbers matches the one from Winning Numbers History page before filtration and always use *Update Sums* button to refresh the table in filter window.

6. Visit www.expertlotto.com to see a detailed instructional video describing the steps in this chapter.

**Winning Numbers History Page**

This page provides a tool for lottery strategy based on evaluation of the frequency of number occurrences in the lottery history. The reasons for this strategy are given here.

The upper left part of this window contains controls for winning numbers selection, where you can chose a subset of winning numbers database to be processed by the functions in this application page.

The right hand part of the window offers several sub-pages for each *Winning Numbers History* function:

- **Number History** - presents the history of occurrences of individual numbers up to their 11th occurrence back in lottery history. The next draw of winning numbers rearranges data in this table and you can correctly estimate this change using simple mathematical tools. The first column contains numbers from 1 up to the maximum drawn number according to currently selected lottery. Column labeled "0" shows the count of draws to the first occurrence of the number from a given row back in the lottery history. Remaining columns labeled "-1" to "-10" present subsequent repeated number occurrences in the lottery history displayed as the count of draws.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>-1</th>
<th>-2</th>
<th>-3</th>
<th>-4</th>
<th>-5</th>
</tr>
</thead>
</table>

From the table above you can see that number "1" came up just 3 draws ago; its second occurrence is 14 draws ago and the third occurrence of this number is 18 draws ago etc. (measured from the latest record in the winning numbers...
In parenthesis you can see the differences between neighboring columns (e.g. Difference(-5) = Value(-5) - Value(-4)). Option Show allows switching between History and Differences, History only, Differences only and Differences and History values being displayed in the table for better readability. The bottom part of this page shows row labeled Sum, which provides summary values for each column above. These sums then provide input for Summary Table. Detailed description and usage of this page is available here.

- **History Differences** - contains a table of differences for a single column of the Number History table. Each table row represents one possible difference value; each cell in the row then shows a drawn number for the given difference for the selected column. Basically this is an inverted table to the Number History table showing column differences only.

Option History to Show allows selecting the Number History column to be shown. Row headers show the difference value and the count of numbers in the row (in parenthesis), row cells contains all drawn numbers which have the same difference in the given column in the Number History table. According to the example above the difference (difference between column "-1" and "0") for number "4" has the value of 13. Above the table listing individual differences area the following data:

- **Max (-)** = provides the maximum negative difference which could arise should the last six numbers from the table list are drawn.
- **Sim** = provides numerical value of the future difference resulting from the simulated ticket.
- **Max (+)** = provides the maximum possible value of difference which could arise should the numbers in the first 6 positions in the appropriate table are drawn.

The table highlights numbers entered in the edit fields next to Draw Simulation option with a thick black border. The right hand part of this screen contains three segments where you can select conditions for package filtering invoked by Filter button. The button is disabled when the package is empty. Detailed description for these functions is available in a separate chapter for the History Differences page.
The bottom part of the screen contains Simulate button. This button starts random number generator to simulate winning numbers draws. After 100000 simulated draws the red/green progress bar provides the lowest and the highest sum values in selected column and also the median value and the number of steps carried out in simulation. When using this page for the first time these values are labeled as n/a. The progress bar shows the probability percentage of draws leading to decreasing sum value in the coming draw for the selected column.

- **Summary Table** - contains the sums for each columns back in the lottery history. The table displays 200 recent draws. You can change this count using menu Lottery → Preferences → WN History - Number of rows in the Summary Table. The row headers provide the date of the draw. Option Show: allows switching between History only, History and Differences, Difference only, Difference and History and Segments values being displayed in the table. The table data are also displayed graphically in History Chart page.

- **History Charts** - presents the development of sums from the Summary Table as a chart. The option in the upper left part of this screen allows switching between Summary Chart and Differences Chart. Each chart line represents one column from the Summary Table. The chart window appearance can be adjusted. If you drag the range lines of any chart then their new position(s) will be available as default parameter value(s) in Winning Numbers History filter window.

- **Simulation** - here you can simulate the sum development using (randomly) generated tickets or package contents. Table shows columns with sum values, estimates for their expected movement, average sum value after simulation with all the tickets from generator / package, average difference etc.

*Update* button updates the contents of all sub-pages for the selected winning numbers range.

*Print* button prints the contents of currently displayed table.

*Export* button allows exporting the currently displayed table to a file in a text format (CSV) suitable for processing in other applications, e.g. spreadsheet processors.

At the bottom of this screen you can find Draw Simulation option, which allows simulating the coming draw by entering your numbers into edit fields (numbers 1 to 7 are provided as defaults). The entered numbers are highlighted in History Differences table even if the Draw Simulation option is switched off. Turning the Draw Simulation option on recalculates the Number History table to simulate a draw (i.e. as if the entered numbers were drawn as the winning ones). The Sum row is updated as well and its values are added to the end of the Summary Table as a new row labeled Draw Simulation. These new sum values are also displayed in History Charts page.

Checking box Use Package Tickets the tickets are transferred from the to editing windows to package. You can scroll through package via arrows right from the
number informing you about ticket position within the package. If the tickets in the package are tagged due to previous processing such tags are shown in the box "tag". You can also change this tag (insert/cancel tags).

You can also use favorite tickets to enter numbers for the Draw Simulation function.

**Note:** Detailed instructions for simplified use of this function is here.

**Number History**

This algorithm is based on a table of history of drawn numbers. The table does not show frequency of number occurrences from a fixed period of winning numbers draws. Instead it provides information on the last 11 occurrences of each drawn number in the winning numbers database.

<table>
<thead>
<tr>
<th>Number History</th>
<th>History Differences</th>
<th>Summary Table</th>
<th>History Chart</th>
<th>Simulation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show:</strong> History and Differences ▼</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>-1</th>
<th>-2</th>
<th>-3</th>
<th>-4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>14</td>
<td>18</td>
<td>23</td>
<td>32</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>8</td>
<td>21</td>
<td>29</td>
<td>35</td>
</tr>
<tr>
<td>3</td>
<td>22</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>28</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>22</td>
<td>27</td>
<td>29</td>
<td>46</td>
</tr>
</tbody>
</table>

The first column in the table contains drawn numbers. Initially this column is sorted in ascending order from 1 to "XX" where the "XX" is the highest draw number. However you can sort the table by any column by clicking appropriate column header. Differences in the range of 1 to 6 have white background, differences in the range of 7 to 12 have yellow background, orange background indicates differences higher than 12.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>-1</th>
<th>-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>2</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>29</td>
<td>2</td>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>9</td>
<td>11</td>
</tr>
</tbody>
</table>
drawn number. Column Total contains the sum of all values from each table row. You can use this value for example as an auxiliary information (the lowest total means the shortest average interval).

The differences in the range of 1 to 6 have white background, yellow color highlights differences in the range of 7 to 12, orange color indicates differences higher than 12.

Except for column "0" all table cells contain two numbers, one of them in square brackets. Option Show allows displaying Number History together with difference between column values, History only, Differences Only and Difference together with History.

The example above (the second figure) provides information that number 25 was drawn just in the latest draw. The second occurrence of this number back in the lottery history was 5 draws ago. The number in parenthesis is the number of draws between the first and the second occurrences (4 in this example). The third occurrence of this number in the past was 10 draws ago and the difference between the second and third occurrence is 5.

The check box in the first table column allows marking of numbers with high/low difference value, for example after sorting the table by any column. The marks can help to compare the numbers after sorting the table by a different column. The count of marked numbers is available at the bottom table.

Row Sum at the bottom part of the table contains the sums of all values from each column. The values in this row do not change even when you switch the table content using the Show option, this row always contains the sums of Number History values. The data from the Sum row are used as input data for Summary Table and for History Charts.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>-1</th>
<th>-2</th>
<th>-3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>368</td>
<td>746</td>
<td>1202</td>
<td>1646</td>
</tr>
<tr>
<td>Sel</td>
<td>0</td>
<td>368 [0]</td>
<td>746 [0]</td>
<td>1202 [0]</td>
</tr>
</tbody>
</table>

You can highlight one or more table rows which is then recalculated as if the highlighted numbers came up in the next draw. Updates sums and their differences are then available at the bottom table on row labeled Sel.

Use scrollbars to see the complete contents of the table.

**Notes**

- When new winning numbers are drawn then the value in the column "0" will change to "1" for the six drawn numbers. Previous values in these 6 rows are shifted one column to the right, i.e. previous value in column "0" is moved to column ".-1", value from column ".-1" is moved to column ".-2" etc. All other values in column "0" are incremented by 1.
- Values in all other rows are incremented by 1. In case of rows containing the drawn numbers the current value is replaced with the previous value from the column on the left. This recalculation leads to changes in the Sum row in all its
columns. The change of the sum in column labeled "0" is an increment of 49 (when playing a lottery drawing 6 numbers from a pool of 49) reduced by the sum of value in column "0" for all drawn (or simulated) numbers.

- Increase or decrease of \textit{Sum} values in other columns is affected by the shifting of each field in the table.
- Values from the \textit{Sum} row for each draw are used as input data for tables and charts describing the fluctuations of these sums in each column.
- The maximum possible increment in column "0" is 43. It happens only if the new winning numbers are the same as the previous winning numbers. The maximum increment in all other columns is 49.
- The maximum decrement in each column is the sum of differences in the last six rows when the table is sorted by the appropriate column in ascending order.

**History Differences**

History Differences page shows the differences of values in neighboring columns from Number History table. Table cells contain drawn numbers and row headers show the history difference these numbers were assigned at \textit{Number History} table.

Option \textit{History to show} allows selecting \textit{Number History} table column to be displayed in this table. Row headers show the difference value. The cells in each row contain the drawn numbers which have the same difference shown in the row header.

According to the example above the difference (between columns "0" and "-1") for number 20 is 16. Number 20 has a black border, which is used to highlight all numbers currently entered in \textit{Draw Simulation} edit fields. The black border is
displayed even when the *Draw Simulation* option is inactive. When the *Draw Simulation* is active (button is depressed) the table is recalculated as if the entered numbers were actually drawn as the winning ones.
The labels at the top right part of the window show the maximum possible differences for currently selected Number History column. *Max(-)* is the maximum possible difference if the last six numbers of this table will be drawn, *Max(+)* is the maximum possible difference if the first six numbers of this table will be drawn, *Sim* is the difference value if numbers from the simulation edit fields will be drawn.

**Note:** *Selection* of winning numbers to be used is the same as in other parts of the application. However please note that when playing a lottery that draws more then one set of winning numbers on each draw day then this table for *History to Show "0"* looks like follows: the first row of this table is the 2nd draw and the second row in the table is the 1st draw from the same draw day. **This ordering differs from the order of draws in other parts of the application.**

The right hand part of the screen contains three option panels allowing to divide the table rows into three segments for package filtering. The default segment ranges are set so that the first segment ends at 6th table row (inclusive) and the second segment ends at 12th table row (inclusive). You can adjust the segment size using edit fields.

The second segment begins always in the row following the end of the first segment regardless whether this row is empty or not. The third segment begins in the row following the end of the second segment and it ends in the last table row.

Each segment has option *Numbers in ticket*, which defines the minimum and maximum count of numbers from the given segment that a ticket must contain.

Following controls offer information on the lowest (*Min Diff*) and highest (*Max Diff*) possible differences according to current segment sizes and ticket number distribution.

**Note:** You must pay close attention to segment definitions when playing a lottery drawing more winning numbers than you can actually bet (e.g. Expert Lotto Keno demo lottery - 20 numbers are drawn and each bet can contain up to 10 numbers only). Naturally the package cannot be filtered with a requirement that a ticket must contain more than 10 numbers from each segment. In this case all tickets would be filtered out.

Click button *Filter* to start package filtering. The filtering process will leave in the package only tickets passing the filter condition for the history currently selected in option *History to Show*. Evaluation of segment sizes and their contents allows estimating the future sum values more accurately. In the example above (see figure for column "-1") all
combinations of any 6 numbers from the first 8 rows lead to sum increase. Even the sum of differences for numbers from rows 6, 7 and 8 is lower than 49.

Each draw will change the sum in all columns. The change in each column is given by the possible maximum increase (49) reduced by the sum of differences corresponding to the actually drawn numbers. Let’s assume that numbers 2, 15, 18, 22, 24 and 36 will be drawn in the example above. In this case the sum of differences for numbers from rows 6, 7 and 8 is 42. The corresponding difference for number 22 is 6; numbers 2, 15, 18 a 24 have corresponding difference 7 (so the sum is 28) and number 36 has difference 8. In this case the resulting sum will increase by 7. (Try to simulate the draw and check the sums in column”-1” in Draw Simulation row in Summary History table). Thus when we assume that the sum in the first column (“-1”) is to be reduced at least two numbers from the bottom part of the table must be drawn in order to reach the sum of difference higher than 49.

You can use Simulate button in the lower right corner of the screen to estimate the probability that the sum will decrease or increase. This button starts random ticket generator to simulate winning numbers draws. After 100000 simulations the minimum, maximum and median values (note: it is arithmetical approximation, not exact median value) are determined for the currently selected column. Before using the simulation feature these values show the n/a symbol. The progress bar with the probability percentage shows how many simulated draws would lead to the sum reduction in the appropriate column (red color) and how many simulations lead to sum increase (green color). You should use "0" for the minimum and "6" for the maximum counts of numbers in all segments to get feasible simulation results (therefore the segment ranges will be ignored in this case). Otherwise the simulation is affected by the segment settings and only random tickets that pass such a filter will be used for draw simulation. The example above shows that the 32% of random draw simulations would lead to sum decrease.

You can adjust the draw simulation using a requirement for the count of numbers from each segment. Only random draw simulations passing your requirement are accepted then. For example a requirement for at least one number from segment 3 (Min=1) means that all draw simulation tickets containing only numbers from segments 1 and/or 2 are excluded from simulation.

Usually the actual winning numbers are scattered over all segments. It is not very frequent that four or more drawn numbers belong to one row only in any segment (applies for each number history column). Therefore another function can be used to remove tickets containing a given set of numbers.
Clicking the first table row selects the following numbers 7, 16, 23, 27, 29, 34, 42. These numbers are highlighted in the table header in the Visual Package page:

Then you can remove tickets containing 4, 5, and 6 numbers from the set defined in the table header using the function **Remove Match in**:

You can select more than one row in the History Difference tables for the function described above. Use Shift key for continuous selection and Ctrl key for non-continuous selection. In the following example tickets containing 4, 5, and 6 numbers form the end of the table presented in the figure above are removed from the package:

Transferred to page **Visual Package**:
Then using option:

The background of table cells can have different colors. The colors are transferred automatically from Winning Numbers page when Panel Coloring function is activated.

**Note:** To avoid distorted values in this and other Winning Numbers History tables (i.e. incomplete) you should be using either the All Draws option or Latest "xx" option, where "xx" is the highest value in column "-10" in Number History table.

**Summary Table**

This table lists *Sum* rows from Number History table for all draws from the selected range of lottery history. Each table cell contains two numbers - the first number is the sum value, number in square bracket is the difference between the given sum value and the sum value from previous draw. Use option *Show* to display sum values only, differences only or sum values and differences together. Switching to *Show Differences only* makes the table more readable and you can better review the intervals for differences in each column. The last two columns show the standard deviation of sum differences and which sum values are odd (O) and which are even (E).

You can also choose *Segments* in option *Show*. The table will then display the distribution of drawn numbers into History differences segments. The segment ranges are fixed. The first segment end at 6th row (inclusive) of the History differences table, the second segment ends at 12th row (inclusive). For example value 3-2-1 means that three drawn numbers belong to the first segment, two numbers are from the second segment and one number is from the last segment.

The values from this table are used as input for Sum Chart and Differences Chart. These charts provide another visual aid helping you to estimate how the differences shall move in the coming draw in the Winning Numbers History table.

When option *Draw Simulation* is on and the ticket edit fields contain valid numbers the table shows values for this simulation as well. This tool will then tell you how the sum values would look like if any six given numbers were drawn in the next draw. The last row is then labeled *Draw Simulation* and its values are recalculated automatically when a new number is entered into any edit field. This is especially useful when you have a fixed set of five numbers and you are searching for a suitable sixth number.
When option *Use Package Tickets* is checked then the simulation fields will automatically load the first ticket from the package. Use scroll button to move to other tickets in the package.

The future values of sums and differences can be predicted automatically by comparing the latest values with previous values. Button *Predictions* opens a new window where it is possible to select which values should be predicted and eventually enter additional input parameters for the prediction process. After calculating the predictions a new row with predicted values will appear in the table. Up arrow and down arrow icons indicate the predicted direction of value change - increase or decrease - and tooltip help contains information about prediction credibility. Predicted values are also available in charts.

**History Charts**

This page shows data from Summary Table as a chart. Option *Show* allows switching between *Summary Charts* and *Differences Charts*.

**Summary Charts**

Each column from the Sum History Table is presented as one line in the chart. The description of common chart window functions is available here. *Options* button brings up Chart Options window where you can adjust the chart appearance:
The list in the upper left part of the window allows selecting the history columns to be displayed in the chart. Only checked columns are displayed:

- Check the appropriate checkbox to show or hide any chart line (history sum column).

When the *Draw Simulation* is on then the last point in the chart presents values for this simulation. Place your mouse cursor above any chart point to see a brief description of the draw date, column name and current value. The chart values remain unchanged until you press *Update* button again which recalculates the chart values and it also resets all adjustments of the chart window.

You can reposition adjustable margins by drag & drop operation using mouse. These adjustments are transferred directly to control *Winning Numbers History* filter window.

**Differences Charts**

This chart provides a visual aid for estimation of "direction" as well as absolute value of expected change of sum in the Summary Table.
The chart always shows the "zero" ("0") value. Bar chart display applies in the example above. The last chart line in Chart Options window is Standard Deviation column from Summary Table. Chart in example above shows differences for the first four columns and the standard deviations at the same time. You can choose color for displayed columns in Chart Options window. Due to resolution blue color has been set for standard deviation column.

Options button works the same way as in the case of Summary Charts.

The figure above shows an example of usage of the differences chart:
• all 11 columns are displayed (from column "0" to ",-10")
• bar chart style is selected
• the range finder tool is set +/- 7 values

As you can see from the figure above there are two history differences values within the selected range of +/-7, 9 values are outside this range and 3 of these 11 differences values are negative (columns labeled ",-2", ",-3" and ",-8"). It means that numbers from the bottom part of the History Differences table are preferred in columns 2, 3 and 8.

For example you can estimate the probability that the differences in 4 to 8 columns will be in the range of -10 to +10 in the next draw.

Another possible use of this chart is evaluation how big the difference will be in the next draw in each column. The following figure presents an example for column ",-5".

From the picture above you can see that the differences values in column ",-5" are outside the +5/-3 range during the last 7 draws. Therefore you can expect that the next difference will be within this range.

Usage

Using these charts you can more accurately estimate how the sums in Summary Table will change in the next draw. You can also estimate how many differences will be positive and how many will be negative as well as their size. Using the replaceable margins (range tools) in Summary Charts and in Differences Chart you can use the values shown below the chart directly in appropriate filter - Winning Numbers History.
All these projections provide more accurate input parameters for Winning Number History filter.

Simulation Table

This function is used for "large-scale" simulation of Winning Numbers History values.

Controls Description

- **Simulation Tickets** - click button > to select whether the tickets for draw simulations will come from Ticket Generator or from the Package. Generator option brings up Ticket Generator window where you can choose the range of numbers and the number of tickets to be used for draw simulation. Please note that in this case you should not be using Maximum overlap option when generating random tickets for the simulation. The Generator may get stuck while trying to find tickets that fit your overlap settings and the draw simulation would never finish. A possible workaround is to generate such tickets into the Package first (press Cancel button when Generator's progress indicator stops moving) and then select option Package in the Simulation tab. Package option will use the current contents of the package for draw simulation. This option is disabled when the package is empty.
- **Simulation Filter** - you can choose any filter or combination of filters to be applied to tickets (either package tickets or generated ones) before they are passed to the draw simulator. Only tickets that pass filter's condition will then affect the simulation statistics. This way you can verify how various filters affect the winning numbers history values.
- **Start Simulation** - click this button to start draw simulation

Results Table

- Column - shows Winning History Number column names
- Sum - contains WN History sums calculated for the current winning numbers selection at the left-hand part of the screen. Simulation column relates to these values
- Simulation - shows whether most simulated draws led to sum Decrease or sum Increase (compared with sum values from column Sum). Value "same" means that exactly half of the simulated draws caused sum increase and the other half caused sum decrease.
- [%] - percentage value of how many simulations led to increase/decrease. For example "Increase - 71%" means that 71% of simulated draws caused sum increase in the particular history column, likewise "Decrease - 56%" means that 56% of simulated draws lead to decreasing sum and 44% lead to sum increase.
- Med* - median sum value calculated from all simulated draws. Note: It is an arithmetical approximation, not exact median value.
- Diff - an average sum difference value calculated from all simulated draws
- Diff StdDev - standard deviation for sum differences from all simulated draws
- Min - the minimum value of sum obtained from all simulations
- Max - the maximum value of sum obtained from all simulations
Winning Numbers History

- Chart/Sum/Min, Chart/Sum/Max, Chart/Diff/Min, Chart/Diff/Max - if you move any drag-able range line within Sum Charts or within Differences Chart then their numerical values appear in these fields. These fields will change their background color if the simulation Avg sum values are outside these ranges (see Tolerances below).

- Notes - you can enter your comments or notes here

- **Standard Deviation** - shows the standard deviation for all values given in column Diffs

- **Tolerance** - you can provide allowed error margins for comparing the median values of draw simulations with your chart estimates. Cells in Chart/xxx/yyy columns will have red background when:
  
  - bottom range value from the chart minus tolerance is higher than the appropriate median sum in the simulation table (your estimated range is above the computed median value)
  
  - upper range value plus tolerance is lower than the appropriate median sum in the simulation table (your estimated range is below the computed median value)

**Note**: This tool does not predict any data. It just provides probability of history sum increase or decrease based on statistics from draw simulations.
Lotteries

Expert Lotto is completely universal and so you can play any numerical lottery. After installation you can choose from the following three lotteries, which are included in the distribution package:

- **Expert Lotto 6/49** - two sets of 6 regular and 1 bonus numbers are drawn twice a week.
- **Expert Lotto Keno** - 20 winning numbers are drawn daily from a pool of 80 numbers. You can select 1 to 10 numbers in a single bet.
- **Expert Lotto Powerball** - the lottery draws 7 main numbers from a pool of 35 and one bonus (powerball) number from a separate pool of 5 numbers. You must match 7 main numbers and the powerball to win the jackpot.

The lotteries above are used to demonstrate application features only, you cannot bet on these lotteries and you cannot print to playslips.

You can download real-world lotteries from www.expertlotto.com for free. Our growing list offers lotteries from around the world. Just copy the downloaded lottery file (pack) into the *data* folder in your installation directory) and after restart the lottery will be included in the list of installed lotteries in the Lottery menu.

You can also use the Lottery Wizard and setup your lottery yourself, including playslip printing.

**Lottery Manager**

*Menu: Lottery ➔ Manager*

Manager of installed lotteries. Using this function you can setup new lotteries, modify existing lotteries or surf to the Expert Lotto web site to download additional lotteries. Here you can also define playslip layout and dimensions for playslip printing.

**Controls Description**

- **Available lotteries** - list of all installed lotteries. The default lottery in the list is the lottery you are currently working with. Select a lottery from the list to update the rest of the controls in this window.
- **Description** - a brief description of the selected lottery, size of the drawing pool, winning number combinations etc.
- **Origin** - country or state where the lottery is operated.
- **URL** - a link to the official lottery web site where you can find the latest winning numbers.
- **Author** - the author of the selected lottery.
• **In folder** - a folder where all lottery related files are stored in. Delete this folder to uninstall the lottery, it will not appear in the list of installed lotteries anymore after application restart.

• **Switch Lottery** - the button is active only when you select other lottery than the current one. Clicking this button will restart the application so that you can start playing the selected lottery.

• **New Lottery** - starts the Lottery Wizard, where you can create and then play a new lottery which is not in the list.

• **Edit Settings** - starts the Lottery Wizard, where you can change lottery settings, edit some default lottery labels (e.g. prize labels) and also modify playslip-printing settings.

• **Backup** - creates a backup file for the winning numbers database and settings of the selected lottery. To restore a lottery you have to only copy the backup file to ‘data’ folder in application's install folder. Invoking this function first brings up a standard file chooser window where you can browse the backup folder and enter backup file name.

• **Restore / Install** - installs lotteries downloaded manually or lotteries backed up by the Backup button. Clicking the button opens standard window for file selection where you browse the saved lottery file.

• **Delete** - after confirmation removes the selected lottery from application's install folder. The lottery will not be included in the list of available lotteries in menu **Lottery**.

  **Attention:** Removing a lottery also deletes all wheels and other files stored in lottery's folder!

• **Download More** - the application connects to server www.expertlotto.com and attempts to download a list of new lotteries that you can install. Internet connection is required to use this feature.

• **Close** - closes this window.

---

**Lottery Wizard**

You can use this feature to setup a new Expert Lotto lottery or to change settings of an existing lottery. The function is available from the Lottery Manager window.

You only have to answer a few questions prompted by the wizard to create a new lottery, e.g. how many numbers are drawn, what is the size of the drawing pool etc. Using the wizard you can also enter playslip layout and dimensions so that you can print your tickets directly on lottery's official playslips.

The **Lottery Wizard** consists of several step. Use the Next button to move to wizard's next question, use the Back button to return to wizard's previous step. The Help button shows a detailed context help for the current wizard step. The Cancel closes the wizard window.

When creating a new lottery the first step is to enter lottery name and a brief description, when updating an existing lottery the first step is a selection of type of settings you wish to change.
Win Tests

Package Win Test

*Menu:* Win Test → Package

This function allows to test:

- The winnings that the package could obtain in comparison with a given or random ticket. Usually the Jackpot value is known beforehand and you can estimate the future winnings in lower ranks.
- The actual financial winnings of tickets in the package when the winning sums are already known.

**Controls Description**

- **Edit fields** - enter the winning numbers you wish to use for the win test from keyboard. Use the TAB key to move focus to the next field when entering one-digit numbers. The input focus moves automatically when entering two-digit numbers. Red background in any edit field indicates a duplicate or out of range number.
  
  You can also use the favorite tickets function to insert winning numbers.

- **Test** - calculates the winning of the tickets in the package as if the numbers in edit fields were drawn. The results are listed in the list of prices.

- **Random Ticket** - fills the edit fields with random numbers. Use the Test button to calculate the package winnings for these numbers.

- **Prize** - shows the prize break-down as defined in *Lottery Settings*

- **Count** - updated automatically after clicking button Test.

- **Win $** - click any field in this column to enter the actual or estimated winnings for the given prize rank.

- **Total $** - updates automatically after clicking button Test. Shows the total winnings for the given prize rank.

- **Cost per ticket** - click field in Win $ column to enter how much it costs to play one ticket. The field in Total $ column then shows how much it costs to play all tickets in the package.

- **Win Total** - the sum of all winnings for all tickets in the package.

- **Balance** - the sum of all winnings for all tickets in the package after subtracting the bet costs.

- **Close** - closes this window.

**Usage**

You can use this function to simulate a draw and check the winning of the tickets in the package.

**Random Win Test**

*Menu:* Win Test → Random
Use this function to find out the winnings of your package by simulating a given number of draws of randomly generated numbers or to find out how many random draws are needed to reach a given number of winnings.

**Controls Description**

- **reaching number of tests** - use this option to test the tickets in the package with a given number of random tickets. Enter the number of tests to be carried out into the edit field.
- **reaching these results** - enter the required number of winnings for any prize(s). After clicking the Test button the application keeps simulating the draws using random numbers until the given number of winnings will have been reached (in the example above until winning at least one third prize). The test results also include all lower prizes winnings.
- **Test results** - shows the number of tests carried out and the list of winnings for each prize.
- **Test** - starts the testing.
- **Close** - closes this window.

**Usage**

You can use this function to test the tickets in the package and to find out the probability of winning of a given prize(s).

**Winning Numbers Win Test**

*Menu: Win Test → Winning Numbers*

The function allows to find out the winnings of given numbers throughout the lottery history.
Controls Description

- **Edit fields** - enter the ticket numbers you wish to test. You can click the button to bring up a list of favorite tickets.
- **Random Ticket** - inserts random numbers into the edit fields.
- **Test** - click this button to lookup the winnings for the numbers entered in the edit fields.
- **Results** - this column shows the number of winnings of the given prize throughout the lottery history.
- **Latest Draw** - this column shows the latest draw date of winning of the given prize.
- **Close** - closes this window.

Win Coverage

**Menu**: Win Test → Win Coverage

Using this feature you can find the minimum win guarantee for tickets in the package when you hit a given count of numbers. The feature is also available from the window of the Minimizer filter.

Controls Description

- The top-most part of the window shows the count of unique numbers found in the tickets in the package.
- The second line of the window allows setting the number of hits which the coverage will be calculated for.
- **Show** - updates the coverage table for the given count of hits. This operation may take a while if the package contains a lot of unique numbers.
- **Coverage Table** - shows the probability of winning of the given "Match X" prizes. Clicking any column's header sorts the table in ascending or descending order. See below for table description and interpretation.
- **Print** - prints table contents.
- **Export** - saves table contents to a text file (in CSV format) that you can import into any spreadsheet processor.
- **Close** - closes this window.

Example [Expert Lotto 6/49]:

The following figure show Coverage Table for 100 random tickets generated from numbers 1 to 15 for the assumption that we will hit any three numbers from the wheel
(i.e. three numbers from the range 1 to 15).

The Coverage Table should be interpreted as follows:

- The first table row shows that the probability the wheel will not win anything is 0.879%. That means the wheel does not cover four triplets out of 455 triplets from 15 numbers.
- In the second table row we can see that we can win exactly one Match 3 prize with the probability of 6.374%. This situation will happen if the winning numbers will contain one of 29 triplets out of 455 possible triplets.
- The third table row shows we can get two Match 3 prizes with the probability of 14.286%. It's also clear that we can have two Match 3 prizes OR one Match 3 prize OR no win with the probability of 21.538%.
- We can also see that the probability of three Match 3 prizes is 16.044% and that the probability of three Match 3 prizes OR two Match 3 prizes OR one Match 3 prize OR no prize is 37.582%.
- The last table row shows that if the winning numbers will contain one of three triplets out of 455 possible triplets we will achieve 12 Match 3 prizes and it will happen with the probability of 0.659%.

<table>
<thead>
<tr>
<th>Match 6</th>
<th>Match 5</th>
<th>Match 4</th>
<th>Match 3</th>
<th>Coverage [%]</th>
<th>Totals [%]</th>
<th>Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.879%</td>
<td>0.879%</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8.374%</td>
<td>7.253%</td>
<td>29</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>14.286%</td>
<td>21.538%</td>
<td>65</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>18.044%</td>
<td>37.582%</td>
<td>73</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>10.923%</td>
<td>54.505%</td>
<td>77</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>14.725%</td>
<td>69.231%</td>
<td>67</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>13.407%</td>
<td>82.637%</td>
<td>61</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>3.451%</td>
<td>92.068%</td>
<td>43</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>5.275%</td>
<td>97.363%</td>
<td>24</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>9</td>
<td>1.538%</td>
<td>98.001%</td>
<td>7</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0.220%</td>
<td>99.780%</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>11</td>
<td>0.220%</td>
<td>99.780%</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>12</td>
<td>0.659%</td>
<td>100.000%</td>
<td>3</td>
</tr>
</tbody>
</table>
The following table shows the coverage of the same wheel of 100 random tickets for the assumption that we will manage to hit six numbers from the wheel.

<table>
<thead>
<tr>
<th>Match 6</th>
<th>Match 5</th>
<th>Match 4</th>
<th>Match 3</th>
<th>Coverage [%]</th>
<th>Totals [%]</th>
<th>Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>3</td>
<td>31.44</td>
<td>0.120%</td>
<td>0.120%</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>4</td>
<td>29.44</td>
<td>0.360%</td>
<td>0.480%</td>
<td>10</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>5</td>
<td>29.43</td>
<td>0.939%</td>
<td>1.419%</td>
<td>47</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>6</td>
<td>28.47</td>
<td>1.578%</td>
<td>2.007%</td>
<td>70</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>7</td>
<td>24.46</td>
<td>2.557%</td>
<td>5.554%</td>
<td>128</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8</td>
<td>26.47</td>
<td>3.017%</td>
<td>5.571%</td>
<td>151</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>9</td>
<td>23.47</td>
<td>4.116%</td>
<td>12.607%</td>
<td>206</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>10</td>
<td>21.50</td>
<td>4.436%</td>
<td>17.123%</td>
<td>222</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>11</td>
<td>23.45</td>
<td>4.176%</td>
<td>21.299%</td>
<td>209</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>12</td>
<td>22.46</td>
<td>3.536%</td>
<td>24.835%</td>
<td>177</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>13</td>
<td>20.43</td>
<td>2.857%</td>
<td>27.892%</td>
<td>143</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>14</td>
<td>22.43</td>
<td>2.379%</td>
<td>30.079%</td>
<td>119</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>15</td>
<td>23.42</td>
<td>1.678%</td>
<td>31.748%</td>
<td>84</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>16</td>
<td>25.44</td>
<td>1.059%</td>
<td>32.807%</td>
<td>53</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>17</td>
<td>23.39</td>
<td>0.839%</td>
<td>33.746%</td>
<td>47</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>18</td>
<td>26.35</td>
<td>0.260%</td>
<td>34.006%</td>
<td>13</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>19</td>
<td>28.36</td>
<td>0.200%</td>
<td>34.206%</td>
<td>10</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>20</td>
<td>33</td>
<td>0.200%</td>
<td>34.226%</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>21</td>
<td>25.33</td>
<td>0.100%</td>
<td>34.526%</td>
<td>5</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>22</td>
<td>21</td>
<td>0.200%</td>
<td>34.346%</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>23</td>
<td>30</td>
<td>0.200%</td>
<td>34.366%</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>2-4</td>
<td>20-61</td>
<td>34.885%</td>
<td>69.251%</td>
<td>1746</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>2-21</td>
<td>18-52</td>
<td>18.901%</td>
<td>38.152%</td>
<td>986</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>3-22</td>
<td>21-45</td>
<td>7.353%</td>
<td>95.504%</td>
<td>368</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>5-19</td>
<td>21-43</td>
<td>1.916%</td>
<td>97.423%</td>
<td>96</td>
</tr>
<tr>
<td>0</td>
<td>5</td>
<td>6-13</td>
<td>22-41</td>
<td>0.420%</td>
<td>97.842%</td>
<td>21</td>
</tr>
<tr>
<td>0</td>
<td>6</td>
<td>4-14</td>
<td>26-39</td>
<td>0.120%</td>
<td>97.962%</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>7</td>
<td>8-10</td>
<td>29-33</td>
<td>0.060%</td>
<td>98.022%</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>0.4</td>
<td>4-13</td>
<td>22-47</td>
<td>1.958%</td>
<td>99.980%</td>
<td>98</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>12</td>
<td>24</td>
<td>0.020%</td>
<td>100.000%</td>
<td>1</td>
</tr>
</tbody>
</table>

- From the first table row we can see that when hitting six of the wheel numbers the minimum win guarantee is at least three Match 4 prizes AND 31 to 44 Match 3 prizes and that it will happen with the probability of 0.12% (six particular combinations out of 5005 possible combinations will be drawn).
- The ninth row from the bottom of the table shows that with the probability of 34.885% we can win one Match 5 prize AND 2 to 21 Match 4 prizes AND 20 to 51 Match 3 prizes. At the same time, with the probability of 69.251% we can win all prizes from this row OR prizes from the rows above.
- From the last table row we can see that we will have two Jackpots with the probability of 0.02%. That means that the wheel contains two equal tickets (tickets with exactly the same numbers).
Win Coverage of Custom Combinations

*Menu: Win Test → Custom Combinations*

Using this feature you can find out what percentage of combinations from given file is covered by the tickets in the package. This feature is also available from Custom Combinations filter window.

The calculation of custom combinations coverage is similar to Win Coverage function. The only exception is that the coverage is not calculated for the complete list of all combinations possible from the given range of numbers but only for user-picked list of combinations stored in a file. For example if you maintain a list of triplets that appear very frequently in lottery's history, then using this function you can find out very easily what portion of these high performing triplets is covered by the tickets in the package.

Invoking this function will first bring up a standard window to browse a file containing the combinations for which you wish to calculate the coverage. When calculating the coverage of triplets or quads, the tickets must contain dummy numbers. The file is checked that all tickets contain the same count of numbers (i.e. the file contains only triplets or only quads etc) and the total number of combinations and the file name are then displayed at the top of the window.

The table at the bottom of the window shows the coverage of custom combinations.

**Controls Description**

- The top part of the window shows the name of the file of custom combinations. The number of combinations and the size of combinations (i.e. whether they are triplets, quads, pentads etc) are also available.

  - **Coverage Table** - shows how many custom combinations from the selected file are covered by the tickets in the package. Clicking any column header sorts the table in ascending or descending order. The table interpretation is the same as for the Win Coverage feature.

- **Print** - prints the table contents.

- **Export** - saves the contents of the table to a text file (CSV format) that you can load into any spreadsheet processor.

- **Close** - closes this window.
Application Preferences

Choose Preferences item in Lottery menu to change some of application settings. The settings description is available in separate topics of these help pages.

General Preferences

Menu: Lottery ➔ Preferences

- **Look & Feel** - changes the style of buttons, tables etc. The default settings imitate the look and feel of your operating system (e.g. MS Windows).
- **Maximum Package Backup Count** - select the maximum number of Undo steps.
- **Print Table Scale** - choose the scale for all table printouts.
- **Show Print Options window when printing tables** - Print Options window will pop up each time you press a Print button to print the contents of any table. You can change the default printing scale and header in this window.
- **Show Available Memory Meter** - displays information on the available free memory Expert Lotto can use at the bottom right corner of the main application window.
- **Reset Dialog Settings** - Expert Lotto "remembers" your settings in some application windows, e.g. your last used parameters in filter windows. This button allows to reset remembered settings and restore the default application state.

Note: These settings apply to currently selected lottery only.

Files & Folders Preferences

Menu: Lottery ➔ Preferences

- **Temp Directory** - select the folder where Expert Lotto application will store its temporary files (the package contents, backup files etc). All temporary files are removed when the application exits. When working in a network environment you should select a folder on a local disk to speed the application up. Clicking button will bring up a standard window where you can browse for the folder. **Attention:** Changing temporary folder name will preserve the current package contents however all package backups will be deleted.
- **Winning Numbers Database Location** - allows changing the default file name for winning numbers database. Clicking button will bring up a standard window where you can select a new file name. Then the application will save the current contents of the winning numbers database into the selected file and from now on the winning numbers will be loaded from the new file.
• **CSV File Separator** - you can change the default field separator for text (CSV) files the application creates when exporting statistics and tables to a file. For example when you choose a comma ",” as a field separator (default setting) the export files will look like this:

```
1,2,3,4,5,6
11,12,13,14,15,16
```

When you choose e.g. semicolon ";" as a field separator the export files will look like this:

```
1;2;3;4;5;6
11;12;13;14;15;16
```

**Note:** These settings apply to currently selected lottery only.

### Plugin Preferences

**Menu:** Lottery ➔ Preferences

This page shows a list of installed plugins. Select any plugin in the list to see its Version and a brief Description.

Button **Download More** connects the application to server www.expertlotto.com and downloads and installs new or updated applications plugins.

**Note:** Some plugins are active for a particular lottery only (e.g. plugins for online winning numbers update). Expert Lotto user interface will offer the functions of such plugins only when a specific lottery is currently selected from the list of available lotteries.

### Internet Connection Preferences

**Menu:** Lottery ➔ Preferences

If you use a proxy server when connecting to Internet select Use proxy option and enter proxy server host and port. If your proxy server requires authentication enter also your username and password. These settings are used for online update of winning numbers databases and for download of application updates.

**Note:** These settings apply to all lotteries.

### Winning Numbers History Preferences

**Menu:** Lottery ➔ Preferences

- **Number of rows in the Summary Table** - allows changing the default number of draws the Summary Table displays.
• **Number of random simulation steps** - allows changing the number of random draw simulations for the *Simulate* function in the History Differences page.

• **Default Size for Segment 1,2** - these options adjust the sizes of WN History segments (number of rows in the *Differences table*).

**Note:** These settings apply to currently selected lottery only.
How To

Example 1 - illustrates the use of Ticket Generator and some basic package operations. In this example you get to know how many number need to be guessed correctly to have at least the cost of your bet returned.

Example 2 - explains Dummy Numbers feature and how to use it.

Example 3 - shows how to optimize the package by comparing tickets with winning numbers history.

Example 4 - describes the use of the Winning Numbers History function and how to find a ticket guaranteed to win the jackpot when the tendencies of several chart lines are correctly estimated!

Example 5 - shows Panel Coloring feature.

Example 6 - explains how to use Best Tickets strategy

Please familiarize yourself also with:

- some general recommendations, which can help you to use Expert Lotto more effectively
- brief description of the most often used functions
- explanations of some terms used in this help

Example 1

This example applies for Expert Lotto 6/49 demo lottery.

The following definitions will be made:

Let A1 and A2 be two sets of numbers, such that:

A1 = 16,17,19,20,33,40,48,49,32

and A2 = 13,18,35,38,39,26

Also:
None of the tickets will contain all six draws taken from one set of numbers only (A1 or A2).
Triplets of successive numbers are to be excluded.
The majority of all the possible triplets should be considered (15 numbers can give rise to 455 possible triplets).

Tickets following the above rules can be drawn by:

a) Randomly generating tickets from a pool of 15 number, allowing for a maximum overlap in 3 numbers, which can then be swapped for the desired numbers from A1 and A2.

and/or


**Part a):**

Approximately 32 tickets will cover about 90% of all triplets from 15 numbers, with a maximum allowed overlap in 3 numbers. Thus, taking the following steps:

- Select Generator from the Package menu.
- Enter 30 in the field *Tickets to generate*, and select *Tickets numbers range to be from 1 to 15*. Select the *Generate tickets with random numbers* option and select *Maximum Overlap* to be 3. Swap generated numbers (1 to 15) for the numbers in A1 and A2, by selecting Swap Numbers from the package drop down menu. Save the package contents to a file named, say *model1a*.
- Return to the *Generator* and select the *Generate maximum possible number of tickets* option to generate tickets for all number combinations (5005 tickets) from the proposed 15 numbers. Save the contents of the resultant package to a file named *template15*.
- Using the *Generator* again, select the boxes 4, 5 and 6 in the *Dummy numbers* list (and ensure that the option for *Generate maximum possible number of tickets* is still selected), thus ensuring tickets will cover all possible triplets (455 tickets). Save them to file named *trips15*.
- In the *Generator*, now select boxes 5 and 6 in the *Dummy numbers* list and create tickets covering all possible quads (1365 tickets). Save them to a file named, say *quads15*.

**Note:** These 4 files will be used for testing how many triplets (or quads) are to be covered by your bet.

- Load the file *model1a* back into the package and use the Successive Numbers filter to remove triplets of successive numbers (if any).
- Switch to the Visual Package page, and click on the numbers from set A1 (or A2) in the table header. Select boxes &rsquo;0’ and &rsquo;6’ next to the *Remove Match in* button and click on this button. This way a modified set of tickets will be produced which contains at least 1 and at most 5 numbers from A1 (or A2). Other box selections can be made to produce different number combinations. Save the results back into the file named *model1a*. 
• Now load the template15 file back into the package. Using the Match Tickets in a File function remove from the file template15 all tickets that match tickets in the model1a file in 4, 5 and 6 numbers.
• Again filter out triplets of successive numbers and also remove tickets with numbers in either of the sets A1 or A2 from the remainder of the package (Visual Package).
• Apply the Shuffle function (from the Package menu) on the tickets remaining in the package, and then use Match Tickets in the Package to remove tickets matching in 4, 5 and 6 numbers. The contents of the package will be reduced to the non-matching tickets.
• Save the rest of the package to the model1a file with the Append to the end of the file option on.

This procedure should be repeated until the package is empty.

Part b):

• Use the Generator to insert tickets for all possible number combinations (drawn from the full pool of 49) into the package.
• Use the Successive numbers filter to remove triplets of successive numbers.
• Switch to the Visual Package page.
• Click numbers from the set A1 (or A2) in the table header. Select boxes '0' and '6' next to the Remove Match in button and click on this button. This way a modified set of tickets is obtained with at least 1 and at most 5 numbers from the set A1 (or A2). Again, alternative selections of checkboxes can be made for differing number combinations.
• Apply the Shuffle function (from the Package menu) on the rest of the tickets in the package and then use the Match Tickets in the Package filter to remove tickets matching in 4, 5 and 6 numbers. The contents of the package will be reduced to the non-matching tickets.
• Save the tickets remaining in the package to a file named, say model1b.
• Load the template15 file into the package again.
• Apply the Match Tickets in a File filter to compare the package with the model1b file and remove tickets matching in 4, 5 and 6 numbers.
• Repeat the Visual Package page procedure and remove from the package tickets matching set A1 (or A2) in the '0' and '6' number positions.
• Shuffle those that remain in the package, and then apply the Match Tickets in a Package filter once more to remove tickets matching in 4, 5 and 6 numbers.
• Append the rest of the tickets in the package to the end of the model1b file.
• Load the template15 file into the package and repeat the procedure as long as any tickets remain in the package.

The following procedure checks the coverage of triplets and/or quads by your bet either in the model1a file or in the model1b file.

Load either the model1a or the model1b file into the package and use the Match Tickets in a File filter to compare it with the trips15 and quads15 files. Make sure that the Tag matching tickets option is selected before using the filter. When the filter is finished load the file you compared with (trips15 or quads15) into the package and
use the Tagged Tickets -> Leave (Remove) function to find out how many tickets are covered by your bet. Usually the bet containing 32 tickets should cover about 95% of all possible triplets and about 45-50% of all possible quads. You can conclude that guessing 4 numbers means about 90% guarantee of winning a 4th prize together with several 5th prizes.

You should be able to easily setup similar procedures depending on your required win guarantees.

Example 2

This example explains Dummy Numbers feature. You can use the dummy numbers (sometimes also masked numbers) in several application screens:

Generator

The dummy numbers in the Ticket Generator allow replacing (masking) of one or more ticket number positions with a dummy number. It is particularly useful for creation of all possible pairs, triplets, quads and pentads for a chosen range of numbers.

Example: In Expert Lotto 6/49 lottery (a demo lottery drawing 6 numbers from the pool of 49 numbers) chose Generator function to create tickets from 20 numbers while checking option Generate the maximum possible number of tickets. The generator will offer to create 38760 tickets with six numbers (full package). Click position 6 in Dummy Numbers list; now the generator offers to create 15504 tickets. When selecting also position 5 in the list the value in Tickets to generate field changes to 4845. When three positions are selected (6, 5 and 4) the value in the Tickets to generate field changes to 1140 possible triplets from 20 numbers. It means that the generator will create 1140 triplets that are inserted into the package as regular tickets where the last three positions are replaced with dummy numbers 97, 98 and 99. See also Example 1.

Only positions checked in the Dummy Numbers list are replaced with corresponding dummy numbers. The dummy numbers are assigned as follows: 94 replaces the 1st position, 95 replaces the 2nd position, 96 replaces the 3rd position, 97 replaces the 4th position, 98 replaces the 5th position and 99 replaces the 6th position. Dummy Numbers menu function allows using dummy numbers for tickets already created in the package. In both cases the appropriate ticket number position(s) is masked. Dummy numbers are also visible in ticket panel where checkmarks are placed in dummy number boxes at the bottom of the panel. When working with tickets in the package the asterisk sign (*) indicates that currently selected ticket contains dummy numbers.
Number Swapping

Swap Numbers function allows replacing one or more ticket numbers with a dummy number.

**Example:** Select *Expert Lotto 6/49* lottery and generate 100 random tickets into the package for the whole range of drawn numbers (49). Select *Swap Numbers* function from the Package menu.

Write down one of the tickets in package and use Swap Numbers function to replace the first number of this ticket (let's assume it's number 23) with dummy number 94. First click on the box of the number being replaced, i.e. 23 then click on the box of the number you wish to use for replacement i.e. 94. Then click OK button. The application will replace number 23 in all tickets with number 94. The dummy number 94 is placed in the first ticket number position and the rest of the numbers are resorted in ascending order.

Replace the remaining numbers of the ticket you wrote down using the *Swap Numbers* function. The dummy numbers already used (active dummy numbers) are displayed using blue color in the panel (inactive dummy numbers are gray). The numbers are replaced in this ticket and also in all other tickets containing the numbers being swapped. *Swap Numbers* function allows swapping all 6 ticket numbers for a dummy number.

The dummy numbers can be replaced with regular numbers later on, e.g. with hot numbers. Tickets with dummy numbers can be processed by other application functions without any restrictions.
The application does not allow to swap two different numbers for the same dummy or regular number. In such a case you will get an error message. Please note that when the replacement dummy number already exists in a ticket then the closest higher dummy number will be used instead to replace the number being swapped.

The dummy numbers are included in statistics.

You can also swap ticket numbers for dummy numbers in a single ticket in Package page either by using edit fields or using the ticket panel together with Add and/or Set buttons.

Example 3

How to apply filters using Winning Numbers table from Statistics

Let's say we want to estimate the next winning numbers for Expert Lotto 6/49 demo lottery and let's have the list of all possible combinations as our starting point. When working with filters it is handy to have an overview how the filters performed in lottery history - Statistics ➔ Winning Numbers table and chart offer such an overview for most of the filters. These tools allow estimating filter parameters for package filtering.

1. Generate all possible combinations into the package.
2. Switch to Statistics page, check Winning Numbers option and click Calculate Stats button.
3. Select Winning Numbers in Show Stats for option.
4. Go to Winning Numbers Charts tab and select Sum Root option by clicking Options button. Now you can estimate the next expected value. Write your estimated value down. Use Options button again to hide Sum Root and display Sum chart instead. Use mouse to drag both black range lines to set your Sum estimate. Click Filter button to open the appropriate filter window. Enter the required values for Sum Root, check settings for lower and upper sum range, check Remove/Leave option and filter tickets in the package. Estimating Low/High ratio can help you in estimation of the next expected Sum value. Usually low sum values correspond to higher Low/High ratio.
5. Select StdDev in chart Options. Lower StdDev values indicate closely-packed tickets where numbers are not too far from their mean value. Charts for Number Groups, Number Movement, Ticket Positions and many others can help you to be more correct in your estimations.
6. Use Winning Numbers History filter for the remaining tickets in the package.

Note: Such a procedure has the following advantages:

- Fast acting filters apply first when the package is large
- Time-consuming filters apply later when the package is significantly smaller, therefore the filtering process is much faster.
Why do we study winning numbers history?

The goal of betting is to find the winning combination of numbers. One of the most common strategies is to select a set of numbers larger than the count of winning numbers being drawn and then create tickets covering all or the most of combinations of these numbers. Majority of Expert Lotto features will help you in doing so.

However in this part of the application we are trying to use a different strategy. The strategy is based on evaluation of frequency of number occurrences in the lottery history.

To understand this strategy you should be familiar with Winning Numbers History page.

Expert Lotto presents the winning numbers arranged in tables and provides simple functions and visual tools helping you to estimate the future values in Winning Numbers History tables. Your estimates then provide input parameters for Winning Numbers History filter. If you manage to fit your estimates into +10 and -10 error margin from the actual value then your can reduce the list of all possible tickets (almost 14 million tickets in lotteries drawing 6 numbers from a pool of 49 numbers) in such a way that the resulting set contains tens to hundreds tickets. However this resulting set is guaranteed to contain the Jackpot winning ticket.

Example [Expert Lotto 6/49]

1. Write down the last two draws from Winning Numbers page (28/2009 1st Wed a 2nd Wed). The tickets used in this example are:
   16,18,22,23,28,29 (28/2009 1st Wed)
   and
   2,13,16,17,25,40 (28/2009 2nd Wed)
2. Switch to WN History page. Make sure that options 1st Wed, 2nd Wed, 1st Sun, 2nd Sun as well as All Draws are selected and click Update button. The data in the table are updated. Click the header of column labeled "0" to sort the numbers in ascending order according to their occurrences in the winning numbers history.

Numbers 2, 13, 16, 17, 25 and 40 are given as the latest draw with the history period "1". The sum values in Summary Table are as follows:

Write these values down, you will need them in following steps. These values are automatically provided in the Winning Numbers History filter. Also note the values in the Summary Table page. In this case the values are: 368, 746, 1202, 1646, 2008, 2407, 2773, 3154, 3500, 3867, 4241

3. Select Edit in the Winning Numbers menu. Click Hide box in the row for the 2nd Wed 28/2009 draw. The record will change as follows (see the highlighted ticket):
Note: Should you wish to repeat the exactly same example then you must skip all recent draws.

4. Switch to Winning Number History page and press button Update. The table is recalculated as if the 2nd Wed 28/2009 draw has not been made yet.

5. Go to Ticket Generator and select Ticket Numbers range 1 to 49, check option Generate maximum possible number of tickets and then click OK. The maximum possible count of tickets 13 983 816 is loaded into the package.

6. Select filter Winning Numbers History and enter the sum values you wrote down earlier into appropriate table cells while adding 10 in the Max column and subtracting 10 in the Min column.

Note: Make sure you are entering values into the table in Sums tab. The filter window should look like follows:
Fields *1st Wed, 2nd Wed, 1st Sun, 2nd Sun* are options for winning numbers selection. All checkboxes to the left of *History Index* column must be selected. Select *And* as the *Logical Condition*. Also select *Leave* in the *Matching Tickets* panel. Now click button *Apply*.

The tickets in the package are backed up first and then you will see filter's progress bar showing the number of tickets processed so far. Because of the large number of tickets being processed this task is very time consuming, especially on slow PCs.

7. When the filtering is finished you will get a message how many tickets are left in the package as well as how many tickets were removed from the package. In this case the number of tickets left in the package is 196. These remaining tickets always contain the Jackpot winning ticket (2,13,16,17,25,40 in this example).

```
Package | Visual Package | Package Winnings | Winning Numbers
---------|----------------|------------------|------------------
196 ticket(s) left in the Package, 13983620 ticket(s) filtered out.
```

8. To verify this switch to Visual Package page and click the winning numbers on the panel (right hand side). The numbers are highlighted in table's header. The last table column shows the match with the Jackpot winning ticket. (The ticket with blue background in the figure below)
9. As the last step in this example you must edit the winning numbers database again. Select function Edit in Winning Numbers menu and switch option Show skipped entries. Remove the "Skip" flag of the winning ticket to restore the winning numbers database record.
Notes

1. The number of tickets in the package can be reduced even more. When evaluating entries in the Summary Table you can see that quite frequently the differences in 3 to 5 columns are lower or equal to +/-10. Then the filter settings should change as follows:
As you can see additional filter condition is defined:

This condition requires that in any of 3 to 5 columns the difference between the last known sum value and the expected sum value is to be at most between -10 to +10. Usually the number of tickets left in the package is higher (in the order of hundreds).

2. Winning Numbers History page offers other supporting tools helping you to determine more accurate filter parameters, e.g. you can evaluate Differences Chart for more accurate ranges of sum differences in each column.

3. You can also reduce the package contents by using functions from History Differences tab.

4. This function can be used for a selected draw(s) in a week only. In the example below the function will process the 2nd Wednesday draws only:

However in this case you must also change all values used in the procedure - sums, tables with history of numbers, charts etc.

5. When using these functions for other lotteries and/or other winning numbers periods, you must realize that the values of sums, ranges, count of the latest draws, number of tickets left in the package etc. will differ from the example provided above! However the function principle does not change and it always provides a small set of tickets containing the Jackpot winning ticket.

Notes:
1. The setting for margins to +/- 10 is recommended only. You can change these values in any way. The wider margins the more tickets are left in the package after filtering.

2. *Min/Max* settings in the rows of *Winning Numbers History* filter need not be identical. Some margins can be left wider and you can omit some margins at all.

3. By checking option *At least "xx" to "yy" columns must pass* you choose the minimum and maximum count of columns that must meet filter conditions. This applies to any combination of columns. The resulting sums (use button *Lookup Min & Max Ranges* to look them up) will not match your original estimated margins but they should be wider. This option is suitable when we expect mistakes in our estimates because the tickets left in the package will still contain the Jackpot winning ticket you are looking for. The larger the difference between "x" and "y" the more tickets will remaining in the package after filtering.

4. The program remembers the last used settings for margins in this filter.

5. Check that your selection of winning numbers matches the one from Winning Numbers History page before filtration and always use *Update Sums* button to refresh the table in filter window.

6. Visit www.expertlotto.com to see a detailed instructional video describing the steps in this chapter.

---

**Hot Numbers**

Some lottery strategies are based on the evaluation of frequency of number occurrences in a fixed period. Usually the latest "xx" draws are evaluated from this point of view.

**Assumptions:**
Let's play a lottery drawing 6 numbers from a pool of 49 numbers. In an ideal case each number should be drawn during a period of 9 draws and 5 of them should be drawn two times. However the real situation is different. The numbers are drawn in different periods with different frequencies. It can be affected for example by the wheeling equipment. The longer evaluation interval we chose, the smaller differences should be expected in the frequencies of drawings of each number. Looking at the *Number Table* in the *Statistics* page (when playing the Expert Lotto 6/49 lottery) you can see that the numbers frequency percentages range from 14,17% to 10,73% (analyzing larger sets of winning numbers yields smaller difference between the lowest and the highest frequencies).

**Lottery Strategy**

Assuming that each draw can be statistically analyzed then the frequency of drawn numbers for any period should correspond to the normal distribution with its typical curve.
In this case the curve is shown as a histogram. This graphical presentation was generated using the latest 28 draws. The draw frequency is expressed by the number assigned to the appropriate color of the bar. Hover your mouse over any chart's bar to see the numbers from that bar or switch to the Table page in the Panel Coloring window, which lists the numbers from each bar in a table.

In this case we can see that number 23 was drawn 7 times during the latest 24 draws, numbers 12 and 25 were drawn 6 times during the same period and numbers 19, 29 and 33 were drawn 5 times. Numbers 7 and 45 were not drawn so far during the latest 24 draws and numbers 9, 10, 17 and 21 were drawn only once. The row for numbers drawn 3 times during the last 24 draws contains the most numbers. You can decide (applying your strategy) that the most frequent numbers (6x and higher frequencies) are so called hot numbers (23, 12, 25, 19, 29, 33), the numbers not drawn so far and as well the numbers drawn only once are the cold numbers (7, 45, 9, 10, 17, 21) and the remaining numbers correspond to the average. You may for example estimate that the next draw will contain two hot numbers, three numbers corresponding to the average and one cold number. Then print the page shown above (button Print) and use the Ticket Generator to insert 1000 random tickets into
the package generated from the whole range of 49 numbers. Now switch to the Visual Package page and click all cold numbers in the panel. Because your estimate is that a winning ticket will contain one cold number only, use the Remove Match in function to remove from the package all tickets that do not match this assumption.

Approximately 400 tickets should remain in the package. Now apply the same for the hot numbers and leave in the package only tickets matching the hot numbers in two numbers. The package contains about 40 tickets corresponding to the above assumptions and can be saved to a file for further processing. This way you can process not just 1000 random tickets but you can use the same procedure for the complete set of all combinations of 49 numbers (almost 14 millions tickets). Naturally the remaining part will be larger. However if your hot number estimations are correct then this remaining set of tickets will contain the jackpot winning ticket.

An additional step could be based on the assumption that the package should not contain any ticket containing three average numbers from each table's row.

Let's continue with the hot and cold numbers strategy and expand the period being examined to 82 draws. In theory each number should be drawn approximately 10 times (the highest frequency shown in the panel coloring) according to the uniform distribution of frequencies.
The figure above shows that a group of numbers does not match the uniform distribution. This can be used for further filtering to reduce the number of tickets being prepared for your bet.

Another step in your strategy can be for example an assumption that only tickets containing numbers with odd/even ratio 3:3, or 4:2 or 2:4 are expected in the next draw. Thus the tickets containing 6 and/or 5 even numbers as well as the tickets containing 6 and/or 5 odd numbers are to be removed. Use the Statistics page to find out the Even/Odd ratio in the period you are interested in. The chart for the Even/Odd ratio in the given period should look like follows:
The chart was calculated for the latest "24" draws. You can see that the highest rate is the ratio 3:3. The ratio 4:2 of Odd/Even numbers slightly differs from the normal distribution (the value is greater than expected). Therefore you may decide to prefer tickets with 2:4 ratio of Odd/Even numbers. To do so open the the Odd/Even filter window, enter "2" into the Odd numbers field and selection option Leave in the Matching Tickets panel. After filtering only several tickets should remain in the package (e.g. 4 tickets only). Thus after application of two filters you managed to reduced the package contents approximately 250 times. If your assumptions are correct then you reduced the cost of your bet 250 times compared to initial 1000 tickets while keeping the same chances to win the jackpot.

Naturally, you can use the filters to process much larger sets of tickets. The following rules apply:

1. Filters can be applied in any order. However it is recommended to use the fast acting filters first when processing large numbers of tickets (e.g. working with all number combinations - full package). All filters except for Match Winning Numbers, Match Package, Match File and Winning Numbers History are fast acting filters. Filters that must compare two large ticket files can be very time consuming. Therefore it is better to apply such filters as the last step of your lottery strategy because at that time usually smaller files are being processed.
2. It is not necessary to use all the filters.
3. Each filter can be applied repeatedly.
4. The filters are a tool for implementation of your lottery strategy and for fault free processing of large numbers of tickets. Your responsibility is to provide appropriate input parameters for these filters.
5. The greater the number of filters applied the greater should be the initial package. However the possibility for invalid estimation increases.
6. After application of each filter the package contents can be saved to a file before using other filters. Should you wish to adjust your estimations, you can return to the previous step and use the same filter again with different input parameters. This way a filter tree is being created where each branch leads to a different result.
7. Each filter's logical condition is clearly defined and its application always leads to the same reproducible results on the same file. The "Random Selection" filter is an exception, it removes the required number of randomly selected tickets from the package.
8. Before using the the filters it is essential to identify your strategy and also to clearly understand how filters work. Also pay close attention when selecting the appropriate option in the Matching Tickets panel especially when using filters that offer options like " and/or", "all/at least one" etc.

**Best Tickets**

The filtering process always leads to some tickets remaining in the package. The number of these tickets can range from a few tickets only to several thousands of tickets depending on the type of used filters. If your estimates for filter parameters were correct then the tickets remaining in the package will include the Jackpot winning one and other tickets matching the Jackpot in 5, 4 or 3 numbers.
Why use the *Best Tickets* filter

- **A)** The results of Best Tickets filter can lead to several groups of similar tickets. It happens when the starting package is too large or when previous filtering steps were not accurate enough (e.g. Min/Max margins were too big). This problem can be resolved in many ways, e.g. try using any other filter. It is recommended to use a filter that applies in a generic fashion (Odd/Even, High/Low, Sum Root etc). The best choice seems to be Sum Root filter because of its almost uniform distribution. You can also select up to three tickets from these groups.

  It is important to apply generally valid filters only. For example filter *Match Package* is not suitable because it will favor the first ticket occurrence that matches the filter condition. Naturally you can use *Package Statistics* page, which provides an extensive set of many supporting parameters. It is recommend to use Sum Root because if your estimates are not correct you can still keep a high chance of winning a higher prize (usually match in 5) while reducing the package contents by a factor of 9.

  It is obvious that when a large original package (e.g. 50000 tickets) contains the Jackpot winning numbers (match 6 = 1x, match 5 = 179x, match 4 = 2158x ..) then the Sum Root filter can divide it into nine parts of the same size and each part will have approximately the same number of match 5 tickets. For example estimating Sum Root = 3, while the actual correct Sum Root is 4 still maintain a chance for Match 5 prize.

- **B)** Usually after selecting 50 *Best Tickets* you can see the groups of tickets at one location on the screen on Visual Package page indicated by columns of continuous graphics. If you highlight these columns (for example four of them) and click *Total Match* button you will see a table with a detailed break-down how many tickets in the package match those four numbers.

  If there are more such groups it is either due to large original package (relaxed filtering conditions) or due to incorrect Winning Numbers History margins. Obviously only one ticket is the Jackpot winning one therefore you should chose up to three tickets from each group to keep your chances for smaller winnings at least.

- **C)** For those who prefer their gut feelings in decision making process it is recommended to use option *Use Package Tickets* at the bottom part of WN History Page. Then you can simulate WN History value with tickets from the package step by step using all available support provided by History Differences tables, chart etc. You can base your decisions on visual perceptions, however this procedure can be too subjective.

  On the other hand even this procedure has features which are generally valid. It is for example the removal of all tickets containing all 6 numbers (6 is an example - you can chose 5 or even 4 which are more strict conditions) from the bottom part of any or each History Differences table. You can also take into account that 4 numbers from one row is rather rare case etc. In addition you can use *StdDev* chart (History Charts - the last row in Chart Options window and Summary Table - column *StdDev (Diffs)*). When you expect a high Standard Deviation value then you should favor 3 to 5 columns in +/-10 range to the usually applied condition of 4 to 6 columns in +/-10 range. It may also mean that you should expect more than one large difference (WN History filter) for the next draw. Therefore if you started your filtering with the condition
of +/-10 range in at least 4 to 7 columns you should repeat the filtering with condition of at least 3 and at most 5 columns in the +/-10 range.

• D) In case you get more than one group of tickets after Best Tickets filtering, the best procedure may be to take all numbers from these groups and generate a full wheel for them and repeat the filtering the same conditions. You can also use Simulation tab on History Page (click "->" button in Simulation Tickets field and chose Package) to simulate this wheel. Then you can use values from Avg column as the starting values for Min / Max margins in the WN History filter. If you guess the reduced set of numbers (for example 25 to 32 numbers) correctly - it includes the six winning numbers - than you can use margins from +/-5 to +/-7. Usually 8 to 11 columns match these conditions even when applied to the full list of all combinations. You will get a smaller package then that you filter for 10 Best Tickets to avoid groups of similar tickets.

• E) It is also possible to divide large package to smaller parts (e.g. use Sum Root filter). Then select for example 30 Best Tickets from each group. Join all filtered groups into the package and filter for 10 Best Tickets again. If you select for example 50 Best Tickets from a large package and then filter the result again for 10 Best Tickets the remaining tickets may be very distorted. Dividing the large package into smaller parts can prevent this distortion - however not completely.

• F) The main reason for implementation of Best Tickets filter was to prevent overlooking of some phenomenon in large packages when the lottery strategy focuses on one set of tickets only. It can happen especially for large packages resulting from full wheels when numbers are spread through whole range almost uniformly. In such cases the package is sorted so you can easily miss something important.

Note: Even though the Best Tickets filter is primarily intended for filtering of results of WN History filters, it can be applied to any package. However you should have a clear idea of what the original package is like and whether the package can contain groups of similar tickets at all.

Naturally you can also use Best Tickets filter to make a bet from tickets with maximum coverage of the given package regardless whether the package contains or does not contain groups of similar tickets.

Tips & Tricks

• Choose descriptive file names when saving your tickets to a file. A good example could be names like "m12_3", "m12_4", "m15_3" where: "m" stands for model; 12 is the count of numbers used in file; 3 stands for the maximum allowed match in 3 numbers. In this case the name "m15_3" means tickets from 15 numbers with maximum allowed match in 3 numbers. Such a naming schemes improves your orientation in your stored files.

• We strongly recommend to verify your lottery strategy before actually making the bet and spending your money. Use Expert Lotto to prepare tickets for your bet and save them to a file. When the winning numbers are drawn switch to Package Winnings page to find your possible winnings.
• **Try yourself:** Select *Expert Lotto 6/49* lottery and generate tickets for all possible number combinations. Then use Sum filter (Min=150 and Max=150) to leave in the package matching tickets only. Switch to Statistics page and examine the statistics thoroughly.

• As you are becoming more familiar with the application note how fast the filters act on the package contents when processing large numbers of tickets. Because your lottery strategy usually requires more filters to be applied you should start first with fast acting filters to remove as many tickets from the package as possible. Then you can use time-consuming filters to process only the remaining tickets to save your time. The order of applied filters is not important. This is especially useful when working with a slow computer. The speedup is only marginal on a fast PC.

• Some filters are related. For example using *Odd/Even* filter to keep tickets with 3 odd and 3 even numbers (as well as 1:5 and 5:1 combinations) means that the sum of ticket numbers of matching tickets will never be an even number. Therefore the sums for these odd/even number combinations will always be odd values only.

• You can bring up context help using F1 key in any application screen. The displayed help page provides the description of application function you are currently working with.

• You can resize any application’s window to see more of its content. Just drag window’s border using your mouse.

### How to import a wheel

**Problem:** I have a wheel in text file and I want to use it in Expert Lotto.

1. The file must have *csv* or *txt* file extension to be recognized by the application, for example `wheel.txt` or `NY_Lotto_Sunday.csv`.

2. Make sure the file has the supported format. It means that each ticket is on a separate line of text and that there is a separator character between ticket numbers. For example

   1, 2, 3, 4, 5, 6  
   11, 12, 13, 14, 15, 16  
   21, 22, 23, 24, 25, 26

   or

   1 2 3 4 5 6  
   11 12 13 14 15 16  
   21 22 23 24 25 26

**Note:** The application does not read files without separators, such as:

   010203040506  
   111213141516  
   212223242526
3. Click menu Package and select File:

![Image](image1.png)

4. A default window for file browsing will open. Select CSV or Text Files in option Files of Type:

![Image](image2.png)

5. Browse the wheel file you want to open in Expert Lotto.
6. Make sure you have selected the correct file when window Insert File opens. Then select Overwrite in Action option and click Ok button.
7. Program will read all tickets from the wheel and insert them into the package, where you can process them further. The original wheel file will remain unchanged.

**Note:** You will get an error message if there are any errors in wheel's file format.

**How to add past winning numbers**

**Problem:** I need to update my winning numbers database.

For some lotteries it is possible to use plugin for online update of winning numbers. Click menu Winning numbers and select Online Update.
The application then downloads the latest drawn numbers and adds them to its database. If the menu does not contain *Online Update* item you must enter the data manually.

If you wish to add a few latest draws only, select menu *Winning Numbers ➔ Add*.

Click the date you wish add.
Enter drawn numbers into edit fields and click button *Add*.

When you are finishing adding the winning numbers, close the window by clicking button *Close*.

If you wish to add a lot of draws in one step you can import data from a text file or from lottery’s web pages (some lottery operators publish full lottery history on their web pages). Select *Winning Numbers* menu - *Import Wizard* in to start Winning Numbers Import Wizard.

1. Click button *Next* for the next wizard’s step. In your internet browser highlight the text listing drawn number you wish to import and their draw dates using your mouse and press CTRL+C key (*Copy*) to copy the text into operating
system’s clipboard.

2. Click the input text field in wizard’s window and press CTRL+V (Paste) to insert the text.

**Note:** The draw date and drawn numbers must be on the same line of text. If it is not the case use button *Join* to join several lines into one line.

3. Click button *Next* to continue with next wizard’s step.

4. Adjust field separators so that each number is in a separate column. Also year, day and month of draw (or year and week number when appropriate).
must be in separate columns

Click button Next to continue with wizard’s next step.
6. Click column headers to assign appropriate labels.

7. Click button Next to continue with wizard’s next step.
8. You will see a table listing winning numbers draws that were successfully parsed. Click button Finish to add the drawn numbers to application’s database.

Note: Visit www.expertlotto.com to see a detailed instructional video describing the import of winning numbers.

How to create a new wheel
How To

Subject: I want to create a full wheel or a wheel with a win guarantee for a given count of numbers.

1. To create a wheel containing all combinations from a selected count of numbers, choose menu Package ➔ Generator

2. Ticket Generator window will open.
3. If there is button Switch to Simple Mode at the bottom window, click it. Otherwise continue with the next step.

4. Enter the range of numbers you wish to use into edit fields.

5. Check option Generate maximum possible number of tickets.
6. Select **Overwrite the Package in Action** option.

![Ticket Generator](image)

7. Click button **OK** to write wheel tickets into the package.

To create a wheel with a guaranteeing certain winnings if you correctly guess some of wheel's numbers, follow the same steps as in the procedure above.

1. When you create a full wheel with all combinations select menu **Filters ➔ Coverage ➔ Minimizer**
2. Enter 100% into option **I want to have ... chance of**

![Minimizing Filter](image)

**Note:** a lower win guarantee does mean a lower chance to win however it may reduce the count of tickets significantly and thus reduce the cost for your bet.

3. Choose **at least 1 match(es) in 3 numbers** for wheel with win guarantee of at least one Match-3 prize. For higher winnings enter enter **match in 4** or **match in 5 numbers**.

![Minimizing Filter](image)

4. Into field **when I hit ... numbers** enter the lowest count of winning numbers the wheel must contain to meet its win guarantee. For example if you want to win at least one Match-3 prize when you hit 4 wheel numbers enter value 4.
5. Choose the **Number range to use** match the count of numbers in your wheel. So the **Range of numbers** options in this window must match the **Range of numbers** settings in **Tickets Generator** window when you created the full wheel.

6. Select **Matching Tickets - Leave**

7. Click button **OK**. The application will leave in the package only the minimum count of tickets necessary to meet the required win guarantee.

### How to print to playslips

**Problem:** I want to print my wheel to playslips.

1. Insert the wheel into the **Package**.
2. Select menu **Print ➔ Playslips**.
3. **Print Playslips** window will open.
4. Click **Ok** to open operating system's default window for printer selection and printing settings. Clicking **Ok** in this window starts printing to playslips.

**Note:** If your lottery does not have playslip layout definition and dimensions the application will ask whether you wish to enter these playslip printing parameters. If you choose **Yes** then Playslip Printing Wizard will start and will assist you with print setting.
How to create a new lottery

Subject: My lottery is not in the list of available lotteries.

1. Click menu *Lottery* and choose *Select*

2. A new sub-menu will pop up listing all installed lotteries. After clicking the lottery name the program will restart and you can start working with the selected lottery.

3. If your lottery is not included in the list of installed lotteries, select menu *Lottery* ➔ *Select* ➔ *Download More*

4. The application will connect to internet and provide you with a list of all lotteries currently available for download.
5. If your lottery is not in the list of supported lotteries you can create a new lottery yourself. Select menu Lottery -> Manager

6. Clicking New Lottery button starts the New Lottery Wizard which will assist you with the lottery setup.

How to use filters

Subject: What are filters and what are they good for?

Filters are conditions of various type applied to lottery tickets. Each ticket either passes or fails condition so they are simple YES / NO conditions. Filters reduce the number of tickets in the package to optimize the cost of bet. The choice of filters and their parameters should be the core of your lottery strategy.

• You cannot use filters if the package is empty so you must first create or insert a wheel into the package.
• Choose Filters menu and select filter you wish apply. Odd/Even filter is chosen for the following example.
• Select filter parameters in the upper part of the window.
• Then you have to choose whether the filtering will result in a list of tickets that passed the filter:
or whether the next step of your lottery strategy will work tickets that failed to meet filter condition:

- Clicking Ok button all the tickets in the package are subjected to filter condition. After finishing the current contents of package is replaced by result of filtration, i.e. by tickets which fail/pass filter condition. This button is inactive when filter parameters are set outside their allowed range.

- The Apply button performs similar like Ok button except that filter’s window remains open after filtration finishing. Such way you can apply the filter repeatedly for example with different margins.

- The Preview button will apply filter condition on tickets in the package and it displays count of Passed/Failed tickets. However the package contents remains unchanged.
• Using the Back-Test button you can check how the filter performs in the lottery past.

**How to use statistics**

**Problem:** Where can I find statistical functions?

Expert Lotto calculates and displays statistics for tickets in the package, winning numbers tickets or combination of both. Statistical data, for example Odd/Even ratio, sum of ticket numbers, are displayed as tables and charts.

1. Switch to **Statistics** page:

   | Package | Visual Package | Package Winnings | Winning Numbers | Visual Winning Numbers | Statistics | Package |

2. Select the set of tickets you wish display statistics for:

   ![Screenshot of the statistics page](image)

   - **Show Stats for:**
     - General

   - **Calculate Stats**

   - **Calculate stats for**
     - Tickets in the Package
     - Winning Numbers
     - Include Bonus

   - **Latest**
     - 130

   - **Selected:** 120 Tickets
3. **Click button *Calculate Stats***:

Show Stats for:
- General

[Image of Calculate Stats button]

- **Calculate stats for**
  - Tickets in the Package
  - Winning Numbers
  - Include Bonus

[Image of Latest section]

Selected: 120 Tickets

4. **After calculation finishes you will see a message how many tickets were processed**:

Show Stats for:
- General

[Image of Latest section]

Total number of Tickets: 120
- Winning Numbers Tickets: 120
- Tickets with bonus number: 120
- Tickets with dummy numbers: 0

Selected: 120 Tickets
5. Click option *Show Stats for* to display a different type of statistical data:

![Show Stats for dropdown menu](image)

6. Most statistics allow switching between table and chart display:

![Table and Chart option](image)

There are additional statistical data on Package Statistics page.

**How to export data from the application**

**Subject:** How can I export data from Expert Lotto?
1. If you wish to export tickets from the package click menu *Package ➔ Save to File.*

![Save Ticket File](image)

2. A standard window of your operating system will open allowing to select the name and location of exported file. Select *CSV or Text Files* in *Files of type* list, enter the name of exported file and select directory where the file is to be saved. Then click button *Save.*

3. Then you will see window *Save the package into a File* with the given file name. After clicking button *Ok* the tickets from the package are saved to the selected file. You can open this file in other applications or you can use it later to check your winnings.

**Note:** You can also export the content of various tables from Expert Lotto to a text file by clicking *Export* button.

Another option is to export the contents of most tables using operating system's feature *Copy & Paste:*

1. Click with your mouse into the table you wish to export.
2. Press CTRL+C key (*Copy*)
3. Switch to the application you wish to use to process the exported data (e.g. spreadsheet processor) and press CTRL+V key (*Paste*).
How to check winnings

Problem: How can I check my winnings?

1. Insert the wheel with your bet into the Package
2. Select menu Win Test ➔ Package
3. Enter the latest winning numbers into edit fields and choose button Test
4. The table will display your winnings
5. You check your winnings also with Package Winnings or Visual Package functions.

How to use Winning Numbers History features

Problem: The description for WN History features is too complex. Is there an easier way to use this function to get the Jackpot winning ticket?

1. Make sure that the winning numbers database is updated and contains at least 100 -150 draws.
2. Switch to WN History page.
3. Select Latest 300 draws in the winning numbers selection panel and click button Update.
4. Switch to History Charts tab.
5. Select *Summary Chart* in the *Draw Selection* combo box.

6. Click *Options* button at the bottom part of the chart window and tick rows in the table of according to the following figure.

7. Select *Close* button to return back to the chart window.
8. Scroll the chart window to right.

9. The last point in the chart shows the current status of the winning numbers database. Drag both horizontal dashed lines with your mouse to new positions to represent your estimated interval which the chart will shift to after the next winning numbers draw.

10. Click the Options button again, un-tick the current chart and tick another chart from the list and repeat steps from 7 to 9.

11. Repeat steps 6 to 10 all charts lines in the list (WN History Summary, 0 to WN History Summary, -10).

12. Switch to Package page

13. Select menu Package ➔ Generator and generate all tickets into the package.
14. Select menu Filters → WN History → Sums

15. Filter window will open.
16. Select *Latest 300 Draws* in the winning numbers selection panel and click button *Update Sums*.

17. Tick all rows in the right-hand part of the window.

18. Use drop-down menus to enter numeric values of your estimates into all table cells.
19. Set the remaining filter options according to the following figure.

20. Clicking button Ok button to filter tickets in the package.

After finishing the package will contain a small set of tickets. If your estimates were correct then this set is 100% guaranteed to include the Jackpot winning ticket.

Notes:

- You can use the same procedure for estimates based on Differences Charts
- If the package contains too many tickets after filtering try using smaller intervals for your estimates. Of course, you can also use other filters.
- If the filtering removed all tickets from the package then the problem is in your estimates. All charts lines are mutually related to each other therefore depending on the current status of the winning numbers database it may happen that, for example, your estimate for significant increase in WN History SUM, 0 is not compatible with estimated significant decrease in WN History SUM -1 chart and vice versa. We recommend experimenting with your estimates and to study previous trends in the chart window.
- For more details and examples see also WN History page description

Predictions

Expert Lotto has a tool which can automatically predict the future winning numbers, future statistical parameters and future values for the History feature. It is based on comparing of several latest draws with the rest of winning numbers database, so called pattern matching.

How does it work?
The prediction algorithm is very simple and applicable to any sequence of numbers. Let's have the following sequence of numbers in the range of 0 to 9:

| Position | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
|----------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Value    | 1 | 2 | 3 | 0 | 9 | 8 | 5 | 1 | 6 | 8  | 3 | 9 | 8 | 0 | 7 | 2 | 7 | 9 | 1 | 3 | 4 | 3 | 5 | 6 | 1 | 6 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 |

Now we are looking for number that will follow in the sequence at position 31. We will start with four latest values at positions 27 to 30 (four latest drawings) - 6,2,7,9 - and will be looking for a similar sequence at preceding positions (previous draws). Such a pattern can be found at positions 7 to 10, where the values are 5,1,6,8. The patterns are not totally equal but they have the same 'character' - increase by 4, decrease by 5, increase by 2, so it is a perfect match. Pattern from positions 7 to 10 is followed by value of 3, so in this case the prediction result is value 4, because the pattern from the end of the sequence has all values smaller by one.

We can also compare bigger patterns. Let's pick the last five values at positions 26 to 30, which are numbers 1,6,2,7,9 and we will be looking for a similar pattern in previous positions. In this case the best match is at positions 15 to 19, where the values are 0,7,2,7,9. Value at position 20 is 1 so in this case the prediction result will be number 1.

The prediction results from the examples above are different from each other. So the next problem is finding the optimal pattern size for matching to achieve as credible prediction results as possible. The automated predictor in Expert Lotto solves this problem by running multiple predictions for different pattern sizes from a given interval (see prediction input parameters below in this chapter) which are then back-tested on several latest values/draws - the number of back-testing draws is another input parameter for the prediction process, see below.

The predictor starts with the lowest possible pattern size and evaluates only values at positions 1 to 29. The actual value at position 30 is then compared with predicted value. In the next step only values at positions 1 to 28 are used to predict value at position 29 which is then compared with actual value. Prediction for sequences 1 to 27, 1 to 26 etc follow. This the predictions are back-tested on e.g. five latest values/draws.

The pattern size is then incremented by one and values for positions 30, 29, 28, 27 and 26 are predicted again and again compared with the actual values at those positions. The optimal pattern size is the lowest size where the most test predictions matched the real values. This optimal pattern size is then used to carry out the actual prediction for position 31.

**Note:** After running the predictions in Expert Lotto you can see the optimal pattern size and the percentage of correct testing predictions in a tooltip of predicted values. The higher the percentage, the more credible the predicted value is.

**Note:** It is possible that the predicted value can be out of the expected range of input values sequence. For example prediction for Sum root can produce value -2. It happens for example when the sum root for the latest draw is 1 and the predictor expects a big decrease in the next draw. In such cases it is possible either to take into account only the predicted direction - increase or decrease - and filter the
Package as such, or ignore such a prediction as not credible and do not base your strategy for the next draw on it. The prediction results can also display N/A which means that the predicted value is outside of interval $\text{Average}_\text{Value} - 2 \times \text{StdDev}$ to $\text{Average}_\text{Value} + 2 \times \text{StdDev}$.

Automated prediction in Expert Lotto is available in Winning Numbers Statistics and in Summary table in WN History page. In both cases clicking Predictions button opens predictor window. The predictions start after selecting values to be predicted and entering input parameters (minimum and maximum pattern size, the number of draws for pattern size selection). Prediction results show as another row in the table:

![Predictions window in Expert Lotto](image)

The figure above shows prediction results in Summary table carried out according to the input parameter shown in the picture. We can see for example that the predictor expects decrease in column "0" to value 328 and only a slight increase is predicted for column "-2" to value 1203.

**Note:** Every lottery has a different history of past winning numbers therefore we recommend experimenting with predictor's input settings to achieve the best prediction results. You can easily verify the efficiency of predictions by hiding the latest draw in your database and then comparing predicted results with the actual results for the hidden draw.